REPRODUKTOR V BLENDERU

Po spusténi Blenderu smaZzeme pomoci (Del) Gvodni krychli a pfepneme se do
pohledu shora (NumPad 7), kde vytvotime zakladni ptidorys reproduktoru. Nejprve
se ujistime, Ze jsme v edita¢nim rezimu a poté do scény vlozime objekt Plane (Space,
Add, Plain) a pomoci metod Extrude (e) a Scale (s) vymodelujeme pozadovany tvar
- podstavu reproduktoru (viz Obrazek 1).

Obrazek 1

Nasledné se pfepneme do pohledu zepfedu (NumPad 1), ozna¢ime celou podstavu
klavesou (a) a opét provedeme Extrude (e). Méli bychom dospét k podobnému tvaru
jako znadzorniuje Obrazek 2. Vyvyseni ¢elniho panelu (Obrazek 3) dosdhneme ozna-
¢enim pifislusnych hornich dvou prednich fad vertexti a potdhnutim svislé Sipky
nahoru. K postupnému oznacovéni jednotlivych vertexti se mi nejvice osvédcila
klavesa (b). Po jejim stisknuti 1ze oznacovat polem, po dvojitém stisknuti se objevi
kruznice a klikanim levého tlacitka mysi lze postupné oznacovat. Navic otd¢enim
kolecka mysi 1ze ménit polomér kruznice a jeho kliknutim Ize rovnéz deselektovat.

Obrazek 2 Obrazek 3



Z4kladni kostru reproduktoru mame jizZ hotovou a miZzeme zacit vytvéaret zvukovou blanu. Do
scény vloZime novy objekt Circle a umistime ho do horizontdlniho sttedu kostry, jak je zna-
zornéno na Obrazku 4. Extrudujeme doptedu (e) (Obrazek 5), poté dovnitt (e, s) (Obrazek 6)
a dozadu (e) (Obréazek 7). Takto vznikne rdm reproduktorové blany.

Obrazek 4 Obrazek 5
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Nyni si ozna¢ime fadu vertexti dle Obrazku 8, duplikujeme ji (Shift d) a vyseparu-
jeme do nového objektu (p). Déle extrudujeme smérem ven, aby o kousek precnival
pfes ram (Obréazek 9), dale Scale (s) dovnitf (Obrazek 10) a uzavieme (Shift f).
Nakonec oznacime vsechny vertexy (a), pfepoc¢itame normaély (Ctrl n) a provedeme
Set Smooth (Space, Edit, Faces, Set Smooth). Méli bychom dostat podobny vysledek
jako Obrazek 11.

Obrazek 8 Obrazek 9
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Dalsim krokem bude vymodelovani ovlddani na reproduktoru. Vlozime do scény
Circle a budeme ho extrudovat dle Obrazku 12. Konec opét uzavieme pomoci (Shift
f) a vSe vlozime do vytvoreného vélcovitého plasté, ktery slouzi k upevnéni do
reproduktoru (Obrazek 13). Vysledny objekt slouZzici jako ovladani hlasitosti
zasadime do levé dolni ¢asti reproduktoru, zduplikujeme (Shift d) a tento duplikat
zmensime pomoci Scale (s) a pfesuneme na pravou stranu (viz Obrézek 14). Jelikoz
ma tento prvek funkci ovladani zapnuti/vypnuti, je tfeba tlacitko vice zatlacit do
ochranného valce. Déle si obdobné vyrobime kontrolku zapnuti, jejiz kryt je
znazornén na Obrazku 14 v pravém hornim rohu a déle na Obrazku 15. Koule uvnitf
slouzi jako zdroj svétla.

Obrazek 12 Obrazek 13
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Nésledné pridame ukazatel hlasitosti pouZitim nastroje Loop Subdivide (Space, Edit,
Edges, Loop Subdivide) (Obrazek 17) a zprihlednénim (pouZiti textury skla).
Detail ovladéani je vykreslen na Obrazku 16. Nakonec vytvoiime symbol ON/OFF
pomoci Circle, kterou extrudujeme v prstenec a smazeme horni ¢ast, kterou dopl-
nime o kvadr vyrobeny z objektu Plain, jak znazormiuje Obrazek 18.

Obrazek 15
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V aplném zavéru doplnime textury, nastavime svétla a podstavec. Textury jsou
pouzité z http://www.freewebs.com/blendermats/index.htm a to tak, Ze na mate-
ridl kontrolky je aplikovano sklo, na povrch reproduktoru lestény kov dvou barev a
podstavec je z kamene. Parametry materidlu ¢erného ochranného krytu byly
nastaveny tak, aby zcela pohlcoval svétlo a reprezentoval tak textilni potah.

Obrazek 19



Modelovani vodovodni baterie v Blenderu

Uvod

K vwmodelovani vodovodni baterie vopensource programu Blender je nejprve tfeba instalacni soubor
ze stranek http://blender3d.org Ja jsem pouZl verzi 2.42a pro Windows. Dale byla zapotfebi konkrétni
pfedloha baterie. Mél jsem vumyslu vymodelovat klasicky dvojkohoutek s cervenym a modrym
odliSenim, a tak jsem hledal na strankach firem zabyvajicich se jejich vyrobou ¢i distribuci odpovidajici
pfedlohu. S podivem jsem Zistil, ze se jiztakové baterie ttmé&rf nevyrabéji, a kdyzuz ano, stale
neodpovidal pivodni pfedstavé. Nakonec jsem si vybral model, jehoZz tvar by mohl odpovidat mym
moznostem po prvnich 6 lekcich video tutorialt na rovni "pokrocily zacatecnik".

Bohuzel, ani u tohoto modelu wrobce nemyslel na riziko
opareni, tudizjsem ve vysledném modelu proved|
drobnou Upravu a na vrcholy kohoutk( pfidélal modrou a
Cervenou Cepicku.

Po nainstalovani programu jsem si prohléd| video
tutorialy a naucil se tak zakladni manipulaci s
prostfedim, vytvafeni objektd, praci s materialem,
texturami a dalSimi uzitenymi technikami. Samotné
modelovani baterie jsem probihalo od oka podle
obrazku. Vysledné rozméry a poméry jednotlivych &asti
nejsou tedy totozné se skuteénosti. Strukturu baterie
obr. 1: pfedloha jsem rozdélil na n&kolik asti:

i. trubka (vodovod) 1x
ii. podstavec (uchyt pro trubku) 1x
iii. kohoutky 2x

a. zaklad 1x

b. ramena 4x

Postup

Po spusténi Blenderu se ocitame na "prazném dokumentu” vokné 3D View v nahledu TOP, kde osa z
jde pfimo proti naSemu pohledu. Prostorovou orientaci nam zajiStuje ikonka vlevém dolnim roku okna.

{173 Cube

Kohoutek

Nejprve jsem smazal jizoznacenou defaultni krychli ve stfedu stiskem DEL a v kontextovém menu
volbou mysi Erase selected Objects(s). Stiskem SPACE jsem oteviel kontextové menu pro praci se
zvolenym objektem. Volbou Add -> Mesh -> UVSphere jsem pfidal na misto kurzoru kouli s parametry
Segments=14, Rings=14. Dale jsem se pfepnul do pohledu FRONT a editaniho médu TAB, stiskem A



deselektoval v§echny body koule a klavesou B a tazenim mySi oznacil body ve spodu koule viz obrazek.

Oznacené bodyjsem smazal DEL - Vertices a oznacil body na vzniklé kruhové hrané. Dale jsem
stisknul klavesu pro rozSifeni bodu (hrany) E - Only Edges, tahem my3i se posunul hranu do prostoru a
stiskem ESC wtvofil nulové prodlouzeni hrany, které se stiskem S a pohybem kurzoru mysi ke stfedu
oznacene kruznice uzavie otvor do kulove plochy.

To samé jsem provedl na druhé strané koule azna to, Ze jsem misto stisknuti ESC pfi prodluZzovani
hrany za pomoci CTRL rozSiril hranu ve sméru kladné osy z. Timto zpusobem (za pomoci funkce
Extrude E a scale S) jsem postupné vymodeloval kohoutek (zatim bezramen). Hranatost jsem odstranil
stiskem F5 a na panelu Editing v zalozce Modifiers stisknul tlacitko Add Modifiers - Subsufrs a zvolil
algoritmus druhotného déleni (subdivision algorithm) na Catmull-Clark, stupef zaobleni (level) na 3 a
pocetrozdéleni pfi renderovani (render levels) na 2. Tim se na zvoleném objektu objevila nova
zaoblena podsit, dalSim ziemnénim jsem dosahnul stiskem tladitka Set Smooth v zalozce Link and
Materials. Vznikly zaklad pro kohoutek jsem pfesunul v Objektovém mddu mimo stfed os xy,za
pfesunul se objektovym kurzorem do bodu [0,0,0]. V dalSim kroku jsem pfidal dal§i UVSpehere a
podobnym zplsobem vymodeloval potfebné rameno pro kouhoutek, ktery jsem 3x zkopiroval kombinaci
klaves Shift+D a pomoci toolboxu, které se otevie klavesou N, nastavil mediany vSech bodu jednotlivych
ramen, tak aby se vnofily symetricky do zakladu kohoutku. K této operaci jsem vyuzival vSech moznych
pohled(l TOP, SIDE, FRONT, BOTTOM a funkce pro otaceni objektuR. Kdyz uz kohoutek kone¢né
pfipominal tvarem koutek na fotografii, pfepnul jsem se do jiné prazdné a zac¢al pracovat na podstavé
trubice. Pfepinani vrstev se provadi na spodni list€ okna v objektovém maddu, viz nasledujici obrazek.
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Vysledny kohoutek potom vypadal takto:



Podstava trubice

Nejprve jsem pfepnul do pohledu TOP a na stfed vloZl objekt stiskem SPACE a volbou Add -> Mesh ->
Circle. Vpohledu FRONT jsem za pomoci vySe zminéného triku o nulovém prodlouzeni a nasledné
aplikaci funkce SCALE (S) wytvofil detailni dekoraci na samém dné podstavy. Dale jsem postupnou
kombinaci roz8ifovani a §kalovani vymodeloval podstavu pro trubici.

Vodovodni trubice

Vnové wrstvé jsem pfidal v pohledu TOP na stfed osy x,y novy objekt Add -> Mesh -> Tube s primérem
odpovidajicim otvoru pro trubici v podstavé.



Potfebného zatoceni trubice jsem dosahnul pomoci funkce SPIN v Editanim modu (F5). Nejprve jsem
si oznacil v kruznici body na konci trubice a kurzor umistil v TOP pohledu mimo trubici vose y ve
vzdalenosti, ktera tvofi polomér zaobleni. Poté jsem se pfepnul do FRONT pohledu a vnastaveniv
zalozce Mesh Tool editaniho madu nastavil stupné (Degr) na 180. Stiskem SPIN se vygeneruje
pozadovany tvar. Usti trubice jsem jiZz dotvaroval podobné jako kohoutek & podstawvu. Pred tim, neZjsem
zapnul v8echny wrstvy (se stisknutym SHIFT), ve kterych byly ulozeny objekty, nastavil jsem na trubici a
podstavé SUBSUFR na Catmull-Clark.

Zavérecné upravy

Momentalné se nachazim vobjektovém modu, v prostoru jsou umistény postupné vSechny soucasti
vodovodni baterie. Zbyva jiz tedy "shromazdit" je okolo podatku soustavy soufadnic a poskladat do
pozadovaného tvaru. Proporcionalni rozdily jsem odstranil tak, ze jsem jednotlivé objekty oznadil
vyselektovanim v8ech jeho bodd a pomoci tlacitka S a tahu mySi ménil jejich velikost.

V uvodu zminény nedostatek rozliSeni teplé a studené vody jsem vyfeSil vymodelovanim &asti kulové
plochy o poloméru stejném jako kulova plocha kohoutku.



Material

Pro material baterie jsem pouZl viastnosti chromu. Parametry chromu jsem pouZl zdatabaze
materiald na The Blender Materials Library. Nejprve jsem oznacil objekt, jehoz material jsem chtél
zmenit. Stiskem SHIFT+F1 jsem se dostal do nabidky pro pfipojeni knihovny. V adresafovém stromu
jsem zvolil stazeny soubor s pfiponou .blend, ve kterém jsem urcil pozadovany material. Ten se
automaticky pfipojil k mému projektu. V zalozce Link to Object nabidky Shading (F5) a Material Button
jizstaci tento material zvolit, Cimz se aplikuje na oznaeny objekt. Viastnosti materialu Ize dale
nastavovat ve zbyvajich zalozkach Material a Shaders. Vysledny model jsem vyrenderoval klavesou F12

a ulozil pomoci F3.




Reference

1. Documentation, Video turorials - http://www .blender.org
2. Material database - http://www.geocities.com/pollythesheep/matlib_indexhtml
3. Completely Lost In Blender - http://www freesoftwaremagazine.com/node/1614



Empire State v Blenderu, aneb jak to vidim ja

Vypracoval: Miroslav BuluSek

V modelovacim programu Blender3D jsem se pokusil vymodelovat Empire State
Building. Nutno dodat, Zze jsem se s nim ucil prvné, tedy si nekladu za cil vérnou kopii ¢i
n¢koho naucit modelovat, ovSem pokud jste na tom stejné jako ja, pak Vam mdj privodce
piijde vhod. Zkusenéjsi odkazu na lepsi navody/tutorialy. V samotném Blenderu jsem se ucil
metodou pokus-omyl. Zakladni ovladani Vam po dni hrani si pfijde jednoduché, ovSem
nejdiive k samotnému Blenderu.

Néco o Blenderu:

Blender je open-source program vyuzivany pro vykreslovani 3D grafiky a animaci.
Jeho vyvoj zapocal Ton Roosendaal, ktery poté zalozil spolecnost NaN pro dal§i rozvoj
Blenderu. Po krachu NaN se Ton dohodl s véfiteli spolecnosti, ze za 100 000 Euro odkoupi
licenci. Blender je od té doby distribuovany pod licenci GNU GPL. Nyni je vyvoj Blenderu
pod rukama Blender Founadation.

To by nam na tvod stacilo. Jen podotknu, ze ma verze je 2.46.

Orientace a ovladani:

Po prvnim spusténi, vidite mfizku se tfemi objekty. Fialové oznacenou plackou, i kdyz
se nam to zatim nezda, je krychle. Dale tu mame kameru a svétlo (Lamp). Toto je vzdy
vychozi stav programu. Nevidite-li jeden z objektii, pouzijte oddaleni. Docilite toho bud’ to
»plus® a . minus“ na numerické klavesnici nebo koleckem mysi (KM). Nedisponujete-li ani
jednim, pak jde pouzit AltGr+Levé Tlacitko MySi ( LTM). Pokud nevite, jak jednoduse
hybat s pohledem, pak Vam poslouzi Ctrl+KM a Shift+KM a nasledné hybani mysi. Hodné
Vam to usnadni praci, nalézt ,koukatelnou® pozici pomoci numerické klavesnice je obcas
nadlidské. Z vlastni zkuSenosti nedoporucuji Blender ovladat na touchpadu.

K zminéné krychli. Aby se krychle (placka) stala krychli, je potfeba zménit pohled ¢i
nahled na objekt. Pro zménu pohledu slouzi numericka klavesnice. Pro otaceni pohledu slouzi
Num4 a Num6. K naklapéni pohledu klavesy Num2 a Num8. Pro pohled shora je pouzita
klavesa Num?7, pro pohled z boku Num3 a pro pohled zpfedu Numl. Klavesa Num0 je
vy¢lenéna pro kameru. Ta je dilezita pro vykreslovani objektt, respektive co je v zorném poli
kamery to bude i vykresleno. K vykreslovani/renderovani daného objektu slouzi klavesa F12.
Je-li vykreslovani prili§ pomalé, mizete si pohrat s nastavenim, to se skryva pod klavesou
F10. Blender nabizi vystup do spousty formatti, nam bude stacit obrazek ve formatu JPG, pro
jeho ulozeni slouzi F3.

Nyni ptejdu jiz k samotné tvorbé objektt. Ujistéte se, ze se nachazite v Edit Mode. Pro
piepinani mezi Object Mode a Edit Mode slouzi tabuldtor (Tab). Nejdiive vymazeme
krychli, to provedeme zmacknutim klavesy A (all), ¢imz oznac¢ime veSkeré objekty a po té
obligatni Delete nebo klavesu X. Nyni jiz mdme miizku prazdnou. Miizeme vlozit néjaky
objekt. Pro jednoduchost si vlozime rovinu. Tedy v Edit Mode si Pravym Tlacitkem MySi
(PTM) umistime kurzor do stiedu soumérného systému. Nedafi-li se Vam to, pouzijte
Shift+S a vyberte Cursor -> Grid, je ovSem nutno umistit kurzor co nejblize stfedu
soumé&rnosti. Také je dobré zkontrolovat zda-li Vam kurzor ,,neplave® v 3. ose.



Nyni si vlozime rovinu a na ni si ukdzeme zakladni prace. V Edit Mode zmackneme
Num?7 a Mezernik. Vyjede ndm nabidka, zvolime Add -> Plane. Vlozil se nam ,,rizovy“
¢tverec, rtizova barva znaci, co vSe mame oznaCeno. Standardné se v Blenderu oznacuje
pomoci PTM. Nyni tedy mame oznaCeny vSechny vertexy. Abychom z 2D objektu vytvorili
3D objekt, pouzijeme klavesu E. Ta ndm vyvola nabidku Extrude. Z ni zvolime Region. Nyni
se nam z roviny stava 3D objekt. Dokud nezmackneme PTM ¢i LTM bude Extrude aktivni.
3D objekt se nam tvofi pomoci osy z, ovSem lze pouzit i jinou osu. Zkuste pfi aktivnim
Extrude zmacknout klavesy X, Y, Z. Ty nam fikaji, v kterém sméru bude Extrude probihat.
Meél bych podotknout, ze potvrzeni akce se provadi LTM, zatimco PTM akci ukondi (stejny
vyznam ma i klavesa Esc).

Nyni jiz vime, jak vytvofit objekt. Dejme tomu, ze jsme si vytvorili kvadr. Na ném si
ukdzeme par operaci.

Zvétseni: Nejdiive vybereme tu ¢ast, kterou chceme zvétsit ¢i zmensit. Oznacime vse, bud’to
pomoci PTM ¢i klavesy A, a zmackneme klavesu S. Hned vidime co se s objektem dé&je pri
pohybu mysi, opét je mozno zvétSeni provadet v riznych osach. Nebo mlizeme oznacit jen
Cast a zvetsit ji.

Pozn.: K oznaceni urcité casti nebo casti slouzi i pismeno B.

Rotace: Provadi se stejné jako zvétseni. Pouzijeme klavesu R. Pro zarovnani k jednotlivym
osam doporucuji ménit pohledy, jinak ndm objekt bude ,,plavat™ respektive bude nesoumérny
s nékterou z os.

Pozn.: Pozdeji jsem prisel na to, Ze drzite-li Ctrl pak se rotace pohybuje po 5 stupnich. Také
se Vam ukazuje hodnota rotovani, Ize tedy presné objekt pootocit jak se nam hodl.

Posunuti: Provadi se pomoci pismena G. Podotykdm, Ze miizeme posouvat ve vSech tfech
osach ¢i libovoln€. Posouvat 1ze i pomoci PTM. Dalsi moznosti je kliknout na jednu z Sipek
(modra, zelena ¢i Cervena), které charakterizuji jednotlivé osy.

Pozn.: Nevidite-li tento symbol Sipek, pak pouZijte jednu z predchozich moznosti. Ne vzdy je
viditelny a pro nezkuSené to znamenda zacit od zacatku z ditvodu nesoumérnosti.

Priprava k modelovani:

Jak jsem zminil, pokusil jsem se vymodelovat Empire State Building v New York
City. Jde o 102 patrovou budou postavenou v roce 1931, kdy se stala nejvyssi budovou svéta
s 381m. Nejdiive jsem si vyhledal, jak budova vypada. Ulozil jsem si nékolik fotek. Snazil
jsem se o ruznorodost pohledd. Ne na vSech fotkach ¢i ilustracich vypada ESB stejn€. Tuto
budovu jsem zvolil zhlediska jednoduchosti, i kdyz to se to postupem casu nezdal byt
nejlepsi napad.



Vlastni modelovani:

Stejné jako Vy, zacal jsem
modelovat od uplného zacatku. Vlozil
jsem si objekt plane, ktery jsem roztahl
na obdélnik. Poté jsem pomoci Extrude
vytvofil kvadr. Ten mi slouzi jako
podstavec pro pozd¢jsi budovu. Po té
jsem si zarovnal kurzor na stfed a vlozil
dalsi rovinu. Tu jsem zmenSil a pouzil
Extrude pro vytvoteni hranolu.

Pozn.: V priubéhu modelovani jsem objevil to, jak by se nékteré casti budovy dali udélat méné
komplikované. V takovem pripade se o tom zminim.

Nyni jsem zacal vytvaret objekty
podle fotografii. Podivate li se na to, jak
je budova od spodu postavena, vSimnete
si, ze je do vysky ,obestavena*
jednotlivymi bloky. A na né¢ jsem
zamétil své modelovani. Ony bloky si
lze rozdélit do nékolika objektt. Podle
tvaru podstavy to jsou obdélniky a vzdy
2 obdélniky tvofici pismeno L. Jelikoz
jsem se z Blenderem seznamoval prvné,
tyto tvary L, jsem vymodeloval tak, ze
jsem spojil 2 obdélniky. Po té uz bylo jednoduché pomoci Extrude z nich vytvotit 3D objekty.
Tyto ,,L* objekty jsem potifeboval 4. Tedy jsem je zkopiroval. V Blenderu se kopirovani
provadi pomoci Shift+D. Pak jiz stacilo pouZit rotaci spolu s klavesou Ctrl a otocit na dany
pocet stupiiti a posunout na spravné misto.

Timto mame spodek hotovy.

vvvvvv

Faces. V liste kde je Edit Mode je na pravé strané ikonka trojuhelniku. Nebo stisknéte
Ctrl+Tab a vyberte Faces. Sami pozndte jak se vSe usnadni.

Nyni uz budeme modelovat vriek
budovy. Zacal jsem tim, ze jsem si na
vrsek prozatimni budovy vlozil objekt
Plane, ten zmenS$il pomoci Sa funkci
Extrude jsem ho protahl do vysky. Nyni
bylo tfeba tento vrSek obestavit bloky ve
tvaru Sirokého U, abychom dosahli
,vykousnuti“. Opét jsem si jej
vymodeloval pomoci objektu plane a
umistil. Na to jsem ho zkopiroval, otoc¢il
a umistil na opacnou stranu. Zminény
,»U“ objekt jsem si pomoci Faces
oznacil, zmensil ho, zkopiroval a umistil naproti. Opét pomoci Faces oznacil oba a vytvofil
3D objekt az do vysky prozatimni budovy. Vr$ek mame tedy zarovnan. Umistil jsem kurzor




doprostfed horniho pohledu a zkontroloval soumérnost. Pak jsem vlozil objekt Plane a
zmensSil ho, pouzil Extrude. Takto jsem to ucinil Sestkrat a docilil jakési pyramidy.

Pozn. Znacného usnadnéni dosahnete oznacite-li si vrchni Face a zmacknete S a poté
Extrude.

A nyni se dostdvam k samotné Spicce
budovy. Nejdiive si vymodelujeme
¢tyfcipou hvézdu. Ja pouzil objekt Plane
a pohybem vektori jsem vytvofil Vi
hvézdy, tu sem zkopiroval, otoc¢il a
posunul na své misto. Zkopirovanim 2
hvézdy a oto¢enim dosdhneme kyzeného
vysledku. Nyni ji staéi umisti na
samotny vrSek a jak je zminéno
v poznamce, 4x pouzit Extrude a vzdy
zmens§it velikost.

Pozn. Hveézdu jde vymodelovat snadnéji z kruhu. Staci nastavit vhodny pocet vrcholii
(Vertices) a plny kruh (Fill) tomto pripadé 8. Pak jiz staci kazdy lichy posunout ke stredu
kruhu.

Nyni do vysky, kde zacina hvézdova pyramida vlozime kruh. Zmackneme mezernik a
zvolime Add -> Circle. Na jest¢ oznaceny kruh pouzijeme Extrude a vyrosteme do roviny
vrsku. Oznac¢ime li si nyni horni Face, zkopirujeme ji, pouzijeme Extrude a zmackneme S,
muzeme docela snadno vymodelovat rozsifenim ¢i zazenim kruhu a opakovanim posloupnosti
téchto operaci ,,bambulku®, které se nam hodi na §picku budovy. Takto mizeme vymodelovat
1 kuzel. Staci jen pokroCovat v posloupnosti operaci. Vrsek kuzele je komoly, to mame pro
uplnou $picku. Tu vytvoiime oznacenim nejhornéjsi Face, jejim zkopirovanim a vytvofenim
uzkého a vysokého valce. Jako posledni operaci u $picky, stejnym zptisobem, vloZime stejné
vysoky valec a pomoci S ho zaspic¢atime. Takto mame hotovou celou kostru budovy.

Na nasledujicich 2 obrazcich je vyobrazena nase Spicka a $picka po upravé povrchu.
Blender ma velkou skalu nastaveni, to se tyka i Uprav povrchu. Ja se budu vénovat hladkosti
povrchu. V Blenderu je to Smooth. Nejprve jsem pouzil Subdivide, skryva se pod klavesou
W. Zmacknete-li, vyjede nam vétsi nabidka. Oznacil jsem si cely objekt a vybral Subdivide.
Tato funkce nam cely objekt rozdéli na mensi ¢asti. Nyni opét zmackneme W a vybereme Set
Smooth. Tim se nam objekt vyhladi.




Pozn. Hladkost povrchu se da upravit i dale. Stisknéte klavesu F9. Pod ni se skryva editovani.
Najedte na zdalozku Modifiers a kliknéte na Add Modifier -> Smooth. Pohrajte si
s nastavenim. Pro mne byla uprava povrchu dostacujici. Jesté podotknu, Ze pri vyrazném
., hastaveni** dochazi k deformacim.

K dokon¢eni  Empire  State
Building jiz moc neschazi. Témér kazda
budova ma okna a ani tato neni
vyjimkou. K modelovani oken jsem
pouzil opét objekt plane. Z ného vytvoril
obdélnik a ten nalezit¢ zmensil. Tento
obdélnik jsem umistil na jeden z blok,
které jsme modelovali na zacatku..
Nejdulezitéjsi bylo zachovat soumérnost,
tedy Num7, Numl a Num3. Pak zacala :
série  kopirovani, pomoci Shift+tD a |
nasledné tlacitko dané osy, ve které jsem chtél objekt posunout. Jakmile jsem dokon¢il dany
blok budovy, oznacil jsem vSechna okna pomoci Faces a zavolal Extrude a vytvoril tak ,,3D*
okna. Postup jsem aplikoval na v§echny bloky budovy. Konec¢na budova vypada néasledovne.

Pozn. Pri oznacovani oken diirazné doporucuji pouzivat Faces a ne selektovani jednotlivych
vertextii oken. Ubude Vam spousta namahavé prace.

Nakonec jsem na podstavec
budovy vlozil napis. Nejprve zarovname i
kurzor a zmacknutim mezerniku a
vybranim Add -> Text vlozime text.
V Edit Mode upravujeme praci s textem -
v Object Mode snim  mulzeme f
pohybovat, rotovat a zvétSovat. Nejlépe
v Object Modu miizeme ménit nastaveni
a hned vidét zménu. Ja nastavil Extrude hh m‘
na 0,2, Bevel Depth na 0,02 a Bev Resol
na 32 (jedna se o upravy textu, zkuste
sami. Extrude jiz zname). Na vloZeném
napisu si mizeme ukazat i zménu barvy Ci pridani vlastni textury. Nejdiive k barvé.
Zméckneme FS5 a vyjede ndm materidlové menu. Stiskneme Add New v kolonce Material.
Barvu zménime stiskneme-li ramedek F-_
nalevo od Col. Zbylé 2 ramecky urcuji
barvu zrcadleni.

Chceme-li na napis pouzit
texturu, mizeme ji bud’to zvolit ¢i nahrat
vlastni. Nejdfive k vlastni. Na nas napis
aplikujeme vlastni texturu ve tvaru
dreva. Opét F5 a Add New. Po té
stiskneme F6 a zvolime Add New. Jako
type zvolime Image. Nyni staci kliknout
na Load Image. Nemame-li texturu
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vlastni, mizeme pouzit ty, které jsou implementovany v programu. Postupujeme stejné jako
pfi vkladani vlastni textury, jen misto typu Image zvolime jiny.

Posledni véci, o které se zminim je osvétleni. Blender nabizi 5 typd, které lze pouzit.
Jako nejvhodngjsi se mi jevi Hemi spole¢né s né€kolika objekty typu Lamp. Objekty
pridavame tak, ze stiskneme mezernik a vybereme Add -> Lamp. Pak jiz staci vSe nalezité
rozmistit. Se svételnym objekty se da pohybovat jen v Object Mode.

Zavérem:

Rad bych pfidal jesté nekolik rad. Mozna jste narazili na problém s pohybem kamery.
Lze to vyfesit i posunem objektu do objektivu kamery, ov§em pohodInéjsi je v Object Mode
stisknout Shift+F a nasledn¢ hybat mysi popt. koleckem.

Obcas se mi stalo, ze ani po velkém oddaleni od objektti jsem nevidé€l objekty kamera
a svétlo, pomohlo na numerické klavesnici zmacknou ,,lomitko*.

V pribéhu modelovani a pfi renderovani obrazku je Casové naro¢né vyrenderovat
celou obrazovku. Proto doporucuji na zalozce, kde se nachazi Edit Mode, View -> Render
Preview.

Posledni rada je, ze pismeno G lze pouzit nejen pro pohyb objektem (méame-li ho
oznacen cely), ale i pro Upravu velikosti. Zkuste oznacit jen dva vertexy a sami uvidite.

UZite¢ne odkazy:
- Nejvétsim zdrojem je http://www.google.com.
- Dale mohu viele doporucit http://www.youtube.com.
- Pro znalé angli¢tiny vynikajici http://wiki.blender.org.
- Bez téhle stranky by to neslo http://www.blender.org.
- Na Ceské scéné skvéla http://www.grafika.cz.

- Malem bych zapomnél na vSevédouci http://cs.wikipedia.org/wiki/Blender



Modelovani piana v programu Blender

Ondiej Cernohorsky

V tomto tutoriadlu se budu snazit popsat modelovdni piana v programu Blender ve verzi 2.44. Jako
snad v kazdém tutoridlu pro Blender za¢nu popisem prostiedi a zakladnimi klavesovymi zkratkami
pro pohyb v ném. Pak se zaméfim na modelovani jednotlivych ¢asti celého pidna, jehoz ¢asti byly
modelovany dvéma hlavnimi technikami. Nejvice bylo pouzivdno modelovani pomoci funkce Extrude,
kde byl ve mnoha pfipadech vysledny vymodelovany povrch jesté dodatecné modifikovdn pomoci
funkce Subsurf. Doslo i na pouZziti Bézierovych kfivek pti tvorbé téla piana. Poté se zaméfim na volbu
materialu, pouZiti textur a nastaveni osvétleni.

Nékteré uzitecné klavesové zkratky:

Hlavni filozofie pracovani v Blenderu je mit jednu ruku na mysi a druhou na klavesnici, kde stiskem
jednotlivych kldves aplikujeme rzné funkce, aniz bychom je museli aktivovat z rliznych menu. To
vyrazné urychluje prdci, je vSak nutné o téchto zkratkdch védét. To je prdvé kamen Urazu pro
zacatecnika, ktery jesté neni na tyto zkratky zvykly a pak mu prace v Blenderu mZe pfijit neobratna,
avsak, az si tyto zkratky zapamatuje, stane se prace v tomto programu radostné;jsi. Podrobny seznam
zkratek Ize nalézt napfiklad zde:

http://download.blender.org/documentation/BlenderHotkeyReference.pdf

Zde v tomto tutoridlu se zaméFim jen na ty nejzdkladnéjsi zkratky, bez kterych jsem se pfi praci
neobesel. Asi nejzékladnéjsi véci je se umét po nasi scéné pohybovat, popf. si ji rizné natacet,
posunovat, pfibliZovat nebo oddalovat:

CTRL+KM (kolecko mysi) — vertikalni posouvani
SHIFT+KM — horizontdlni posouvani
KM — oddalovani, ptiblizovani

NUM?7 (7 na numerické klavesnici) — pudorysny pohled na rovinu XY

NUMS3 - pohled z boku na rovinu YZ

NUM1 - pohled z boku na rovinu XZ

NUM2 - otaceni doleva

NUMS6 — otaceni doprava

NUM2 - otaceni dold

NUMS8 — otaceni nahoru

NUMO - pohled z kamery — tedy pohled ze sméru, ze kterého scénu referujeme

LM (levé tlacitko mysi) — nastavuje kurzor, do tohoto mista se pak vkladaji objekty
PM (pravé tlacitko mysi) — tim Ize uchopit jednotlivé vrcholy (popt. hrany, plochy nebo cely objekt)



G+pohyb mysi — pohyb s objektem
R+pohyb mysi - rotace objektu
S+pohyb mysi — zména méfitka objektu

To prozatim staci, k dalSim zkratkdm se dostaneme v prlibéhu textu.

Prostredi Blenderu:

Nyni néco malo k prostrfedi Blenderu. Po zpusténi Blenderu nas pfivita takovéto prostredi:
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Lze ho rozdélit do tfi ¢asti.

Na vrchni ¢ast:

2 Blender

Na ¢ast prostiedni, ve které probihd vlastni modelovani:



a na Cast spodni, ve které se vyskytuji funkce, které se tykaji od vkladani riznych objektl az po
nastaveni materialQ, svétla nebo textur:

Prostfedni a spodni okno si Ize rozdélit na libovolny pocet ¢asti, pokud bychom najeli mysi mezi prvni
a prostiedni nebo mezi prostfedni a spodni ¢ast. Kurzor se zméni na oboustrannou Sipku a po kliknuti
na PM se zobrazi menu, kde vybereme volbu Split Area. Pak uZ si jen zvolime, kterou oblast chceme
rozdélit. Velikost jednotlivych oken mlzZeme dodatecné upravit mysi.

v v/

Déleni oken je uziteéna véc, protoze pokud modelujeme néco slozitéjsiho, Ize si do jednotlivych oken
nechat zobrazit nas objekt z rdznych smér(. To pak velmi usnadni orientaci v nasi scéné.

V prosttedni ¢asti mUzeme vidét dva objekty, ten kulaty je svétlo, a ten druhy je kamera. K témto
objektim se jesté dostaneme.

Jesté poznamka k listé vespod prostiedni ¢asti, kde je za nabidkami View, Select a Mesh nabidka
maodu. Zde v tomto tutoridlu budeme pracovat jen v Object Mode a Edit Mode. V Object Mode se
pracuje s télesem jako celkem, lze tedy napf. upravovat jeho polohu, velikost nebo natoceni, kdezto
v Edit Mode mUZeme pracovat s jednotlivymi vrcholy, hranami, nebo plochami objektu a timto
vysledné cely objekt deformovat.



Modelovani klaviatury:

Po spusténi Blenderu se do prostfed okna automaticky vlozi krychle. Tu vymazeme (pomoci tlacitka
DELETE), abychom zacali UpIné od zacatku. Zmackneme NUM7, abychom se dostali do plidorysného
pohledu. Novy objekt vloZime do scény pomoci tlacitka SPACE; po jeho zmacknuti se objevi menu

s nabidkou co vloZit. Vybereme Add -> Plane a na misté, kde se nachazi kurzor, se objevi ¢tverec.
Jsme prepnuti do Edit Modu (pokud jsme v ném uz nebyli). PM si ozna¢ime spodni vrchol ¢tverce a
s pomoci kldvesy SHIFT k nému pfiddme jeho druhého spodniho kolegu. Lze to provést i tak, ze
zmackneme klavesu B a pak kurzorem oznacime poZzadované vrcholy (nesmi byt oznacené i jiné
vrcholy, jinak by se donasec vybéru také dostali). Nyni mGzZeme protdhnout tvar naseho ctverce; Ize
to provést pomoci zmacknuti kldvesy G a nasledného pohybu mysi. Pokud bychom chtéli objekt
tvarovat presné ve sméru os, staci bud mysi najet na jednu z barevnych os kurzoru a pak pohybem
mysi s objektem pohybovat, nebo zmacknout G a poté bud' X, Y nebo Z, to podle toho ve sméru které
osy chceme pohyb vykonat. Pokud chceme aby se vrcholy pohybovaly po skocich, zmackneme
kldvesu CTRL. Ctverec vytvarujeme do takovéhoto obdéIniku:

Nyni se pfepneme pomoci NUM1 do ¢elniho pohledu, zmackneme kldvesu A pro oznaceni vSech
vrchol(. Pomoci metody extrude (kldvesa E) ,,vytdhneme” ¢tverec nahoru a ziskdme tim kvadr.




Pfepneme se do Object Modu, oznacime objekt a zmacknutim kldves SHIFT+D z néj udélame
duplikat, ktery mGzeme pomoci kldvesy M presunout do jiné vrstvy (Layer). Mezi jednotlivymi
vrstvami se da prepinat tlacitky nalevo od ikony zamku na spodni listé prostiedni ¢asti v prostredi
Blenderu, musime viak byt v Object Mode (M Ize také pouzit jen v Object Mode). Pokud budeme
drzet tlacitko SHIFT a budeme klikat na jednotlivé vrstvy, zobrazi se ndm vSechny, na které jsme klikli.
Prace ve vrstvach vyznamné ulehcuje praci a napomadha zvyseni orientace ve scéné. (povypinanim

véci, které v dany okamzik nepotfebujeme vidét.

Z tohoto duplikdtu se budeme snazit vytvarovat hlavu klavesy. Oznacime si duplikovany objekt a
posuneme ho presné nad jiz vymodelovanou kldvesu. Pfepneme se do Edit Mode a duplikovany
Utvar zplostime. (Oznacime si horni sténu a pretdhneme ji kousek dold.)

Pokusime se objekt zaoblit. Zmackneme F9 a dostaneme se do Editing menu ve spodni ¢asti
prostiedi. Najdeme kartu Modifiers, tam zmackneme tlacitko Add Modifier a vybereme Subsurf.
Vidime, Ze se ndm nas kvadr zaoblil. Metoda Subsurf je v podstaté metoda déleni povrch(. Lze si zde
navolit jaké déleni pouZit, implicitné je zde nastaveno Catmull — Clarkovo déleni. Pfepinacem Levels
volime hladkost plochy, tladitko Render Levels voli hladkost plochy pro referovani. My si vsak
takovéto zaobleni neprejeme. Spi$ bychom chtéli dostat tvar podobny takovémuto:

Takovyto tvar dostaneme, pokud vytvofime mfizku stejnou jako na nésledujicim obrazku. Rezéni
objektu a tedy ziskdvani novych vrcholl provadime kldvesami CTRL+R. Zkuste si, jak to funguje. Pro
zajiSténi aby byla zadni plocha ostrd, musime pomoci zkratky CTRL+R vytvofit fez a ten cely posunout

k zadni ploSe. Podobné se spodkem objektu.



Nakonec jesté objekt mirné protdhneme. Po zobrazeni obou vrstev dostaneme:

A mame jednu kldvesu hotovou.

Cerné kldvesy udélame podobné jako hlavy kldves bilych. Dostaneme pfiblizné néco takového:

Nakonec pomoci duplikovani (SHIFT+D) a poskladani kldves vedle sebe dostaneme celou klaviaturu:



Modelovani téla piana:

Pomoci NUM7 se pfepneme opét do pldorysného pohledu. Zmackneme SPACE, objevi se menu, ve
kterém zvolime Add -> Curve -> Bezier Curve. Zobrazi se ndm kfivka, kterou lze tvarovat pomoci
usecek. Budeme se snaZit tuto kfivku vytvarovat tak, aby jeji hranice pfipominala télo piana, kdyz se
na néj divame ze shora. Je tfeba si trochu pohrat, abychom dostali tvar, ktery se podobd tvaru
pozadovanému. J& jsem zacal od pravého spodniho bodu, poté jsem vytvaroval zaoblenou kfivku
kfidla piana, poté jsem musel tlacitkem V zlomit kfivku, abych dosahl ostrého rohu. Tlacitko V ndm
prepdli Usecku, kterd uréuje tvar Beziérovy krivky. Pokud tyto poloviny Usecek nastavime do pravého
Uhlu a poté priddme dalsi bod stiskem CTRL+PM, vytvorime roh. Takovymto postupem dostaneme
tvar téla piana, ktery nakonec uzavieme tlacitkem C. Pokud nejsme spokojeni s tvarem kfivky, kterd
nam spojila prvni bod kfivky s poslednim, opét mizZeme v prvnim nebo poslednim bodé kfivku zlomit
a nasledné ji editovat, do poZadovaného tvaru. Timto jsme dostali pldorys téla koncertniho kridla.




Po uzavreni kfivky nastavime parametr Extrude v karté Curve and Surface na spodni listé na hodnotu
0.5. Dostaneme:

Télo piana bychom tedy méli. Nyni udélame viko. Opét kombinaci SHIFT+D zduplikujeme télo piana a
dostaneme druhé télo piana, které nepatrné zvétSime a z plidorysného pohledu upravime jeho tvar,
aby kopirovat (zvétsené) tvar téla piana.




Podobné jako télo piana vyrobime zbylé ¢asti pfedku. V pldorysném pohledu vytvofim pred
korpusem piana obdélnik, ktery posléze vyextrudujeme zhruba do jedné ¢tvrtiny vysky téla piana. Na
néj se polozi klaviatura.

Pomoci Bézierovych kfivek vyrobime taktéz boc¢nice u klaviatury

a také mala nastaveni, které zaplni prostor mezi bo¢nicemi a klaviaturou samotnou. (ta se udélaji
podobné jako napt. cerné klavesy klaviatury.)




Nakonec udéldme viko na klaviaturu a provedeme to podobné, jako kdyZ jsme délali bo¢nice bocnice.
Zde nalezneme pUvab pracovani s vrstvami, kdy pfi ,pfidélavani“ vika k télu piana povypiname
vSechny vrstvy, které vidét nepotiebujeme, a tvorba naseho objektu je ptehlednéjsi.

Poté, co cely predek sloZzime dohromady jako sklddanku, dostaneme:




Modelovani nohou piana a kolecek:

Budeme se snazit udélat néco takového:

Zmackneme NUM1 a vloZzime do scény pomoci SPACE a nasledného menu kruznici, kterou
vyextrudujeme, abychom dostali valec. Podstavy pomoci metody Extrude dostaneme do
nasledujiciho tvaru:

Potom vyextrudujeme do vélce a plochu uzavieme pomoci kldves SHIFT+F.




Nakonec pfidélame po stranach jesté dva mensi vélce.

A kolecko je hotové. Nyni vytvorime Uchytky.

Vlozime ke kolec¢ku novou plochu. (klasicky pfes SPACE -> Add -> Mesh -> Plane)

Podobné jako u ¢ernych klaves ji dostaneme do tvaru podobnému nasledujicimu obrazku (pomoci
Subfurf) a tlac¢itky CTRL+R pridédme dalsi vrcholy nad drovni povrchu kolecka. Nakonec tuto vrstvu
zkopirujeme pomoci SHIFT+D a pomoci M (musi byt v Edit Menu) ji ozrcadlime podle néleZité osy a

dopravime na druhou stranu kolecka.

1




Nyni (pokud tam jiZz nejsme) se vratime do ¢elniho pohledu (NUM1) a upravime plochy kolem kolecka
do tvaru jako je na obrdzku. Toho docilime tim, Ze z ¢elniho pohledu obrdzek pomoci tla¢itka R a
pohybu mysi zrotujeme o 45° (pfi drZeni CTRL budeme rotovat po 5°), pak po zmacknuti tlacitka B
oznacime vrcholy (viz ndsledujici obrazek) a dostaneme je do pozadovaného tvaru.

Nakonec vloZzime mezi tyto plochy zaobleny kvadr (opét pomoci Subsurf). (viz obrazek na zacatku

¢asti o modelovani kolecek)

Takto vyrobené kolecko pridélame na sokl, ktery poté pridélame na nohu, kterou ptipojime k pianu.
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Modelovani pedali:

Nyni uz zbyva jen vytvofit peddly a nohu piana, kterd k nim vede. Pfepneme se na pohled seshora
(NUMZ?) a vloZime ¢tverec. Pomoci metody Extrude (E), R (rotace) a S (zména méfitka) vytvarujeme

tvar podobny tvaru na obrazku.

K vytvoreni takovéhoto tvaru lze také pouzit CTRL+LM. Tato kombinace ndm totiz do obrazku na
aktudlni pozici kurzoru prida novy vrchol, resp. takovy objekt, ktery mame pravé oznaceny, a spoji ho
s vrcholy plvodné oznaéenymi. Pokud mame tedy oznacenou pfimku, tento pfikaz ndm na misto
kurzoru vloZi dalsi pfimku a spoji ji s plivodni pfimkou oznacenou (po vrcholech). Takto to vypada
mozna zbytecné moc slozité, ale po vyzkouseni to bude hned jasné. Zfejmé se nam nepodati dany
tvar pfesné vytvofit, ale to nevadi, miZeme vSe doladit ru¢né praci s jednotlivymi vrcholy. Vysledny
tvar z bo¢niho pohledu vyextrudujeme nahoru. Dostaneme néco takového:

Na tomto obrazku jsou vrcholy horni vrstvy jiz ru¢né upraveny a povrch je zaoblen metodou Subsurf.

V Object Mode by pedal vypadal takto:



Nyni vytvofime nohu z piana, do které pedal usadime. Tvorba nohy neni nic tézkého, jedna se opét o
pouziti metody Extrude, nebo si mlzZete zkusit vloZit krychli a tu do poZzadovaného tvaru doladit.
Noha se sklada ze tfi kvadrovitych objektl. Napojime ji na spodek piana podle néasledujiciho obrazku:

Pohled na spodek piana by potom mohl vypadat asi takto.
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Zde stoji za povsimnuti vyhoda rozdéleni prostfedni ¢asti na vice obrazovek. Zde vidime, Ze

v nejvétsim okné se vénujeme pohledu piana zespoda, zatimco zbylé dvé okna ukazuji pohled

z kamery (NUMO) a bo¢ni pohled. Proto napfiklad usazeni nohy k pedalu bude o mnoho prijemnéjsi,
protoZe ji mohu délat bez zbytecného nataceni a posouvani scény. V horizontdlnim sméru pouziju
nejvétsi okno, ve sméru vertikdlnim pak okno vpravo dole. A na pohledu z kamery si mohu
zkontrolovat, jak vSe bude vypadat po vyrenderovani. Nyni uz zbyva jen usadit pedaly a madme piano
témér hotové. Jesté vlioZime na zem plochu, ktera bude pfi stinovani plnit roli podlahy.

Jak vidime, tento obrazek neni z pohledu kamery, dosahl jsem ho tak, Ze jsem si tlacitkem ; (pod Esc)
nechal zobrazit vSechny vrstvy a natocil se pomoci numerické kladvesnice do pozadované pozice. Jak
Ize vidét, pozice kamery a svétla je také v nasem uhlu pohledu. Kameru a svétlo Ize také vlozit do
vlastni vrstvy a nemusime si je nechat zobrazit, pokud ndm pfi praci vadi.

Material, textury a osvétleni:

Pro to, aby nas obrazek vypadal jinak nez Sedég, jak jsme ho znali doposud, slouzi nastaveni materiald,
textur a osvétleni. Na internetu lze o této problematice vyhledat spoustu material, které popisu;ji
pouZiti vSemoznych parametr(, které se této problematiky tykaji. Proto projedu tuto ¢ast strucnéji a
spiSe se zaméfim na to, co jsem sdm potzival nejcastéji. Do nastaveni materialu, textur a osvétleni se
dostaneme stlacenim ikony s ¢ernou kouli (Shading, tlacitko F5) na vrchni listé spodni ¢asti prostfedi
Blenderu. Objevi se ndam hned dalSich 5 tlacitek, prvni se tykd osvétleni, druhé materialu, treti textur,
¢tvrté radiozity a paté celkového prostredi.
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Nejdfive se zaméfime na material. Zkusime pfidat materidl télu piana. V Object Mode ho oznacime a
zmackneme materialové tladitko. Pomoci Add New material priddme. Zde si mizeme navolit barvu
materialu, pomoci ovlddaciho prvku Ref nastavime jeho odrazivost, Spec urcuje jeho lesklost a Hard

hrubost jeho povrchu. S témito parametry jsem pracoval nejcastéji. Nasledujici obrazek ukazuje, jak
ma konkrétni nastaveni pro material téla piana.
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Nastaveni téchto materidl( zaleZzi na vkusu kazdého z nds. Barvu téla piana jsem zvolil ¢ervenou. A
protoze jsem chtél zddraznit leskly povrch objektu, nastavil jsem Spec na vysokou hodnotu a Hard
naopak na hodnotu nizkou. Také Ref jsem pridélil hodnotu vysokou. Podobné nastaveni jsem proved|
i v pripadé kldves a kolecek, pouze s jinou barvou. Kazdy materidl si Ize uloZit v poli Links and
Pipeline, kde prepiSeme politko pod napisem Link to Object ndzvem, jaky jsme si pro materidl
vybrali. To je uZiteéné zejména v pFipadé pokud chceme jeden material pridélit vice objektim.



Textury jsem na piano nepouZzil, pouZil jsem je vSak na podlahu. Pro dany material se textury pridavaji
v menu po zmacknuti kldvesy F6. A pak jeSté v materidlovém menu Uplné vpravo po kliknuti na kartu
Texture. Tam Ize volit, na jaky tvar texturu mapujeme, barvu textury apod. Na podlahu jsem pouzil
takovouto texturu:

Tedy po zmacknuti F6 se ocitneme v Texture menu. Na zacdtku nelze Zaddna textura pfidat, musime
nejprve objektu priradit material (F5). Poté bude moZno v Texture menu texturu pfidat stlacenim
tladitka Add New. V Texture Type zvolime Image. Nasledné se objevi sekce Image a tam zvolime
Load. Tim nahrajeme nasi texturu. Dale ptiddme dalsi texturu. Tentokrat typ Clouds. PouZijeme ji
jako Bump-Map pro zvrasnéni povrchu podlahy. V menu Clouds zaskrtneme Hard Noise. Poté

v materidlovém menu (F5) obé textury pfidame. V pfipadé Clouds jesté v karté Map To, vypneme Col
a zapneme Nor. Hodnotu tohoto parametru nastavime podle toho, jak ma povrch vypadat zvrasnény.
Barvu textury jsem zvolil Cernou.

Co se tyCe osvétleni, jeho menu nalezneme po ikonu s lampickou po zmacknuti tlacitka F5. Nejdfive
vSak musime do scény vlozZit svétlo. To udélame tak, Ze na misté, kam chceme svétlo vloZit,
zmackneme SPACE a dale Add -> Lamp a tam si mUzZeme zvolit, jaky typ svétla chceme. Mdame na
vybér mezi Lamp, Sun, Spot, Hemi a Area. K tomu opét existuje fada tutoridld, takZe to nebudu moc
rozebirat, snad jen, Ze Sun je simulace rovhomérného denniho svétla, Lamp zase lampy a Spot je
néco podobného jako Lamp. Pro osvétleni scény pouziji Spot. VloZzme tedy do scény Spot. Jeho
polohu a smér jsem vybral asi takto:

V menu je fada parametrd, z nichzZ jednim z nejdileZitéjsich je posuvnik Energy, coz je intenzita. Déle
Ize navolit jeho barvu, ostrost apod.
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Jesté zbyva v nastaveni World (posledni tlacitko z péti ikon materidlového menu) nastavit okolni
prostredi, ja jsem ho nastavil na ¢ernou, aby byl dobfe vidét stin.

Pokud toto v§e mame navolené, miZeme provést findIni render obrazku:




Piano pfi osvétleni Sun a bez podlahy a s modrym pozadim nastavenym ve World menu:

Tyto obrézky si lze ulozit v File -> Save Image.

Zaver:

Modelovani v Blenderu, stejné tak jako asi i v jinych programech na 3D modelovani, zabira velmi
mnoho c¢asu a je tfeba zde neustéle néco objevovat. Nepteberné mnozstvi moznosti, které program
poskytuje, fantazii meze nekladou a Ize zde vymodelovat prakticky vie, na co si vzpomeneme. Nyni uz
je jen na nds a na nasem uméleckém citéni, jak nas model dotdhneme do konce.



Jakub Darani: Model lampicky

Fra:1 Ve 5205 Fa 5783 La:t Mem:12.18M (0.00M) Time:00.06,20

Pro svij zdpoctovy modelovaci pfiklad jsem si vybral stolni lampicku IKEA, kterou
jsem vymodeloval pomoci programu Blender verze 2.43. Nejprve jsem se
sezndmil s ovlddanim a moznostmi programu pomoci nékolika turoriall. V téchto
tutoridlech jsem se naucil pracovat s texturami, moznostmi modelovédni 3D
objektl z Beziérovych kfivek - modelovani luku, moznostmi pouziti prinikd a
sjednoceni jednotlivych objektd.

Lampicka IKEA se sklada ze tri ¢asti - stojanku, ktery je zvinény, spojovaci tyce a
krytu se zarivkou.

V prnim kroku jsem modeloval stojanek lampic¢ky. Prvnim ndpadem bylo
vymodelovat stojdnek pomoci Bezieriovy kfivky, ale tento postup bohuzel



neddaval dobry vysledek. Proto jsem vygeneroval krychli a valec, z kterych jsem
poté prinikem ziskal zaklad profilu stojanku. Prlinik dvou objektd je v Blenderu
mozné vygenerovat oznacenim vybranych objektl a stiskem kldvesy W. Potom
z nabidky vybereme moznost Intersect. Potom ziskdme mimo téchto dbvou
objektl objekt automaticky pojmenovany jako Mesh, ktery je vysledkem pravé
provedené operace. Pro pfesny model se mlzeme prepinat mezi jednotlivymi
pohledy kldvesami 1,3 a 7. Tim se d& snadno zkontrolovat symetrie objektu.

Pro vygenerovani objektu vhodné velikosti pouzijeme tlacitko S , které zméni
velikost objektu a pro Upravu tvaru Ize po oznaceni plochy pouzit bud moznost
Extrude region (klavesa S) nebo oznacit plochu a objekt v daném sméru
povytdhnout pomoci mysi.

Predpokladem pouZiti priniku je, Ze jsme si vygenerovali dva rlizné objekty. To
Ize zajistit tak, Ze po ukonceni editace jednoho objektu se pfepneme z Edit médu
do Object moédu a poté pridame druhy objekt. V pfipadé Zze bychom se do Object
maédu neprepnuli, ziskali bzchom pouze jeden objekt.

Stojanek lampicky ma také 6 drazek. Tyto drazky lze vymodelovat jako rozdil
dosud vygenerované ¢asti stojanku a Sesti valcl. Téchto 6 valcd vygenerujeme
jako jeden objekt a poté udéldme rozdil téchto dvou vzniklych objektl. Rozdil se
opét déld oznacenim obou objektl a stiskem kldvesy W.
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Timto ndm vznikne zéklad stojdnku. Oznacnime si cely stojanek a ulozime jej jako
jeden objekt. Pro tento objekt pak jesté zadefinujeme ¢ernou barvu jako barvu
povrchu. Dale zbyvé ke stojanku pripojit otvor pro tyc¢ lampicky. Ty¢ modelujeme
z objektu Cube pouzitim metod extrude region a zménami velikosti. Tim
dosdhneme pozadovany tvar. Stejnym zplsobem vymodelujeme i tyc.
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V dalsi ¢asti je nutno vymodelovat horni Cast lampicky. Postup je celkem
analogicky jako pro generovani stojanku. V tomto pripadé nam jako zakladni
objek poslouzi 2 vélce a kvadr s kterymi udéldme prinik s jinym kvadrem. Tim
dostaneme profil hofejSku lampicky. Protoze horejSek lamipicky je zluty, tak mu
zménime barvu.
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Zbyva nam jesté horejSek lampicky dotvarovat do skute¢ného tvaru a pfripojit jej
k tyci.

Nasledujici obrazek ukazuje detail zakonceni tyce pro napojeni.
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Pfedchozi obrazek ukazuje detail zakonceni tyce pro napojeni. Zbyva jesté

vygenerovat vypinac, ktery vzrobime pretvarovanim extrudovaného objektu
Cube a vysledny objekt sesadit k sobé.

Vysledkem je lampicka zobrazend na prvnim obrazku. Nebo také z jiného pohledu
na nasledujicim obrazku.
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POGR 2 Flétna v Blenderu Jan Doubek

Flétna v Blenderu

Tvorba modelu autentické flétny v Blenderu zacind namodelovanim dirky, coz je vlastné
takovy plnik invertovaného valce prstynkem. Pfi znazornéném postupu bylo pouzit Mesh
CIRCLE a z n¢j pak pomoci extrude udélan otvor viz. Obr. 1.

Obrazek 1

Tento element se musi ddle zakfivit podle profilu samotného vélce flétny, tudiz se na ngj
nasadi dalsi dva CIRCLE nakolmo viz Obr. 2,

Obrazek 2

1. strana



POGR 2 Flétna v Blenderu Jan Doubek

v mist¢ prunikd se body sjednoti pomoci funkce join a podle pfesahu se samotna dirka ru¢né
ohne viz Obr. 3.

o Seiit, eoh | P80 [ [ciova 3] |

Obrazek 3

Tento proces vytvoii prstynek Obr. 4,

et e | B0 [ [ciovs 3|

Obrazek 4
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POGR 2 Flétna v Blenderu Jan Doubek

ktery dale pomoci extrude roztahneme do trubicky Obr. 5 a zarovname plus jest¢ odstranime
prebytecné faces Obr. 6. a zékladni element mame hotovy Obr. 7.

Obrazek 5

cle

Obrazek 6
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POGR 2 Flétna v Blenderu Jan Doubek

Obrazek 7

Tyto elementy prokopirujeme Shift + d Obr.8 nato¢ime a pospojujeme Obr.9.

Obrazek 8 Obrazek 9

Dale pomoci znamého extrude a na konci pomoci join dokon¢ime dolni konec flétny Obr. 10
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POGR 2 Flétna v Blenderu Jan Doubek

Déle pokracujeme horni ¢asti az k okénku, kde nasleduje peclivda a velmi narocnéd prace
s metodou join a create face viz Obr. 11

cxc
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Obrazek 11

I mistr tesat se n€kdy utne proto muize stvofit flétnu s obracenou hlavou o 180° obr.12.

(173 Cube

view select otject [ovectvose 2| [§ 4 @ Js=| [BIA]0)]

Obrazek 12
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POGR 2 Flétna v Blenderu Jan Doubek

Celé télo musime tudiz natiznout funkci knife(exact) a otocit a zase spojit Obr.13

(G Add Timeline Game Render Help | <] SR2 Model | [ =[scEscene

Obrazek 13

Dale pokracujeme zobcem, ten se provede podobnym zakonenim jako dolni dil a navic se
zaktivi podle zplosténé kruznice Obr. 14.

[ = view Select Mesh | AEdit Mode
Obrazek 14
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POGR 2 Flétna v Blenderu Jan Doubek

Pak uz jen sta¢i pomoci scale, jednak proporénim nebo neproporénim ud¢lat findlni tvarové
upravy, a nanést material. A mame hotovo.

7. strana



1 Tutorial model propisovaci tuzky

Spustime Blender a miizeme zacit. Nejprve vymodelujeme vnitini napli pro-
pisky. Vlozime v pfednim pohledu kruznici sta¢i méné vrchold napt. 10. V
edit médu jeden smazeme klavesou x, timto dostaneme z kruznice vice spo-
jenych tsecek. Kazdy bod pomoci pravého tlacitka oznacime a stiskem g
milzeme presunout na pozadovanou pozici. Profil naplné by mél vypadat
asi jako na obrazku nize. Nasledné tento profil rotujeme kolem 3D kurzoru
musime byt v hornim pohledu. Nastavime parametry podle prostiedniho ob-
razku , zmacknutim tlacitka spin ziskdme vnitini napln, ktera je zobrazena
aplné vpravo.

| v o

Beauty | Short | Subdivide | Innervert

Halse
To Sphere
Fem Doubles|

[ Extrude

Serew Spin Spin Dup
—

s el Extrudes the selected wertices ir

Extrude Dup

Dale budeme pokracovat v modelovani spodni ¢asti propisky. Zvolime
jiny zptisob. V hornim pohledu vlozime kruznici. Pfizptisobime jeji velikost
pomoci stisku klavesy s a pomoci klavesy g presuneme na pozadovanou po-
zicl.




Déle v edit médu oznacime pomoci a vSechny body kruznice. Pfepneme
do pohledu zepfedu a stiskem klavesy e vytdhneme kruznici, pfidrzenim
prostifedniho tlacitka mysi a pohybem v pozadované ose muzeme kruznici
tahnout jen v daném sméru. Klévesou s mtizeme upravit velikost kruznice.
Vysledek by mél vypadat asi takto. Nastavime set smooth ¢imz vyhladime
profil.

New | Deete | Hew Delete
Assign | Remove Select Dreselect
Select Desel Aszign
[Set Gmooth | et Solid

Nyni pridélame dalsi ¢ast. V pfednim pohledu udélame profil jako predtim
a ten opét orotujeme.




Jesté zbyva zapinani propisovaci tuzky, které vymodelujeme pomoci kruz-
nice. Vytazené do potfebného profilu a se zapnutym set smooth pro hladkost.

v

Na fadu pfichazi slozit€jsi ¢ast. Pomoci kiivek vytvarovat tichyt na pro-
pisovaci tuzce. Vlozime nurbs kiivku v pohledu zepredu, kterou pomoci fi-
dicich bodti vymodelujeme na potifebny tvar. Dale v pohledu shora udélame
potfebny profil také z nurbs kiivky. Tento profil pojmenujeme naptiklad osa.
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Nyni oznac¢ime kiivku a v moznosti BevOb napiseme jméno profilu tedy
osa. Timto dostaneme dalsi Cast, v této fazi jesté mizeme upravit jednotlivé



kfivky. AZ budeme s vysledkem spokojeni pomoci klaves Alt+c ho preve-
deme na mesh.
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Ptrepneme do edit médu a z koncll nejnovéjsi plochy pridame dalsi ver-
texy(pomoci ctrl a levého tlacitka) k vytvoieni tsecek jako na obrazku. Zluté
oznacenou usecku orotujeme podle 3D kurzoru, neni nepotiebujeme celych
360, ale jen ptiblizné 280.




Nyni ozna¢ime orotovanou ¢ast. Tu pomoci klavesy e nejdrive vytahneme,
pouzijeme prostiedni tlac¢itko mysi pro pozadovany smér a nakonec upravime
velikost pomoci s. Jesté umazeme vrcholy, které se nehodi a vznikne ptiblizné
to co vidime na obrazku.

Déle je potfeba néjak spojit dané plochy. V edit mdédu si oznac¢ime vzdy
vrcholy, mezi kterymi vznikne plocha pomoci stisku f. Nakonec vznikne asi
toto.




Jesté prodlouzime tchyt. V prednim pohledu oznac¢ime skupinu vertext,
kterou budeme protahovat. Pak stiskneme e pro extrude a na pozadované
pozici stiskneme levé tlacitko mysi. Tento krok provedeme jesté jednou jen
nakonec zméni jesté velikost pomoci s. Vysledek vypada asi takto.

Nyni propisovaci tuzce prifadime materialy ¢i textury. Oznacime v ob-
jekt mdédu vnitini napli. Poté mysi klikneme na kulicku oznac¢enou nalevo
v obrazku a pokracujeme Add New. Objevi se nové nabidka v této fazi
nastavime jen barvu naplné pomoci RGB slozek. Timto jsme obdrzeli nej-
jednodussi material.

Pro dvé kovové ¢asti pouzijeme texturu z ulozené fotografie. Na obrazku
vidime jaké parametry mame nastavit. Aby vypadal material vice realisticky

6



zménime jeho odrazivost a barvu viz nize, jsou to parametry spec a hard.
Stejny material poté prifadime zapinani propisovaci tuzky.

Pro dolni kovovou ¢ast pouzijeme stejné jako predtim fotografii. Pro vétsi
matnost materialu vSak vlozime jesté druhou texturu clouds.




Prihledny material udélame snadno pomoci nastaveni nékolika malo pa-
rametri. Nejdfive nastavime pozadovanou barvu. Dale polozku Tralu pro
prusvitnost a Fresnel pro prihlednost.

Nyni zbyva jen vlozit desku, na kterou umistime propisku. Vlozil jsem
jednoduchy objekt plane a jako material nahral obrazek dfeva.




Jako posledni ptijde na fadu pozice svétla a kamery. Nyni uz jen obrazek
vyrendrujeme a je hotovo.




Vodni dymka v Blenderu

Martin Grill

Po spusténi blenderu vytvofime novy objekt Cylinder (mezernik — add — mesh - cylinder).
Pomoci (B) si oznac¢ime jednu hranu a tu funkcemi Extrude (E) a Scale (S) rozsifujeme.
Vytvofime spodni nddobu vodni dymky.

Uplné stejnym zplisobem vytvoFime i t&snici gumu:




Nasleduje hlavni Zelezna ¢ast vodni dymky, kterou opét vytvofime z Cylindru a extrudujeme:

Nyni je tfeba vytvofit pist a pist odkud povede hadice. Vytvorime si proto nové dva objekty a
pomoci funkce extrude a scale se dostaneme k poZzadovanym tvarim.




Nyni je tfeba aby bylo vie hladké a proto v Objekt modu pomoci B oznacime viechny objekty
a v menu Editing(F9) v submenu Link and materials nastavime Set smooth. Toto je vysledek:

Nyni je tfeba pfiradit jednotlivym ¢astem nejaké materidly. Materialy
Ize nalézt na http://www.freewebs.com/blendermats/index.htm, po
staZeni je tfeba knihovnu nacit, takZze ddme Shift+F1 a v dialogovém
okné, které se objevi nalezneme pfislusny material a zadame load, po
té si kazdy objekt oznacime a v menu Shading (F5) klikneme na add new
a vybereme potiebny materidl. Zde je obrdzek gumy a spodni nadoby,
kde na nadobu byl pozit materidl sklo a guma pouze zménou barvy.




No a nyni nejtézsi ¢ast — hadice. Zacneme tak, Ze si vytvofime jeden ,dilek” hadice. Pfidame
objekt Cylinder a pomoci Extrude a Scale upravime:

Nyni se pfepneme do objek-modu, nastavim Set smooth a po oznadeni pomoci ALT-D
duplikujeme a stavime za sebe:

Vytvorime takovouto fadu pozadované délky a poté oznacime vsechny a stiskneme CTRL+)
k jejich spojeni. Nyni je tfeba vytvofit kfivku podle které se bude nami vytvorena hadice
chovat. Vlozime tedy novy objekt Bezier Curve a pomoci Rotate(R) a Scale(S) ji vyrovname
vedle hadice.




Nyni je tfeba kfivku narovnat a srovnat s hadici:

Oznadime pomoci B kFivku i hadici a pomoci CTRL+P a vybérem Curve Deform udélame
krivku otcem hadice. Nyni v edit modu vloZime kfivku presné do hadice aby se nam hadice
deformovala spravné. Zbyva dodélat jen par malickosti, jako jsou koncovky, hotak a koncovy
nahubek. Zde je obrazek se viemi dily.

Nyni postupné vSechny dily zasadime do sebe a s hadici si musime chvilinku ,pohrat”. Je
tfeba editovat jen kfivku a hadice se bude deformovat podle ni. Podle potfeby si pomoci
Extrude mlzZeme pfidat body na kfivce.



A nyni uz jen zavérecné Upravy. Pfidat objekt Svétlo a nastavit poZadovanou polohu. Vybrat
polohu kamery a nakonec by vSse mélo vypadat néjak takto:




Modelovani v Blenderu
aneb jak vymodelovat housle
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1 Uvod

Prakticky na vSech internetovych strankich tykajicich se modelovani v Blenderu se doctete, jak
je tento program tzasny, mé malou instalaci, ale velké moZnosti a daji se v ném vytvofit i ty
nejslozitéjsi tvary. Podrobil jsem ho tedy zkouSce a zkusil vymodelovat housle nastroj s dokon-
alym tvarem pochdazejicim uZz ze sedmndactého stoleti od Antonia Stradivariho. Jako pfedlohu
jsem pouzil housle vlastni (viz obr. 1). Nakolik se mi podafilo p¥ibliZit se originalnim tvariim
necht posoudi ¢tenaf sam (obr. 2).

Obréazek 1: Pfedloha

Obrazek 2: Model



Obrazek 3:

2 Modelovani

Nebudu popisovat zékladni prostfedi Blenderu ani zakladni modelovaci techniky, nebot to uz za
mé udélali kolegové z minulych let ve svych tutoridlech. Soustiedim se tedy na tvorbu konkrétniho
modelu. Zkratky budu pouzivat standardni, tj. LM pro levé tlac¢itko na mysi, PM pro pravé
tla¢itko na mysi a KM pro kolecko.

2.1 Korpus

Nejprve vytvoiime korpus, tj. horni a spodni desku. Abychom trefili spravny tvar, umistime
nejprve na pozadi fotku originidlu pomoci nabidky View/Background Image. Vlozime kfivku
(Space Add/Curve/Bezier curve), pfepneme se do edit modu klavesou Tab a zméafkneme
tla¢itko Poly v nabidce Curve tools. Ted je zapotiebi fadou bodi kiivky obtahnout desku, stadi
horni polovina. Body se pridavaji tak, Ze oznacime posledni a stiskneme Ctrl+R, pfesunuji
se stiskem klavesy G (obr. 3). Ted pfejdeme do object modu (Tab) a cely obrys zkopirujeme
(Shift-+D), posuneme podél osy y (G,Y) a mirné zmengime (S). Upravime prostfedni body, aby
vysledek vypadal jako na obr. 4. Mensi obrys bude slouzit jako pés spojujici desky. Opét obrys
zkopirujeme (Shift+D), ale tentokrat v edit modu, aby vSe byl jeden celek. Zkopirovanou &ast
rotujeme okolo = o 180 stupiiii (R,X a posun mysi, je dobré drzet Ctrl, otaime pak po nasobcich
5). body napravo propojime, tj. oba oznadime a zmatkneme F. Oznaime vSechny body (A) a
stiskem C kifivku uzavieme. Nyni v object modu vytvofime novou Beziérovu kruZnici (Space
Add/Curve/Bezier circle) a upravime velikost na ovél (S). Pojmenujeme v okénku Link and
materials napiiklad "profill". Na§i kfivce pak nastavime vlastnost BevOB na profill. Vysledek
by mél vypadat jako na obr. 5. Podobnym zptisobem udélame i obé desky. Ty je ale nutno délat
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Obréazek 6:

zvlast, protoze v horni musime je§té vytvofit f~otvory. Oznaclime zatim nepouzity vétsi obrys
a prejdeme do edit médu. Pfiddme novou Beziérovu kfivku a opét podle fotky vytvarujeme
otvor. Oznac¢ime body na otvoru (B,B a klikime PM), stiskem C kfivku spojime. Zkopirujeme
obrys (v edit modu), oto¢ime ho a napojime. Ted ozna¢ime jen body na obvodu desky (!) a
stiskem C vytvofime plochu s vyfiznutymi f-otvory. Je dulezité, aby otvor i obrys tvofili jeden
objekt, takze pokud jste je vytvorili zvlast, spojte je nejprve v object moédu oznacenim a stiskem
Ctrl+J. Vysledek by mél vypadat jako na obr. 6. Spodni desku uz jisté zvladnete sami. JeSté
malé poznamka: je dobré obé desky umistit tak, aby z nich spojovnik trochu presahoval. To pak
vytvori ¢aru, kterd skutecné na deskach housli byva.

2.2 Hmatnik

Nejprve vytvofime spodni stranu hmatniku. K tomu stac¢i pfidat kruznici (Space Add/Mesh/Circle),
smazat horni polovinu bodt a spojit krajni body, takze vznikne pilkruznice. Nyni oznacime
vSechny body a stiskem Shift+F z ni udélame pilkruh. Ten dvakrat extrudujeme, aby vzniknul
tvar na obrazku 7. Oznacte vSechny body a pouZijte E Region a klavesy G a S pro pfesouvini
a zmeénu velikosti. Vrchni ¢ast hmatniku udélame naprosto stejné, jen za zaklad pro extrudovani
nepouzijeme pilkruh, ale kruhovou tse¢ odpovidajici velikosti. Nakonec jesté, opét stejnym zpii-
sobemn udélame patku, tady to bude chtit ale trochu trpélivosti, abychom dosahli spravného tvaru.
Doporucuji pouzivat fotografie na pozadi. Jak je vidét z obrazku 8, jednu fadu bodi musime
presunout tak, aby patka doléhala na korpus. Oznacte pfislu§né body a presouvejte klavesou G.
Ted horn{ a spodni ¢ast hmatniku spojte (Ctrl+J) a konec horni &asti nad korpusem trochu
roztahnéte (S). Vysledek je na obr. 9

2.3 Hlavice

Tvar hlavice je opét vhodné obkreslit podle obriazku. Hlavici rozdélime na dvé ¢asti, spodek
a Sneka. Nejprve vytvorime spodek. Pomoci Bezierovy kfivky obtidhneme obrys, klavesou C
v edit modu ji uzavieme a zkonvertujeme do meshe (Alt+C Mesh). Poté ji extrudujeme na
potfebny tvar (viz obr. 10 a 11). Sneka udélame nasledovné: Vlozime kruznici a nekolikrat ji
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extrudujeme, ptri¢emz ménime velikost jednotlivych vrstev. Mélo by vzniknout néco jako na obr.
12. Nejmensi kruznice uzavieme (Shift+F) a v hornim pohledu podle obr. 13 jednotlivé strany
ponékud sklopime. Nyni vyrobime koliky. Opét pridame kruznice a jednoduSe extrudujeme do
potFebného tvaru. Nahoru pak kolmo pfidame jesté jednu extrudovanou kruznici, oba objekty
spojime (Ctrl+J). Kolik je na obr. 14 a cely vysledek na obr. 15. Nakonec je je§té poti¥eba
vyfiznout v hlavici diru, aby byl prostor na natazeni strun. To udélame tak, Ze oznac¢ime horni
povrch hlavice a stiskem Ctrl+R pfidame po stranich dvé fady vrcholi. Vznikne nadm tedy
vevnit¥ jakysi obdélnik (z horniho pohledu tak vypada), ktery extrudujeme doli. Ve je vidét na
obr. 16.

2.4 Strunik

Pii konstrukei struniku budeme pouzivat opét davérné znamé postupy. Vytvorime dvé soustiedné
kruznice a nechame si jen jejich vrchni ¢asti, které k sobé spojime (oznacte sousedni body a
stiskem F se vytvofi hrana). To je profil, ktery podle fotky dle pot¥eby extrudujeme. Body tvo¥ici
konec struniku oznacéime a stiskemn Alt4+M At center spojime do jednoho bodu. Vysledek je
na obr. 17, profil tvofi oznaené body. Ted je jesté potieba udélat ve struniku diry pro konce
strun. To udélame tak, Zze oznalime v8echny body nejlevéjsiho ¢lanku struniku a stiskem W
Subdivide multi s nastavenim tieba 10 vytvofime mnoho novych bodd. Nyni ve vzniklé siti
pomoci B,B oznac¢ime koletkovym vybérem body (velikost koletka se d4 nastavit KM) ve ¢tyfech
kolech. Stiskneme Del Faces a diry jsou na svété (obr. 18).



Obréazek 12:
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2.5 Kobylka

Ani pii tvorbé kobylky nepouZijeme nic nového. obrys je vytvofen pomoci ¢asti kruznice a pfi-
danych bodi (oznacte krajni bod, drzte Ctrl a stisknutim LM vytvofite novy bod), dovnit¥
jsou pak pfidany dvé kruznice a polygon. VSechny objekty spojime (Ctrl4+J) a vytvoiime z nich
plochu (ozna¢ime vSechny body v8ech objekti a stiskneme Shift+F ). Tuto plochu extrudujeme
(obr. 19).

2.6 Struny

Struny jsou jednoduché, protoZe to jsou jen extrudované kruznice. Jediny problém je s jejich
usazenim, je tfeba kombinovat pohledy a trogku si s tim pohrat (obr. 20 a 21).

2.7 Podbradek

Hlavni ¢ast podbradku udéldme starym znamym extrudovanim. Podle fotky obkreslime obrys v
nejiirgi ¢asti podbradku (na obr. 22 Zluté zvyraznéna ¢ast) pomoci Beziérovy kiivky a extrudu-
jeme na obé strany. JeSté je tfeba udélat dvé kovové trubicky, které podbradek piipeviiuji ke
korpusu. Ty vytvorime pomoci extrudovanych kruznic. Na konce trubic¢ek pak pfipevnime kvadr
vytvofeny extrudovinim z objektu plane. Ve spojime do jednoho objektu a pfipadné dodélame
chybéjici plochy (Shift+F). Detaily znazoriiuje obr. 23.

11
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2.8 Zalud

Zbyva dodélat tzv. zalud, tj. "knoflik", ktery drzi strunik u korpusu. Kolem zaludu pak jesté
omotame dratek, ktery jej spojuje se strunikem. Dratek je tvofen (jak jinak) extrudovanou
kruznici, stejné jako zalud. Opét je nejvétsim problém spravné umisténi. Tuto ¢ast uz nechim
na vas jako doméci cvifeni :). Na obrazku 24 je pro inspiraci zobrazen vysledek.

2.9 Obarveni

Na zéavér uz staci jenom zvolit vhodné barvy pro jednotlivé ¢asti housli a vyhladit kulaté ¢asti
modelu zvolenim Set smooth v nabidce Link and materials a vysledek pak vypada jako na
obréazcich 25 — 29.

13



= | SRiz-Model X

_A Edit Mode 3

Obréazek 22:

14



| #|SRz-nodel

| [otonal <]

Obréazek 23:

15



(S = view select vesn [acaivose <) (@ @ f] (G816 = [sona =] (@] |

Obrézek 24:

Obrazek 25:

16



Obrazek 26:

Obrazek 27:

17



Obrazek 28:

Obrazek 29:

18



W

Cajova konvice v Blenderu

Autor: Vlastimil Jedek

Blender je multiplatformni program pro vytvareni 3D grafickych modelt a animaci, ktery je
vyvijeny pod licenci GPL. Jeho nejnovejsi verzi (aktualng€ 2.45) Ize stahnout na webovych
strankach http://www.blender.org. Pro modelovani za uCelem napsani tohoto tutoridlu byla
pouzita starsi verze 2.44.

Jako modelovany objekt jsem si vybral ¢ajovou konvici. Ta se sklada z n€kolika ¢asti, které
budeme modelovat samostatné: télo konvice, hubice, uchyty pro drzadlo a drzadlo konvice. Z
téchto jednotlivych objektl pak v zavéru sestavime vysledny model konvice.

Pti studiu technik modelovani v blenderu jsem z velké ¢asti vychazel z tutoridli, které jsou k
dispozici na webu (at’ jiz v anglictin€ nebo v ¢esting, jejich seznam je uveden v zavéru tohoto
navodu). Tyto tutoridly byly napsany pro nejriiznéjsi verze programu, které¢ se mohou castecné
lisit ovladadnim (strukturou menu a ovladacimi prvky). V takovém ptipad¢ pak sice nelze
postupovat presné podle téchto tutorialli, ¢asto se vSak da spolehnout na klavesové zkratky.
Jejich pouzivani pfi praci s timto programem mohu nejen z tohoto divodu viele doporucit.
Nyni tedy k samotnému modelovani.

Télo konvice

Modelovéni za¢neme télem konvice. PouZijeme pifi tom funkci EXTRUDE (modelovani
tazenim). Pfi spusténi programu se otevie novy soubor, v zévislosti na verzi programu se ve
stfedu obrazovky nachazi objekt Cube nebo Plane. Tento odstranime (kldvesou DELETE) a
vytvorime misto néj kruh. To provedeme stisknutim klavesy SPACE, vybérem polozky ADD
-> MESH -> CIRCLE. Parametry miizeme ponechat na vychozich hodnotach. Tento kruh
bude tvofit vnéjsi sténu nadobu. Potfebujeme vsak jesté vnitini. Ponechdme kruh oznaceny,
stiskneme klavesu E (EXTRUDE), zvolime moznost ONLY EDGES a stiskneme klavesu S
(SIZE). Tazenim myS$i zmenS§ime polomér nového kruhu. ktery bude tvofit vnitini sténu
nadoby.




Piepneme se do bo¢niho pohledu (kldvesa NUM 1, pozor na vypnuty NumLock), stiskneme
jednou klavesu B (funkce pro oznacovani bodl Border Select) a oznaCime vSechny body.
Opét pouzijeme funkci EXTRUDE a tazenim myS$i posuneme body smérem nahoru.
Vytvotime tak prvni kruhovy segment nadoby.

Opakovanym extrudovanim smérem nahoru a néslednou zménou velikosti postupné
vytvotrime celé télo nadoby. Vysledek by mél vypadat néjak takto:




Horni ¢ast téla nadoby vytvarujeme obdobnym zptisobem zplsobem podle obrazku. Horni
hranu vytvofime zkosenou.

Télo nadoby je témet hotové, zbyva vytvofit dno. V bocnim pohledu (NUM 1) oznac¢ime
nejspodnéjsi vrcholy tvorici spodek nadoby (pomoci Border Select). Je tieba odznacdit vrcholy
tvorici vngjsi sténu. Pfepneme se do horniho pohledu (NUM 7) a stiskneme dvakrat klavesu
B. Nastroj Border Select se ptepne do rezimu ozna¢ovani pomoci masky (jeji velikost 1ze
ménit koleCkem). S podrzenou klavesou ALT klepnutimi postupné¢ odznalime vSechny
vrcholy tvorici vnéj§i sténu. Naslednym stisknutim kldves SHIFT+F vytvofime plosky
(Faces), které vyplni oznaceny prostor a vytvoii tak dno nadoby.




Modelovani hubice

Zakladem hubice bude vélec s vnéjsi a vnitini sténou. Klavesou TAB piepneme do rezimu
Object mode. Nyni se ptepneme do horniho pohledu (NUM 7) a kurzor levym tlacitkem
umistime na cervenou piimku vlevo od konvice. Kombinaci klaves SHIFT+S a vybérem
moznosti Cursor -> Grid zarovname kurzor k mftizce (kvili zarovnani hubice na stfed
vzhledem k télu konvice). Klavesou SPACE a vybérem moznosti ADD -> MESH ->
CIRCLE vlozime objekt kruznici.

Nyni z kruznice vyrobime valec. Nejprve klavesou E a nasledné S vytvoiime profil valce.
Poté¢ se prepneme do boc¢niho pohledu (NUM 1) a oznafime vSechny vrcholy profilu.
Extrudovanim vytvofime valec. Nasledné ozna¢ime vSechny vrcholy valce a stisknutim
klavesy R nebo gestem mysi (stisknutim a drzenim levého tlaCitka mysSi a naznaCenim
oblouku kolem valce) pooto¢ime valec tak, aby byl pfiblizn€ orientovan smérem, kterym bude
ustit hubice. Poté jest¢ cely valec zmensime (klavesa S), aby jeho velikost odpovidala
konvici. Vysledna situace je vidét na nasledujicim obrazku.




Budeme dale pokracovat v modelovani hubice.V bo¢nim pohledu oznacime body vélce, které
jsou blize smérem ke konvici a extrudujeme. Nasledn¢ klavesou S zvétSime profil
extrudovaného segmentu blize konvici. Proces se obdobny jako pfi modelovani t¢la konvice.

Segment je vSak tieba jeSté dale tvarovat. Pouzijeme k tomu magneticky ndstroj, ktery
aktivujeme klavesou O (Ze je zapnuty, pozname podle vybarveni ikony néstroje).

Se zapnutym nastrojem oznaCime nejvyssi vrchol nové vytvofeného segmentu a stiskem
klavesy G (GO) jej posuneme smérem ke konvici. Pfi posouvani vrcholu mizeme koleCkem
mysi regulovat dosah magnetického néstroje. Ten je reprezentovan kruznici se stfedem v
puvodnim umisténi vrcholu (nebo ve stiedu vybrané oblasti v piipadé oznaceni vice vrcholi).

Vysledek miize vypadat napf. takto:




Opakovanim tohoto postupu (extrudovanim, zménou velikosti a modelovanim pomoci
presunovani bodl s pouzitim magnetického nastroje) postupné vymodelujeme c¢ast hubice
blize k télu konvice. Cely postup vyzaduje jistou davku zkuSenosti a zruc¢nosti, nebojte se
proto pii modelovani experimentovat. Velmi uzitecna je rovnéz funkce navratu o krok(y) zpét
(Undo). Provede se stisknutim tlacitka U. Néavrat o krok zpét lze zrusSit stisknutim kombinace
klaves SHIFT+U. Vysledek procesu by mohl vypadat néjak takto:

Objekt zatim hubici piili§ nepfipomina. Vytvarujeme tedy druhou stranu hubice. Usti hubice
by pfitom mélo byt piiblizné ve stejné vysSce, jako je vyska téla hubice (aby z konvice
nevytékal obsah pfi jejim Gplném naplnéni). Usti hubice je kromé toho tieba vénovat vice
péce a pomoci magnetického nastroje jej vytvarovat do odpovidajiciho tvaru. Vysledek je
vidé€t na nasledujicim obrazku:




Tvar hubice je vSak pfili§ hruby, je tieba jej vyhladit. Ozna¢ime vSechny body hubice
(tlacitko A), stiskneme klavesu W (specidlni operace) a vybereme moznost Smooth (vyhladit).
Algoritmus posune vrcholy a vyhladi tak tvar objektu. Operaci podle potieby nékolikrat

zopakujeme. Pfipadné mlzeme jeSté poupravit tvar usti hubice. Vysledny objekt vypada o
poznani Iépe.

Nyni ptipojime hubici k télu konvice. Tlacitkem TAB se pfepneme do rezimu object mode.
Meéli bychom mit oznac¢enou hubici. Klepneme a drzime levé tlac¢itko mysi na Cervené Sipce,
naslednym pohybem mys$i mizeme objekt posunovat po ose X. Zasuneme hubici do konvice.
Podle potieby jesté hubici v rezimu edit mode poupravime. Nakonec v rezimu object mode
oba objekty vybereme (klepnutim pravym tlacitkem mysi vzdy do blizkosti objektu soucasné

s podrzenim klavesy SHIFT), stiskneme klavesy CTRL+J (Join meshes) a ptikaz potvrdime.
Tim spojime oba objekty do jednoho.




Model jiz pfipominéd konvici, je vSak stale pfili§ hruby. Pouzijeme tedy funkci rozdélovani
ploch - subsurf. Objekt oznacime, v dolnim menu v ¢asti Modifiers klepneme na volbu Add
Modifier a vybereme moznost Subsurf. Parametry Levels a Render Levels nastavime na
optimalni hodnoty (kdy jesté¢ pozorujeme zlepSeni oproti predchazejici hodnoté) a potvrdime
klepnutim na tlac¢itko Apply (doporucuji neptfehanét to s hodnotami parametrii, vyssi hodnoty

Uchyty drzadla

T¢lo 1 hubici konvice mame vymodelovanou, zbyva doplnit drzadlo. Za¢neme jeho uchyty.
Zakladem uchytu bude Bézierova krivka tvarem ptipominajici obracené pismeno U. Piepneme
se do horniho pohledu (NUM 7) a kurzor umistime opé€t na ¢ervenou piimku, tentokrat pro
piehlednost vpravo od konvice (k pfesnému umisténi si opét mizeme dopomoci zarovnanim
kurzoru k mtizce stisknutim kombinace klaves SHIFT+S a vybérem moznosti Cursor ->
Grid). Stiskneme mezernik a vybérem moznosti Add -> Curve -> Bezier Curve vlozime
Bézierovu krivku.




Abychom mohli kiivku vytvarovat do potfebného tvaru, musime do ni pfidat alespoil jeden
vrchol. Provedeme to oznaCenim obou krajnich vrchold kiivky, stisknutim klavesy W
(Specials) a vybérem moznosti Subdivide. Piesouvanim vrchold a bodd urcujicich smémice
teCen ve vrcholech nyni upravime kfivku do pozadovaného tvaru (viz obrazek). Body
oznacujeme standardné pravym tlacitkem mysi a pfesouvame klavesou G (pozor na zapnuty
magneticky néstroj), pfi umistovani bodii si pomadhame miizkou.

Tim jsme vymodelovali zékladni tvar uchytu. Nyni je tfeba vytvofit z kiivky prostorovy
objekt. Pfepneme se do rezimu object mode, umistime kurzor na misto mimo pohled kamery a
pomoci volby Add -> Curve -> Bezier Circle zde vytvotime Bézierovu kruznici. Pomoci
klavesy S ji zmensime na prumér priblizn¢ odpovidajici tloustce uchytu. V sekci Links a
Materials (viz obrazek) déle textovym vyb&rem oznacime ndzev objektu (v nasem piipade
CurveCircle) a kombinaci klaves CTRLAC jej umistime do schranky:.

CF Y Corsye Circle




Nyni se klavesou TAB piepneme zpét do rezimu object mode, ozna¢ime Bézierovu krivku
reprezentujici uchyt, otevieme panel Uprav (klavesa F9 nebo tlafitko oznacené na obrazku
cerveng) a do pole BevOp v sekci Curve and Surface vlozime ze schranky (nebo zadame
pomoci klavesnice) nazev Bézierovy kruznice. Z. Bézierovy kiivky se tak stane prostorovy
objekt, jehoz pritez je tvoten Bézierovou kruznici. Vymodelovali jsme tak uchyt drzadla.

Nyni se pfepneme do boc¢niho pohledu (NUM 1), klavesou R nebo diive popsanym gestem
mysi pooto¢ime uchyt do pozadované polohy a klavesou G jej umistime na télo konvice za
jeji horni otvor. Nyni klavesami SHIFT+D uchyt zduplikujeme, poté jej pootoc¢ime a nakonec
umistime na protéjSi stranu horniho otvoru konvice. Vyslednd situace je zndzornéna na
obrazku:




Drzadlo konvice

modelovani uchytu, princip je vSak zcela totozny - vytvotime Bézierovu kiivku (tentokrat v
bo¢nim pohledu), klavesou W a vybérem moznosti Subdivide vytvorime dodate¢né body
kiivky (v mém piipad¢ celkem 11), kiivku vytvarujeme do podoby drzadla a usadime ji do
uchytu.

Nyni opét nékde mimo kameru vytvoiime Bézierovu kruznici o pozadovaném poloméru a
pfitadime ji jako parametr BevOp Bézierové krivce predstavujici drzadlo. Velikosti
Bézierovych kruznic muzeme i po jejich pfifazeni kiivkdm upravovat a pfizpisobovat tak
tloustku uchytii a drzadla, dokud nebudeme spokojeni. Model konvice je hotov.




Kone¢né tpravy

Jediné, co zbyva ucinit, je vybrat materidly a pfipravit scénu. Materialy pro Blender jsou k
dispozici volné ke stazeni na internetu, staci pouzit vyhledava¢ Google. Osobn¢ jsem Cerpal z
materidlovych knihoven odkazovanych na domovské strdnce projektu Blender na adrese
http://www.blender.org/download/resources/ v sekci Material Libraries. Po stazeni souboru
obsahujiciho materidly klepneme v Blenderu v menu na polozku File -> Append or Link,
nalistujeme stazeny soubor a nasledné pozadovany materidl, ¢imZ jej importujeme do
Blenderu. Nyni vybereme objekt, kterému chceme pfifadit materidl, kliknutim na obrazek
koule otevieme materalovy panel a klepneme na tlacitko Add New.

Select Mesh |
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Nyni po kliknuti na Sipky v sekci Links and Pipeline v poli Link to Object vybereme
pozadovany material.

Po pfifazeni materiali objektim zbyva nastavit pozadi, kameru a osvétlit scénu. Pozadi 1ze
podle potteby pomémné jednoduse nastavit v panelu World buttons (tlacitko s obrazkem
vénuji celé samostatné tutoridly. My si vysta¢ime se zdrojem Sun, umisténym za kamerou, a
zdrojem Lamp, osvétlujici konvici z druhé strany (proti kamete). Zdroje svétla se umistuji
obdobn¢ jako jakékoliv jiné objekty klavesou SPACE -> Add -> Lamp. Nakonec umistime
kameru. Vyslednd scéna je zachycena na obrazku:




Klavesou F12 nyni mizeme vyrenderovat findlni obrazek:




Pouzité zdroje:
(Tutoridly na serveru grafika.cz)

Pavel Cernohous: Blender pro tplné za¢ate¢niky,
http://www.grafika.cz/art/3d/clanek1329651850.html

Pavel Cernohous: Blender pro tplné za¢ate¢niky, dil 2.
http://www.grafika.cz/art/3d/clanek836668730.html

Pavel Cernohous: Modelovani v Blenderu metodou extrude,
http://www.grafika.cz/art/3d/clanek2144915219.html

David Streldak: Modelujeme 3D v Blenderu 1. dil - Pracovni prostiedi,
http://www.grafika.cz/art/3d/blender-tutorial-1-prostredi.html

David Stielak: Modelujeme 3D v Blenderu - 2.dil: Tvorba luku pomoci kiivek,
http://www.grafika.cz/art/3d/Model-in-3D-Blender-2-luk-tut.html

David Stielak: Kostel v Blenderu snadno a rychle,
http://www.grafika.cz/art/3d/3D-Blender-model-spacecraft.html

David Stielak: 3D Blender: modelovani vesmirné lodi,
http://www.grafika.cz/art/3d/blenderkostel.html

DalSi odkazy:

Stranky projektu Blender,
http://www.blender.org/

Stranky ¢eské komunity kolem programu Blender,
http://www.blender3d.cz/



Patrik Jira

3D model gymnazia

Strucny popis 3D modelu

Mym ukolem bylo pripravit univerzalni 3D model moji byvalé Skoly tak, aby
bylo morné naanimovat prulety budovou, prochézet budovu jako ve 3D hrach z

FirstPerson pohledu, pripravit jednoduchou interaktivni hru a v neposledni
radé vyrenderovat statické snimky gymnazia.
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Modelovani

Zacal jsem ziskanim detailniho planu budovy, ktera je mimochodem
architektonicky velmi zvlastni, ma dvé patra normalni a dvé mezipatra,



pomérné nepresné Sestithelnikovou strechu a dalsi atypické rysy. Pomoci
planu jsem tedy v programu Blender 3D vymodeloval postupné obé patra,
vnitrni mistnosti, a po nékolika navstévach okolnich vyssich budov jsem
dokoncil i strechu.




Game engine

Po nasazeni walkthrough dema jsem musel kviili Spatnému zobrazovani textur
v game enginu predélat veskeré zdivo. Game engine Blenderu ale stejné délal
spoustu véci, které nebyly zddouci - v nékterych ¢astech budovy jsem mohl
prochazet sténami, textury a nasvétleni se mi stale nedarilo idealné vyladit, a
proto jsem se pokusil prejit s jiz hotovym modelem k enginu, ktery by mi
nabidl snazsi cestu k péknému detailnimu zobrazovani. Jako prvni jsem zkusil
Q3 Radiant, do kterého se mi ale nepodarilo uspokojivé importovat 3D
model(primo z blenderu ani pres 3D Studio Max a dalsi), proto jsem zacal
hledat jinde. Free game engine Irrlicht se jevil velmi idealné, ale vzhledem k
blizké uzavérce jsem ho uz kompletné nenasadil. Na hru ani na prochazeni
gymnazia tedy nedoslo, mald ukdzka game enginu a modelu gymnazia je
zde(nutno spustit v programu Blender, prepnout se do pohledu kamery a
spustit v roletce GAME): Game engine a gymndazium Pacov v akci

Vysledek

Pro blizici se termin prezentace gymnazia na jeho vyroci jsem nasnimal
snimky, vyrenderoval animace a doplnil je hudbou.



Vyslednd animace gymnadzia s hudbou ¢.1 Vysledna animace gymnazia s
hudbou ¢.2




Véclav Jirkovsky
Katedra Matematiky
FJF1- CVUT

Vétrny mlyn

(Zéapoctova uloha — PocitaCové grafika 2)

Uloha byla modelovéana v programu Blender 2.44. Témé&f skoro cely objekt byl
vymodelovan metodou extrudovani.

Jako prvni byl na plochu umistén objekt Plane, z kterého byla vytvotfena etrudovanim
zékladna mlyna

VloZzeny objekt Plane — horni pohled

Extrudovany Plane — profil



Objekt Plane — jiny pohled
Jako dalsi byl vytvoren ,,balkdn®, ktery se poté usadi na zdkladnu mlyna. Vytvoien byl

(stejnou metodou jako zakladna) z objektu circle, ktery mél jen 8 vertexi. Tedy 8 — tthelnik misto
kruhu. Nakonec byl vytvotfen na spodni i vrchni strané triangularni face (face - ,,povrch, plocha®)

Objekt circle — horni pohled

Extrudovani objektu circle — profil



Vytvoteni triangularniho facu a usazeni na zakladné

~r v

Vlastni budova mlyna se bude skladat ze tii ¢asti. Oznacené jako: ,,budova 1, budova 2 a
vrsek. VSechny tii ¢asti byly vytvoteny také extrudovanim.

Vytvoteni budovy 1

Usazeni budovy 1



Vytvoftini budovy 2

nebo zvetSovany pro obdrzeni pozadovaného tvaru

Modelovani ,,vrsku“ - ¢ast 1

Modelovani ,,vrsku‘ - ¢ast 2



Sestaveni celé budovy

Nasledovalo vytvoteni ,hiidele” pro umisténi lopatek mlynu. K tomu bylo vyuzito objektu
Cylinder

Vlozeni , hiidele*

Vytvoteni lopatek bylo z objektu grid (mftizka), ktery byl nasledné vymodelovan na
pozadovany tvar (extrudovanim)

Lopatky mlynu



Lopatky — sestaveni

Nasledovalo vytvoreni zdbradli. Modelovéano bylo opét z objektu circle (8 vertexi)
extrudovanim. Pak bylo nasezeno na mlyn s vytvofenim tramu, které toto zabradli drzi. Zaroven
byly nastaveny barvy a textury pro jednotlivé ¢asti mlyna.

Vytvoreni zabradli



Nasazené zabradli i s nosnymi tramy, hnédd barva pro mlyn

Pro budovu 2 a pro vrsek byla zvolena textura clouds (mraky). Pro budovu 1 byla vybrana
textura stucci (stucco — Stuk), stejne jako pro zdkladnu, ale s jinou barvou.

Nakonec zbylo vytvoteni travniku. Vytvoten byl za pomoci ¢asticového systému na tvorbu
statickych ¢astic. Byl vytvoren objekt Plane pod mlynem a rozd¢len na vice fact.

Plane (rovina) pod mlynem

Bylo nastaveno, aby se ¢astice zobrazovaly jako vektory a aby vyrustaly z jednotlivych bodt
(vertext) i stran. Nastaveno bylo také ndhodné emitovani jednotlivych vektor. Vzhledem k
velikosti plochy byl pocet vektorti zvolen na 100 000. Nasimulovana byla i gravitace (Force Z:
-0,01) a nastavena barva stébel travy na zelenou. Nakonec bylo piidano svétlo (spot).



Travnik — horni pohled

Vysledny vymodelovany obraz mlynu vypadé nasledovné




Delfin v Blenderu

Tento tutorial stru¢né popisuje postup pfi vytvdireni modelu delfina v Blenderu. Open-source
program Blender slouzi k modelovani objekt(i ve 3D. Pouzita byla aktudIni verze 2.46. Pfi vymysleni
objektu k modelovani padl muj zrak na nasledujici kycovitou sosku, ktera sbira prach na jednom

z mych reproduktord. Tato okrasa tedy byla pouzita jako podklad k modelu.

Delfin je mofsky savec oplyvajici velmi elegantnim a hydrodynamickym tvarem. Jeho télo je tedy
sama oblina a ostrou hranu na ném snad krom jeho zubl nenajdete. Proto je vyhodnéjsi pouZit pfi
modelovani hladké objekty misto polygonalnich.

V prvni fazi tedy pfidame kouli z nabidky Add -> Surface -> NURBS Sphere, kterou je mozné vyvolat
stiskem mezerniku. Jeji velkost upravime pomoci skdlovani stiskem kldvesy S a tazenim mysi. Jelikoz
je delfinovo télo podlouhlé, roztdhneme pfipravenou kouli pouze ve sméru osy x, ¢ehoz docilime
stiskem prostifedniho tla¢itka mysi. Méli bychom dostat tvar podobny tomu na obrazku.



Zakladni tvar téla vymodelujeme pomoci deformacni mrizky. 3D kurzor nechdme nastaven na stfedu
naseho objektu a pfiddme deformacni mfizku pomoci nabidky Add -> Lattice. Mtizka md v defaultnim
stavu podobu krychle, musime ji tedy roztdhnout, aby tésné obepinala nasi zdeformovanou kouli.
Ddle je tfeba pfidat vice vrchold, pomoci kterych budeme nasi kouli ddle upravovat. Pocet vrcholll

v jednotlivych osach mtizky miZeme upravovat v panelu s ndzvem Lattice, jak je vidét na dalSim
screenshotu. Pro nase potreby postaci pouzit 9 vrcholll v ose X a 3 vrcholy v osach Y a Z. Nyni je tfeba
propojit deformacni mfizku a deformovany objekt. K tomu je tfeba vybrat objekt kliknutim pravym
tlacitkem mysi na néj a soucasné vybrat stejnym zplsobem mfizku. Oznacovani vice objekt(
soucasné se realizuje pomoci stisknuté kldvesy SHIFT. Mfizku pak nastavime jako rodi¢e deformované
koule pomoci nabidky Object->Parent->Make Parent, pfipadné stisknutim klavesové zkratky CTRL+P.
Z nasledného pop-up menu vybereme moznost Lattice deform. Nyni je jiz vSe pfipraveno

k vymodelovani tvaru téla delfina.

Madfifiers

Add Modifier To: Lattice

Make Fiegular




Samotnd Uprava tvaru se provadi v editacnim rezimu, ktery aktivujeme stiskem klavesy TAB. Je
vhodné se prepnout zobrazeni objektu na mtizku (wireframe) pomoci stisku kldvesy Z. Nyni
prepneme na pohled shora pomoci kldvesy Num7. Modelovani se provadi pomoci oznaceni skupiny
vrchol( a jejich pozadovanych transformaci. Vrcholy je nejlépe vybirat pomoci boxu (klavesa B), ktery
oznaci véechny v ném obsaZené vrcholy. S takto ozna¢enymi vrcholy je poté moZno provadét
Skalovani (kldvesa S), i translaci (kldavesa G). Nasim cilem je ziskat elegantni trup delfina pti pohledu
shora, ktery by mél vypadat napfiklad takto.

Nyni je tifeba podobné Upravy provést jesté v pohledu zepredu (kldvesa Num1). Po dokonéeni
pozadovanych transformaci dostaneme zakladni tvar téla delfina.

Aby byl model kompletni, je nezbytné ptidat a vymodelovat jesté koncetiny, tedy ploutve. Toho
nejlépe dosdhneme vyuzZitim Beziérovych kfivek. Z nabidky vybereme Add->Curve->Bezier curve,
prepneme do pozadovaného pohledu pomoci numerické klavesnice a zacneme modelovat zékladni
tvar ploutve. Pfepneme do editacniho reZzimu (kldvesa TAB) a oznadime posledni bod krivky. Pomoci
klikdni pravym tlacitkem mysi za soucasného drZzeni kldvesy CTRL pfiddvame dalsi vrcholy kFivky,
dokud nedostaneme poZadovany tvar. Délku Casti kFivky a jeji sklon upravujeme Gpravou bod( na
koncich pomocné usecky, kterd je ¢asti tecny dané ¢asti kivky. Kfivku ndsledné uzavieme stisknutim
klavesy C. Po dokonéeni by mél zakladni tvar ploutve vypadat asi takto.



Nyni stiskneme F9 pro pfistup do editaéniho mddu a Upravou nékolika atributl dostaneme konecény
tvar ploutve. Je tfeba vybrat tlacitka Back a Front, kterd vyplni povrch uvnitf kfivky. Parametr Bevel
Depth nastavime na hodnotu 0,15 a parametr BevResol na hodnotu 2. Poté bychom méli ziskat
nasledujici tvar ploutve.

Add Modifier To: Curve.001
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Ploutev je v mém modelu pouzita celkem pétkrat. Nejprve objekt oznacime pomoci pravého tlacitka
mysi a nasledné jej duplikujeme pouzitim kldvesové zkratky SHIFT+D. Duplikat pfetdhneme do
volného prostoru, jeho velikost zménime pomoci Skdlovani (kldvesa S), otocime jej do sprdvné
orientace (kldvesa R) a pfesuneme na spravné misto (klavesa G). Tento postup opakujeme do té
doby, dokud nejsou vSechny ploutve spravné na svém misté. Takto napfiklad vypada ploutev ocasni,
ktera je slozena ze dvou stejnych ¢asti.

Tvar prsnich ploutvi je na vzoru podstatné odlisSny od ostatnich ploutvi, proto je tfeba jej jesté
upravit. Toho docilime stejnym zplsobem jako u téla a to pomoci deformace mfizky. Po findlnich
Upravach vypada prsni ploutev takto.

K dokonceni tvaru zbyvd jen pfidat tlamu a oci. Tlama byla vymodelovana opét pomoci Beziérovych
kfivek s koeficienty Bevel Depth = 0.01 a BevResol = 4.



Zbyva jiz jen vymodelovat oci a umistit je. Jednd se opét o malé hladké koule zapusténé z vétsi ¢asti
do téla. Takto tedy bude vypadat delfini kostra v naSem podani.




Nyni jiZ zbyva jen pridat textury. Jako textura byl pouZit obrazek kiize skute¢ného delfina. Obrazek je
poufZit jak pro samotnou texturu, tak pro bump mapu. Textura vypada takto:

Texturu nastavime objektu nasledujicim zplsobem. Napred je tfeba objekt, pfipadné objekty, jez
maji byt otexturovany oznacit. Tém je tfeba pfifadit materidl v odpovidajicim menu (kldvesa F5)
pomoci tlacitka ADD NEW. Poté prejdeme pomoci tlacitka F6 do menu textur, kde texturu vytvorime.
Opét v panelu Textures klikneme na Sipky pro vybér textury, zvolime moznost ADD NEW. Poté
zvolime typ textury obrazek a obrazek vyberme. Nastavime opakovani textury v osdch X a v.
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Nyni se mGzZeme vratit zpét do menu materidlll (F5) a zvolit material vybraného objektu.

V odpovidajicim panelu zvolime texturu, kterou jsme praveé vytvofili. V naSem pfipadé je textura
pfidana dvakrat, kdy jednou slouZi jako klasickd textura a podruhé jako bump mapa. Pro nastaveni
bump-mappingu je tfeba prepnout do zdlozky Map To a stisknout betonky Nor (textura ovliviiuje
referované normaly) a No RGB (barvy jsou prevedeny do odstint Sedi, tj. pocitd se jen s intenzitou).
Na zavér zbyva vybarvit obé oci cernou barvou v témZe menu.
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Posledni podstatnou véci je pfidani pozadi. V mém ptipadé jsem pouzil jednoduchy gradient evokujici
mofskou vodu. Vybereme tedy kontrolni prvky World buttons a ptifadime odpovidajici texturu.
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Nyni jiz zbyva jen spravné umistit kameru (NumO), aby byl objekt zabran ze spravného uhlu, nastavit
osvétleni a scénu vyrenderovat. Jako osvétleni jsem zvolil slunecni paprsky. Spolecné s texturou
pozadi jsem se snazil ukdzat delfina plujiciho tésné pod hladinou mofe. K vybrani typu zdroje svétla je
tfeba oznadit lampu, pfejit na Lamp buttons a vybrat typ osvétleni Sun (intenzivni paralelni paprsky).
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Nyni jiz zbyva jen scénu vyrenderovat pomoci tlacitka F12.




Modelovani v Blenderu

V tomto tutoridlu se pokusim popsat, jak jsem pomoci zakladnich technik
vymodelovat luk. Vychazel jsem z nékolika tutorialu na internetu zejména na

www.grafika.cz a www.3dscena.cz.

Nejtézsi je zapomenout na bézné navyky prace s mysi.

Levym tlaéitkem mysSi (LM) objekty pfesunujeme a potvrzujeme provedené ukony.

Pravym tlacitkem mysi (PM) objekty vybirame, pokud objekt pfesuneme, stiskem

PM tuto zménu stornujeme

Koleékem mysi (KM) scénu pfiblizujeme a oddalujeme, pfi stisknutém kolecku

pohybem mysSi ménim uhel pohledu na scénu.

Pro mé osobné bylo nejbolestnéjsi zapomenout na osvédéenou metodu ,kdyZ nevim

jak dal, kliknu PM a z nabidky si uz néco vyberu*.

Prepinani Object a Edit mode

Mezi témito mody pfepiname klavesou ,tab“.

Object mode: zde se predevsim objekty pfesouvaji, méni jejich velikost a rotuje se
S nimi.

Edit mode: zde se pracuje s koncovymi body tzv. vertexy.

Vertex se oznaci kliknutim PM, pokud chceme oznadit vice vertexd, tak pfidrzime
klavesu ,shift“. Pokud jsme lini nebo chceme oznacit hodné vertexu, stiskneme dva
krat klavesu ,b“. Objevi se kole€ko, jehoz velikost miZzeme ménit podle potfeby KM.
Vertexy se oznaci pokud drzime LM a koleCkem pfejedeme nad vertexem.
Odznaceni se provadi drzenim KM a pfejeti koleCkem nad vertexem.

Luk budu modelovat pomoci beziérovych kfivek. Nejlépe je zagit s Cistou pracovni

plochou, proto dva krat stisknu ,a“ ¢imz se oznaci vdechny objekty, které se smazou

klavesou ,delete“. Nové objekty se obecné vkladaji klavesou ,mezernik“ nebo



kliknutim na ,Add“. Beziérovu kfivku vloZzime Add -> Curve -> Bezier curve (Bezier

circle je uzaviena kfivka, ale o tom pozdéji).

Pomoci jedné kfivky nejsme schopni vymodelovat luk, proto jich vloZzime vice. To se
provede oznacenim vertexu PM a za sou€asné stisknuté klavesy ,ctrl“ klikneme LM

na misto, kam chceme umistit dal$i konec kfivky.

Pomoci 4 bezierovych kfivek jsem schopni vymodelovat tvar, ktery se (alespon
trochu) podoba luku.

Aby bylo obé strany luku soumérné, ,pfichytil“ jsem koncové body k mfiZzce. Obrazek

se snadno pfiblizi KM. Pokud mame obrazek hodné pfiblizeny a chceme se podivat
na jeho druhy konec: horizontalné rolujeme koleCkem a sou€asné stisknutou
klavesou ,ctrl“, vertikalné rolujeme koleCkem a soucasné stisknutou klavesou ,shift*

(podle mé je vertikalni rolovani opacné proti béZznym zvyklostem).

Luk zatim neni 3D, toho docilime ,tazenim profilu“. Klavesou ,tab“ se pfepneme do
object mode pfes mezernik -> add -> bezier circle vloZim uzavfenou kfivku. Tuto
kfivku musime vhodné vytvarovat tazeni vertextl a hodné zmensit (oznacenim vSech
vertexu, stisknutim klavesy ,s“ a tazenim mysi ke stfedu naseho byvalého kolecka,

protoZe se bude jednat o profil luku.



Pokud mame kole¢ko v podobném tvaru jako na obrazku, pfejdeme k propojeni obou

obrazku.
V poli OB na obrazku napiSeme né&jaky nazev napf. luk




Ted nas luk by mél vypadat néjak takhle:

Abychom mohli luk modelovat pomoci vertexd, musime ho prevést do klavesovou

zkratkou ,alt + c* do meshe, jelikoZ je pofad kfivkou.
Ted musime oba konce luku ,ukonéit‘. Oznacime si koncové vertexy - nejlépe
hromadné (dva krat klavesa ,b“) a oznacené vertexy k sobé pfiblizime stisknutim

klavesy ,s“ a pohybem mysi ke stfedu a zacelime ,shift + f*.

Nyni prostfedek luku rozSifime, oznacime si asi dvé rfady vertext a tazenim mysi

nahoru

ProtoZe jsme luk modelovali pomoci kfivky, musime stfed trochu narovnat. Oznacime

si prostfedni Fadu vertexd a tdhneme je nahoru. Tohle je nas dosavadni vysledek.

Nyni na obou koncich luku udélame bandaze, do kterych bude umisténa tétiva.
Oznacime vertexy, kam chceme bandaze umistit a zvétSime je. ProtoZe budou mit

jinou barvu, musime je osamostatnit - klavesou ,p“ a vybérem selected.



Nyni musime pfidat tétivu. To provedeme pfidanim nového objektu typu cylinder: Add
-> Mesh -> Cylinder. Objektu zmens§ime primér aby pomérné odpovidal tloustce luku

a oba konce vyextrudujeme. Nas luk nyni vypada néjak takhle.

Tady je v detailu bandaz s tétivou.




Ted je na Case pfiradit jednotlivym ¢astem barvu.

Z http://www.3dscena.cz/art/3dscena/wood.jpg si stahneme texturu, kterou

pouzijeme na télo luku a Cast tétivy, na bandaze a stied tétivy Sedivou barvu.
Oznacime luk a stiskneme ,F5°, klikneme na ¢ervenou kouli a pokracujeme kliknutim
na Add new. Nyni pfejdeme kliknutim na leopardi kiizi (hned vedle Cervené koule),
tam pfidame na8i texturu tak, Ze v nabidce vybereme typ image. V dalSi nabice
vybereme Load image a z adresaie, kam jsme stahli nasi texturu, vybereme
pozadovany obrazek. Kliknutim na ¢ervenou kouli se vratime zpét a pfepneme se na
Map input (Uplné vpravo). Zde misto Flat zvolime Cube a misto Orco Globe.

Nastaveni barvy bandazi a stfedu luku najdeme pod klavesou ,F5“.

Abychom vibec néco vidéli, je jesté potfeba pfidat svétlo a kameru. Svétlo umistime
mezi objekt a kameru. Oboji se pfida pfidava jako ostatni objekty tedy add -> lamp ->

lamp pro svétlo a add ->kamera pro kameru

Nyni muZeme klavesou ,F12“ nas pokus vyrenderovat. Ja jsem dopadl takhle:

Pro zlepSeni vysledku mizeme luk jesté vyhladit. To se provede v object modu
oznacenim objektu, stiskem klavesy ,F9* a zvolenim voleb Auto smooth a Set

smooth. Nyni objekt opét vyrenderujeme a vidime, Ze luk je hladsi



Pokud chcete vyrenderovany obrazek ulozit do bézného formatu (jako Ze asi chcete)

stisknéte klavesu ,F3“.



Dorsky chram v Blenderu

Autor : Bc. Martin Kult

Tento strucny tutorial popisuje zakladni modelovaci techniky v prostfedi aplikace Blender.
Jako objekt pro modelovani byl vybran dorsky chram (konkrétn€ bylo pruceli modelu
vytvoreno podle obrazu chramu v Delosu) a pro modelovani byl pouzit Blender verze 2.44.

Pro strucnost budu v textu pouzivat nasledujici zkratky:

- LMB = levé tlacitko mysi

- MW = kolecko mysi

- RMB = pravé tlacitko mysi

- NumN = klavesa N na numerické klavesnici

V prvni fad€ je pro modelovani scény nutné zvladnuti orientace v 3D prostoru. Rtizné pohledy
na model 1ze ménit pomoci numerické klavesnice. Kazda klavesa ma pridélen specificky
pohled na scénu:

- Num O ... pohled kamery. V ptipad¢ vice kamer lze po vybrani kamery (pomoci RMB)
stiskem Ctrl + Num 0 zvolit novou aktualni kameru.

- Num 1... bo¢ni pohled ve sméru osy Y.

- Num 3 ... bo¢ni pohled ve sméru osy X.

- Num 7 ... pohled shora ve sméru osy Z.

- Num 5 ... pfepinani mezi ortogonalnim a perspektivnim pohledem.

- Num 2,4, 6,8 ... otai¢eni modelu o 15° v kolmych smérech aktudlniho pohledu.
- Num + ... ptiblizeni scény.

- Num - ... oddaleni scény.

Ptiblizeni a oddéleni 1ze realizovat t¢Z pomoci MW. Pro pohyb v prostoru scény lze pouzit
stisk MW. Pohyb doprava ¢i doleva, resp. nahoru ¢i dolt, v aktudlnim pohledu je mozny
pomoci Ctrl + MW, resp. Shift + MW.

Popisu prostredi aplikace Blender a funk¢énosti jednotlivych ¢asti se vénuje mnoho tutorialt a
proto tuto oblast piesko¢im a prejdu rovnou k popisu modelovani dorského chramu.

Modelovani chramu

Priceli chramu lze intuitivné rozd¢lit na tfi samostatné ¢asti. V prvni fad¢ je to podstavec se
schodistém, dale pak sloupy a nad nimi kladi. Jednotlivé ¢asti jsem modeloval oddélené. Pro
zajisténi realnych proporci modelu jsem objekt vytvarel dle obrazu chramu v Delosu (viz
nasledujici obrdzek), ktery jsem v Blendru umistil jako pozadi (menu View — Background
Image...).



Schodisté

NejjednodussSim tvarem chramu je jednoznacné schodisté. Jedna se o nékolik kvadra
naskladanych na sebe.

Do scény jsem v prvni fadé v ortogondlnim pohledu ve sméru osy Z pridal ¢tvercovou sit’
pomoci mezerniku a nasledného vybrani typu objektu (Add — Mesh — Plane). Ctverec jsem
zvétSil na velikost podstavee obrazku na pozadi pomoci S+ pohyb mysi. Objem jsem
prvnimu kvadru dodal metodou extrude ve sméru osy Z (E + Z + pohyb mysi).

Pro vytvoteni spodni podstavy dalsiho kvadru jsem zkopiroval horni podstavu a zanechal ji na
stejném misté jako byl vzor kopie (Shift + D, Enter). Kopii jsem nasledné zmensil (S + pohyb
mys$i) na pozadovanou velikost. Tento postup jsem opakoval, dokud nebylo schodisté hotovo.



Sloupy

Jako druhou ¢ast modelu jsem vytvarel sloupy chramu. Vzhledem k tomu, Ze sloupy jsou
identické, stacilo vytvorit jediny sloup a nasledné jej nakopirovat.

Sloup jsem vytvarel opét metodou extrude, nyni vSak jako podstava
poslouzila kruznice. Po prepnuti do ortogonalniho pohledu ve sméru osy
Z jsem vlozil kruhovou sit (Add — Mesh — Circle), kterou jsem
nasledné tiikrat extrudoval ve sméru osy Z (E + Z + pohyb mysi). Ttreti
kruznici odspodu jsem nasledn¢ zmensil polomér (S + pohyb mysi) a
celému sloupu vyhladil povrch (oznacit cely sloup, menu Mesh — Faces
— Set Smooth).

Posledni c¢asti hlavy sloupu je kvadrovy nosi¢ kladi. Ten lze snadno
vytvorit pomoci metody extrude aplikované na ¢tvercovou podstavu.

Vytvoteny sloup jsem nasledné kopiroval a umistoval na mista sloupt
v obrazku na pozadi (Shift D + X + pohyb mysi).




¥ Multires
|

Kladi

Pro vytvofeni bezesporu nejslozitéj§i ¢asti chramu jsem jako podstavu pouzil kopii
nejvrchnéjsi podstavy schodisté, kterou jsem piesunul na urovenn horni hranice sloupt. Tu
jsem nasledné extrudoval az po posledni vodorovnou fimsu.

Drtive, neZ jsem extrudoval jednotlivé Casti stieSniho plasté, bylo nutné vytvotit prostorovou
strukturu praceli, tj. zménit umisténi jednotlivych casti v roviné tvofené osami X a Y.
Postupnym extrudovanim nejvyssi roviny jsem dospé€l k nasledujicimu tvaru (pohled ve
sméru osy Z):



Po extrudovani tohoto tvaru ve sméru osy Z (E+Z+posun mysi)jsem dvojice bodi
symetrickych podle osy X sjednotil vzdy do bodu ve stfedu jejich spojnice (Alt M + At
Center) a pfipadné nasledné posunul do odpovidajici vysky (G + Z + posun mysi). Poslednim
krokem bylo vytvofeni samotného stfesniho plasté extrudovanim nejvysSsich rovin ve sméru
osy Z vzhlru. Tim jsem dostal nasledujici tvar stieSniho plasté a stitt:



Zdobeni kladi

Zdobeni mezi fimsami kladi jsem wvytvofil opét extrudovanim ctvercové podstavy a
naslednym kopirovanim kvadru ve sméru osy X (Shift D + X + posun mysi).




DopInéni objekti ve sméru osy Y

Do tohoto okamziku jsem podstavec a kladi vytvarel v pudorysu jako ¢tverec. To mélo své
opodstatnéni. Doséahl jsem tak toho, ze pfi extrudovani a ptidorysnych zménach maji fimsy,
popft. schody, ve sméru osy X a ve sméru osy Y stejnou velikost.

Navic jsem vytvoril pouze jednu fadu sloupti a jejich doplnéni pfislo na fadu nyni. Po
oznaceni vSech sloupd (B + oznaceni oblasti my$i) jsem fadu sloupld osmkrat zkopiroval ve
sméru osy Y s ekvidistantnim rozestupem (Shift D+ Y + 1,57). Po odstranéni sloupt
uprostied chramu (oznaceni + X) jsem dospél k nasledujicimu schématu:

Foundation\Blender\.blender\dorsky_chram.blend]
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Assign

Nasledné bylo ovSem tieba rozsifit pudorys podstavy a kladi o potfebny rozmér. To bylo
mozné po oznaceni piislusného praceli chramu a jeho posunu (G + Y + posun mysi).




Vytvoireni scény
Predchozi text popisuje vytvoieni objektu chramu. Z takto vytvofeného modelu lze
vyrendrovat napft. nasledujici obrazek:

Mezi dal$i moznosti Blenderu patii pfidani textury (napf. mramor), hra se svétlem, stiny a
pohledy na vytvofeny objekt apod. Moznosti je mnoho a vénuje se jim velké mnozZstvi
tutorialt dostupnych na internetu.

Ja& jsem ovSem také s texturami a svétlem experimentoval a jako ukadzka vyrendrovanych
obrazki poslouzi nasledujici dva.






Komprese videa

Co je to video? Video je sekvence po sob¢ jdoucich obrazkt. My bychom chtéli toto video ukladat do
pocitace, abysme jej mohli dale zpracovavat, sestiihat stiihovym programem a vysledek pak
exportovat do n¢jakého vhodného formatu, at’ uz pro vysilani ptes internet, ¢i k promitani v DVD
prehravaci. Surové video by ale bylo pomérné velké. Méjme rozliSeni 720x576 v barevném formatu
RGB (coz je standartné 3x8bitd, tedy 3 bajty na jeden obrazovy bod) a snimkovou frevenci 25Hz. Pak
jednoduchym vypoctem zjistime, ze k uloZeni jedné sekundy videa potfebujeme 720x576x3x25 = 31
104 000 bajta. Pokud si vezmeme 80GB disk, pak bysme tento disk zaplnili pfiblizné nahranim 42
minut videa. Odtud tedy plyne potieba video komprimovat.

Pro pfevod videa do riiznych komprimovanych format slouzi takzvané kodeky. Plivodni anglické
oznaceni terminem codec vzniklo prostym slozenim slov coder a decoder. S jejich pomoci miZzete
video do pozadovaného formatu prevést a v budoucnu pak prehravat. Jak zvuk, tak video byvaji casto
dopliovany o dodate¢né informace (takzvana metadata — data o datech), diky nimz Ize jejich béh
sladit.

Zvuky a zvukova zafizeni - viastnosti
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Zakladni informace o nainstalovanych kodecich miizete zjistit primo ve Windows. Jejich vlastnosti naleznete pod polozkou
Zvuky a zvukova zarizeni v Ovlddacich panelech

Kodek je tedy néjaky algoritmus, ktery snimky daného videa zakdduje do mensi podoby a pfi
prehravani videa jej zase dekoduje jiz v realném Case. Kodeky muzeme dale rozdélit na ztratové a
bezeztratové. Ruzné kodeky se dale 1isi kvalitou, rychlosti a vyslednou velikosti komprimovaného
videa, ktera je vétsinou v poméru k nekomprimovanému originalu 1:4-1:100.

Ztratova komprese

Druhym zptusobem ukladani dat v pocitaci je ztratova komprese. Pomoci specialniho algoritmu se
zmen§uje objem dat na zlomek ptivodni velikosti. Pfitom se ale nékteré méné duilezité informace
ztraceji a z vytvorenych dat jiz nejdou zrekonstruovat.

Ztratova komprese se nejcasteji pouziva pro ukladani obrazovych a zvukovych zdznamt. Vychazi z
faktu, ze lidské oko neni schopné zaznamenat vSechny detaily filmu, a proto ze snimkt vypousti
¢loveékem jen tézko postifehnutelné detaily.

Ptesto, ze se ¢ast informace pfi ztratové kompresi nevratné ztraci, je tento zptisob ukladani dat ¢asto
velmi vyhodny. Ztrata nékterych informaci je totiZ zcela vyvazena velmi vyraznym zmensenim
komprimovanych dat. Obvykle je tak urcita (mald) ztrata kvality vyvazena vyraznou usporou mista.
Priklady vyuziti:

digitalni televizni vysilani



filmova DVD

prenaseni dat ptes Internet a dalsi datové sité

ukladani do multimedialnich pfehravaca

Ztratova komprese je nepouzitelnd v piipadé, kdy je potieba uchovat presnou kopii ptivodnich dat,
naptiklad text knihy, program nebo vysledky méfeni.

Principy ztratové komprese

Obecny pristup ztratové komprese je jednoduchy. Po uvodnim pfedzpracovani se preskupi a/nebo
transformuji data tak, aby bylo mozno lehce oddé¢lit dilezité informace od nedtlezitych. Nedilezité
informace se pak potlac¢i mnohem vice nez dilezité a nakonec se vysledek zkomprimuje nékterym z
bezeztratovych kompresnich algoritma.

Algoritmus ztratové komprese ma tedy dvé podstatné ¢asti — transformace ptiivodnich dat a potlaceni
ruzné dialezitych dat.

Transformace ptavodnich dat

K transformaci pivodnich nebo predzpracovanych dat se obvykle pouziva néktera z ortonormalnich
nebo témet ortonormalnich transformaci. Ptiklady takovych transformaci jsou naptiklad DCT
(diskrétni kosinova transformace), FFT (rychla Fourierova transformace) nebo DWT (diskrétni
vinkova transformace). Tyto transformace prevedou ptivodni data do jinych domén, napiiklad z Casové
do frekvencni. Vétsina z dilezitych informaci je poté uchovana v mnohem mens$im objemu nez
pivodné. Pokud zbytek dat nahradime né&jakymi predem zndmymi nebo vypocitatelnymi daty (n¢kdy
se pro tento ucel hodi samé nuly), data se po zpétné transformaci budou velmi dobte podobat datim
puvodnim.

Potlaceni nékterych dat

V této ¢asti kompresniho algoritmu je rozhodujici kvalitni psychovizualni nebo psychoakusticky
model, ktery urcuje, jakd data mohou byt potlacena nebo dokonce upln¢ odstranéna. Pfi kompresi
obrazu se posuzuje, které frekvence v obrazu jsou duilezité, aby ¢lovék na obrazku vidél to, co na ném
vidét ma.

Formaty vyuzivajici ztratovou kompresi

JPEG, JPEG 2000, MPEG, MP3, Vorbis, WMA, AAC, VQF

Mezi velice znamé ztratové kodeky patii i MJIPEG, jehoz nazev vznikl zkrdcenim anglického oznaceni
Motion JPEG, které jiz trochu napovid4, na jakém principu funguje. Kazdy snimek videa se totiz
komprimuje pomoci ztratové JPEG komprese, takze v disledku 1ze i MJPEG zatadit do skupiny
ztratovych kodekd. Pii kompresi si uzivatel vétSinou mize zvolit velikost ztraty obrazovych dat a tim
predurcit kvalitu i velikost vysledného videa. Diky tomu, Ze se kazdy snimek komprimuje samostatné,
nachazi MJPEG uplatnéni pfi stiihu videa na pocitaci.

Bezeztratova komprese

Bezeztratova komprese je jeden ze dvou zakladnich pfistupt ke kompresi dat. Jedna se o algoritmy,
které dovoluji pfesnou zpétnou rekonstrukci komprimovanych dat, narozdil od ztratové komprese, kde
to mozné neni.

Bezeztratova komprese se pouziva vSude tam, kde je dtlezité, aby originalni data a data po
dekompresi komprimovaného souboru byla totozna - napt. komprese textti nebo komprese c¢ehokoli,
kde je nepfipustna i sebemensi ztrata kvality. Mizeme se s ni setkat ve vSech béznych archivacnich
programech urc¢enych ke kompresi souborti (WinZIP, WinRAR apod.).

Algoritmy bezeztratové komprese

Jednotlivé algoritmy muZzeme rozdélit podle typt dat, pro které jsou urCeny. Existuji ¢tyti zakladni
typy dat, které algoritmy zpracovavaji - data textového charakteru, data obrazového charakteru, data
zvukového charakteru a videa. V principu mohou existovat také univerzalni algoritmy, které mohou
zpracovavat jakykoliv typ vstupnich soubort.

VétSina bezeztratovych komprimacnich programt nepouziva jen jeden algoritmus, ale hned nékolik
najednou. U né€kterych komprimacnich programi jsou data napted transformovana a az poté
komprimovana. Zminéna transformace se pouziva za tcelem dosazeni lepSich kompresnich poméru.



Rozdéleni algoritmi bezeztratové komprese

Transformace

Tyto algoritmy ve skute¢nosti nic nekomprimuji, pouze modifikuji data tak, aby se dala Iépe
zkomprimovat. Je také podminkou, ze ke kazdé transformaci musi existovat transformace inverzni,
ktera bude schopna obnovit ptivodni data.

Burrows-Wheeler transformation (BWT)

Move to front I (MTF I)

Move to front IT (MTF II)

Weighted frequency count (WFC)

Distance coding (DC)

Inverse frequency coding (IF)

Slovnikové algoritmy

Zjednoduseng: Algoritmy v této skupiné vytvaieji v prubéhu komprimace slovnik na zakladé dat jiz
zkomprimovanych, v némz se pak snazi najit data, kterd se teprve maji komprimovat. Pokud jsou data
nalezena ve slovniku, algoritmus zapiSe pozici dat ve slovniku misto samotnych dat.

Lempel-Ziv 77 (LZ77)

Lempel-Ziv 78 (LZ78)

Lempel-Ziv-Welch 84 (LZW84) - podobny LZ78, byl velmi popularni, ale také patentovany
LZMA

Statistické algoritmy

Snazi se uréitym zpasobem piedvidat jaké znaky budou v souboru dat nasledovat. Pro znaky s vyssi
pravdépodobnosti vyskytu vyhradi algoritmus kratsi informaci pro jejich zapsani, pro znaky s nizsi
pravdépodobnosti vyskytu vyhradi naopak del$i informaci pro jejich zapsani.

Statistické metody dale délime na metody se statickym modelem (model slouzi pro vypocitavani
pravdépodobnosti vyskytu znaki) a metody s adaptivnim modelem. Metody se statickym modelem
vytvoii pfed komprimaci dat uréity model a podle ného zkomprimuji cely soubor dat, zatimco metody
s adaptivnim modelem priubézné model aktualizuji.

Shannon-Fanovo kddovani

Huffmanovo kdédovani

Aritmetické kodovani (znamé taktéz jako aritmeticko logické kodovani)
Range coding (RC)

ACB

Prediction by partial match (PPM)

Ostatni algoritmy

Run length encoding (RLE)
Potlaceni nul

Bitové mapy

Pilbajtové kddovani

Mezi nejznamé;jsi zastupce bezztratovych kompresi patii kodek s ndzvem HuffYUV. Vlastni
algoritmus funguje na podobném principu jako bezztratova JPEG komprese, dokdze zmensit velikost
videa az na polovinu a poradi si s barvami ve formatu YUV 1 RGB. HuffYUV pouziva k ukladani
obrazové informace Huffmanovo kodovani. Mezi jeho hlavni pfednosti patii vysoké rychlost.

Huffmanovo kédovani

Huffmanovo kdédovani bylo navrzeno ptiblizné v poloviné minulého stoleti a stale patii mezi
nejpouzivanéjsi bezztratové komprese. Své vyuziti naslo uz v JPEG, MP3, PKZIP (metoda deflate) a
mnoha multimedidlnich kodecich.

Funguje na pomérné jednoduchém principu: Nejprve je zapotiebi zjistit, kolikrat se jednotlivé
symboly v datech vyskytuji (Cetnost). Pro jednoduchost piedpokladejme, ze se data skladaji pouze ze
znaku a, b, ¢, d, e a jejich Cetnosti odpovidaji udajim v tabulce.

a b c d e



4 7 12 9 10

Znaky se sefadi podle jejich Cetnosti. Ve stromu (grafu) se spoji vzdy dva s nejnizsi ¢etnosti. Spojnice
se ohodnoti 0 a 1. Postup se opakuje a misto jednotlivych symboll se pouZzivaji nové vzniklé dvojice
az vznikne graf, jehoz hrany pravé udavaji kddovani znaku.

Jednotlivé znaky se tedy budou kddovat podle jednoduché tabulky.

a b c d e

111 110 0 101 100

Huffmanovo kodovani tak zajist'uje, ze se znak s nejvyssi Cetnosti se bude kodovat pomoci nejkratsi
posloupnosti. Véta ,,abeced”, ktera ma délku 6 B, tedy 48 b, se zakdduje do fetézce
,»1111101000100101, ktery ma délku jen 16 b.

MPEG

Zkratka MPEG znaci Motion Picture Experts Group, coz je vybor mezindrodni organizace ISO, ktera
definuje standardy v oblasti komprese videa. A jak komprese MPEG funguje? Obraz se nejprve
rozdéli do tzv. makroblokt o velikosti 8 x 8 nebo 16 x 16 px a kazdy z té€chto blokll je nadale
zpracovavan samostatné. U dvou po sob¢ nasledujicich snimkt se poté ur¢i rozdily mezi jednotlivymi
makrobloky. Obrazky se rozdé€luji do tzv. IPB sekvenci, kde oznaceni IPB vzniklo ze spojeni Intra
coded image (I snimky), Predicted image (P snimky) a Bidirectionally interpolated image (B snimky).
Také snimky se komprimuji podobné jako v MJIPEG, navic vSak Ize na riznou ¢ast obrazu pouzit
ruzny stupeit komprese. Koédovani P-snimkt vychazi z predchozich snimki a kone¢né B-snimky se
dopocitavaji jako rozdilové snimky mezi nejbliz§im predchozim a nejbliz§im nasledujicim I nebo P
snimkem. Nejvice mista zabiraji | snimky a nejméné B snimky.
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makroblok Bxf pixeli hodnoty barew jednotlivych
pixell makrobloku

Zékladem MPEG komprese je rozdéleni obrazu do jednotlivych makrobloki. S kazdym z nich se poté
pracuje samostatné a urcuji se rozdily mezi nimi u po sob¢ jdoucich snimkd.

Nejstarsi variantu popisovaného kodeku predstavuje MPEG-1, ktery spatiil svétlo svéta koncem roku
1991 a béhem toho nasledujiciho byl piijat jako norma. Pivodné byl navrzen piedevs§im pro video o
rozliSeni 352 x 288 s frekvenci zobrazovani 25 sn./s a datovym tokem 1,5 Mb/s.

Format MPEG-2 byl dokoncen v listopadu roku 1994 a stal se standardem pro kompresi digitdlniho
videa. Jednou z novinek oproti MPEG-1 je napiiklad podpora dvou typt datového toku — CBR a VBR.
Konstantni tok (CBR, Constant Bit Rate) zajiSt'uje, ze vSechny ¢asti videa maji stejny kompresni
pomgér, naproti tomu pii proménlivém datovém toku (VBR, Variable Bit Rate) se nékteré scény
komprimuji vice nez jiné.

DalS8im v tad¢ standardt by logicky mél byt MPEG-3, nicméné jeho vyvoj byl zastaven. Cilem jeho
pusobnosti se totiz mélo stat HDTV (High Definition TV), které vSak dostate¢né pokryl jiz rozsiteny a
hojné pouzivany MPEG-2. Novy standard MPEG-4 byl publikovan v fijnu roku 1998 a zaméioval se
predevsim na pfenos videa s co nejmensim datovym tokem, piesnéji v rozmezi mezi 10 kb/s a 1 Mb/s.
Definice formatu MPEG-4 se stala vzorem pro mnoho dalSich kodeki.



Jak modelovat v Blendru

aneb Pohar v Blenderu

V tomto tutoridlu si ukdzeme zdkladni techniky modelovani v Blenderu. Na pfikladu modelovani
poharu si ukazeme jak pracovat v Blendru, praci s texturami a materidlem, néco malo k osvétleni a

vivs

Nejprve si ukazeme jak se v Blendru orientovat a kde najdeme pfislusné tlacitka a daleZitd menu.
Nejdfive si ale yavedeme par zkratek:

LM — |evé tladitko mysi

PM — pravé tlacitko mysi

KM — kolecko mysi

SM — sttedni tlacitko mysi (pokud nemdate na mysi 3 tlacitka, mizete SM nahradit pfidrzeim klavesy

Jesté nez zacneme modelovat, tak si ukdZzeme jak se v Blendru pohybovat:

Pro ptiblizeni a oddaleni slouzi KM
Pokud se chceme pohybovat doleva ¢i prava, pfidrzime Ctrl+KM
Pro pohyb nahoru a dolu ptidrzime Shift+KM

Pro riizné pohledy na modelovany objekt slouzi numericka klavesnice:

Num 1 — pohled zepredu

Num 3 — pohled z boku

Num 7 — pohled zeshora

Num 0 — pohled kamery, Cili pohled na vysledny model

Kldvesy Num 2, 4, 6 a 8 slouZi pro otdceni pohledu ve sméru horizontdlnim i vertikalnim.
Alt+LM — natdceni pohledu uzivatelem

To by bylo vSe pohybu a k ndhledu na model. Popisu prostifedi v Blendru se vénuje spousta tutoriald,
takze si pfipomeneme pouze ty nejdulezitéjsi véci.

PFi praci v Blendru méjte jednu ruku vzdy na mysi a druhou vZdy na klavesnici. Pomoci kldvesovych
zkratek se da udélat opravdu vse, jen si zapamatovat, ktera k ¢emu slouzi. Prostfedi Blendru si mlze
kazdy uZivatel nastavit sdm. J& pouzivdm standardni zobrazeni, €ili v hornim panelu jsou menu z User
preferences, uprostfed modelovaci prostredi a v dolni ¢asti obrazovky liStu z 3D View a neldilezitéjsi
listu s tlacitky.
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Co se tyce prace s mysi, zapomerite pokud mozno co nejrychleji na LM. V Blendru je dllezZitéjsi PM,
kterym selektujete objekty. Pokud tedy chcete néjaky objekt oznadit a ddle s nim pracovat, udélate to
pravé PM. LM slouZi pro potvrzeni tkolu a pro posunovani objektd. Pokud jste jesté nestlacili LM a
nepotvrdili tedy Ukon, mlZete posledni Upravu vratit zpét stlacenim PM.

Pokud budete mit zdjem dozédét se vice o prostfedi Blendru, podivejte na tutoridly pro za¢atecniky,
kde je vSe podrobné vysvétleno. My se ted’ vrhneme na modelovani poharu.

Vkladani objektti
Pokud chcete vlozit néjaky objekt stiknéte mezernik -> add -> pfislusny
objekt.

V nasem pfipadé vloZzime v hornim pohledu (Num 7) objekt Plane. Zobrazi
se nam Ctverec s vyselektovymi rohy. Stlacnim tladitka TAB mizeme
ptepinat mezi Object Mode a Edit Mode. My budeme nejdfive pracovat

v Edit Mode.

Modelovani metodou Extrude
Pfepneme do predniho pohledu (Num 1) a stla¢ime klavesu E. Z nabidky
vybere Region a téhneme mysi. Timto postupem vytvorime
z dvojrozmérného objektu objekt tfirozmérny. Nam bude vyhovavat tvar
kvadru (velokost nechdm na vas).

Pozn. Pokud chceme vyselektovany objekt posunout pouze v urcitém sméru,
zmackneme pri pohybu klavesu X, Y nebo Z. Tim docilime pohybu pouze
v jednom sméru.

Pro posunuti objektu slouZi pismeno G, pro rotaci pismeno R a pro velikost
pismeno S. NeZ budeme pokracovat dal, vyzkousejte si, jak tyto moznosti
funguji. Znovu pfipominam, ze zmdacknutim klavesy pfislusného sméru
docilete zménu pouze v tizeném sméru.

Pokud nemate oznacenu vrchni stranu kvadru, oznacte ji. Docilite toho bud’
oznacenim vSech ¢tyr vrcholll PM a drznim klavesy Shift, nebo stlacenim
kldvesy B a vyselektovanim vsech pfislusnych vrchola.

Tuto stranu znovu vyextrudujeme (E) a o trosku zmensime (S) tak, abyhom
docilili tvaru na obrdzku.

Pozn. Pokud na objekt dobre nevidite, rotujte pohledem (Num 2, 4, 6, 8), nebo
se prepnéte do jiného pohledu (Num 1, 3 7), ve kterém bude zmensSovani
jednodussi.

Pravé jsme vymodelovali
podstavec pro nas pohar.
Kldvesou F12 vyrenderujte
projekt a podivejte se ¢eho jsme
za tak kratkou chvili dosahli.
Mélo by to vypadat néjak takto.




Modelovani stopky
Pfepneme se opét do horniho pohledu (Num 7), pfepneme se do Object Modu a PM
vyselektujeme podstavec. Zarovname cursor na stfed objektu (Shift+S a vybereme Cursor ->
Selection). Tim docilime toho, Ze kdyZ budeme vkladat dalsi objekt, bude stfedové zarovnam
s podstavcem.

Pokud mame tedy zarovnany kursor
na stred, vloZime dalsi objekt a to
Circle. Mezernik -> add -> Mesh ->
Circle. PocCet vertex( zvolime tfeba
32.

Tento kruh budeme nékolikrat
extrudovat (E),
zmensovat a zvétSovat
(S), az docilime tvaru
jako na tomto obrazku.

Aby se nam pozdéji |épe pracovalo s jednotlivymi ¢dstmi, umistime
kazdou znich do jedné vrstvy. Vyselektujeme cely objekt (A) a
stiskneme kladvesu M. Vybereme jednu z vrstev, nejlépe abychom
méli ¢asti ve vrstvach po sobé pro lehéi orientaci, ve které vrstvé se
ktera ¢ast nachazi, a potvrdime OK.

EE o

Jak bude vase stopka ddle vypadat nechdm na vas. J4 jsem dale
vlozit dva objekty Uvsphere a vyextrudovany objekt Circle.

Edit Mode Object Mode Po vyrenderovani

Modelovani kalichu
P¥i modelovani kalichu budeme postupovat stejné jako
pfi modelovani stopky. Zviditelnime vrstvu, ve které se
nachazi nejvrchné;jsi ¢ast stopky (Na listé 3D View
klikneme na pfislusnou vrstvu — POZOR musi me byt
v Object Modu). Zarovname kursor se sttedem (Shift+S -
> Cursor -> Selection) a vloZime object Circle (add ->
Mesh -> Circle). Posuneme pfipadné na vrchol stojanu a
vyextrudujeme (E) do tvaru, ktery se vdm bude libit. Ja
jsem zvolil jednoduchy kalichovity tvar.




To by jsme méli zakladni tvar a nyni se zamérime na vnitrek
kalichu. Aby budil kalich dojem, Ze md opravdu objem a
nevypadal pouze jako kus papiru, vyextrudujeme (E) vrchni
vertexy dovnitf a okopirujeme tvar kalichu tak, aby vypadal
jako v redlu. Aby mél kalich také dno, vyplnime spodni kruh
(Shift+F) tak, jak vydite na obrazku. Presurite kalich do nové
vrstvy (M v Object Modu), aby se ndm pozdéji 1épe
pracovalo.

Nyni si ukdZzeme, jak pridat do objektu vice vertex,

abychom mohli objekty |épe tvarovat. Pfepneme se do
predniho pohledu (Num 1), vyberte pouze vrstvu, ve které je
kalich (lista 3D View v Object Modu), oznacime kalich (PM) a prepneme do Edit Modu (TAB).

Pozn. Pokud chceme vycentrovat objekt do stfedu pracovniho pole, nemusime to délat pomoci
KM+Shift a Ctrl. Staci kdyZ zmdckneme HOME, tim vycentrujeme objekt do stfedu pole, aby
se ndm s nim lépe pracovalo. Pokud chceme vycentrovat cursor, zmackneme kldavesu C.

Nyni je vSe pfipraveno pro vloZeni novych vertex(. Ja bych rad ptidal na plast kalichu Stitek

z logem sportu. Pridejte tedy do plasté kalichu dalsi tfi fady vertex( v horizontalnim sméru.
Vertexy priddm kombinaci kldves Ctrl+R. Pridejte také dvé rady vertext ve vertikalnim sméru.
Nyni vyselektujite nékolik vertext uprostied naseho fezu (Shift+PM) a posurite je o kousek
dovnitf. Tim docilime dojmu prohloubeni plasté kalichu. Pohrajte si trosku s vnitfnimi vertexy,
aby vypadalo vykrojeni dobfe. Vyselektujte vnitfni plochu a zarovnejte Cursor do stfedu (Shift+S -
> Cursor -> Selection). V3e by mélo vypadat podobné jako na obrazcich.




Modelovani Stitkii
V ptedchozim odstavci jsme si jiz nastavili Cursor, takze
muiZeme vloZit dalsi objekt Circle (add -> Mesh ->
Circle), pocet vertext bude stacit 16. Zmensime kruh (S)
tak, aby se ndm vesel co nejlépe do vykrojeni. Otocime
kruh (R) tak, aby byl cely vidét. MzZeme si pomoct
posunutim kousek dopfedu (G v ose Y). Pfesurite kruh
do své vlastni vrstvy (M), bude se nam to hodit. Nyni
kruh vyplnite (Shift+F). Aby nebyl Stitek opét jako papir,

vyextrudujte ho (E).

Pozn. Pokud se vdam nedari kruh
presunout do nové vrstvy, protoze
je vyselektovany takeé kalich,
vloZte kruh primo v nové vrstvé.
Pokud chcete, aby se zobrazovalo vice vrstev najednou pomoci Shift+LM
vyberte vrstvy, které chcete zobrazit.

Stitek s logem uz mame, ale jeété by
se nam hodil néjaky Stitek na podstavci, na ktery by jsme
mobhli néco napsat. Pustme se tedy do toho. Vybereme
vrstvu, ve které je podstavec. Pfepneme do Edit Modu a
oznacime predni stranu podstavce (Shift+PM nebo
v hornim pohledu B) a zarovname Cursor na stred.
VloZzime objekt Plane (add -> Mesh -> Plane) a
pfizplGsobime velikost podstavci. Vyextrudujeme (E) ve
sméru osy Y a zapustime Stitek do podstavce.

UZ ndm chybi vymodelovat jen néjaké drzadlo a kostra poharu bude hotova. Jesté nez se na to
vrhneme, oznadime vSechny vrstvy s objekty, abychom vidéli celou kostru ve své krase a
vyrenderujeme (F12).
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Modelovani drzadel (Modelovani pomoci bezierovych kiivek)
Na tomto pfikladu si ukdZzeme metodu modelovdni pomoci kfivek. Pfepneme do Uplné nové
vrstvy. Budeme potiebovat vice mista, abychom na modelovani dobre vidéli. Bude to zase néco
nového, takZe bude dobré, kdy?7 si tuto techniku potradné vyzkousite a budete chuvili
experimentovat.

Za¢neme vloZenim bezierovy kfivky (add -> Curve ->
Bezier Curve). Nejprve si vyzkousSejte posouvat

s pomocnymi body, aby jste vidéli, jak se kfivka méni.
Nyni pfidejte dalsi body kfivky (Ctrl+LM). Ted jiz
nechdm na vas, aby jste si vymodelovali tvar drzadla,
jaky se vam bude libit. J& jsem vytvofil tento tvar.

Pozn. Zalomeni pomocnych bodu docilite kldvesou V

Podivejte se podivejte na vlastnosti kfivky v Editing
menu (F9). Soustfedme se hlavné na vlastnosti Extrude, Bevel Depth. Témito vlastnostmi mlzZete

krivku extrudovat do ,,vysky“ a do ,Sitky“. Bev Resolution urcuje, jak moc bude objekt zaobleny.
NeZ budeme pokracovat, vyzkousejte si jak tyto vlastnosti ovliviiuji kfivku.

Ul [FO8Cey

My budeme modelovat metodou tazeni profilu. Pfepneme do
horniho pohledu (Num 7) a vloZime novou ktivku (add -> Curve ->
Bezier Curve). Na panelu tlacitek v Editing menu (F9) kliknéte na

tlacitko Poly. Pozor, musite byt v Edit Modu.

Posouvanim bod vytvorte tvar
jako na nasledujicim obrazku.
Urcité vam nebude stadit pocet
bodQ, pridejte jich tedy par kombinaci CTRL+LM. Az
docilite pfislusného tvaru, uzavrete kfivku tlacitkem C.

Pojmenujte novou kfivku v kolonce OB:. Zvolte tieba
jméno ,profil“. Oznacte plvodni kfivku a do kolonkz
Bev OB napiste profil. MlZete vidét, jak se na tvar nasi
krivky aplikoval profil druhé kfivky. Nyni jen upravime
velikost (S) a posuneme drzadlo na zpravné misto.

V pfipadé potieby otocime (R) podle osy Z. Nejlepsiho
otoceni docileme zarovndni Cursoru na stfed kalichu a
potom budeme otacet vzhledem ke kursoru (lista 3D
View). AZ budete s profilem spokojeni, konvertujte
drzadlo do sité kldavesami Alt+C, tim je pFipraveno k
dal$im upravam, jako je texturovani apod.

Jedno drzadlo uz tedy mdme. Radi bychom ale méli
drzadla na obou stranach a nejlépe UGplné stejna.




Oznacime tedy drzadlo a zkopirujeme (Shift+D). Jesté predtim si ale ovéfime, zda mame Cursor
zarovnany na stfedu kalichu. Po zkopirovani oto¢ime (R) drzadlo kolem osy Z. V listé 3D View
vyberte volbu Pivot -> 3D Cursor. Ted' jiZ mame vymodelovanou celou kostru poharu. Oznacte
vSechny vrstvy ve kterych mate ¢asti poharu a vyrenderujte (F12). Pokud jste postupovali
zpravné, méli by jste vidét néco podobného jako na nasledujicim obrdzku. Pozadi bude zfejmé
jiné, ale o tom az v dalSich odstavcich.

Upraveni povrchu kostry
Kdyz se podivame bliZze na vymodelovany objekt, zjistime, Ze hrany jsou pfiliZz ostré a povrch tah
hladky jak by jsme si pfedstavovali. V tomto odstavci se s tim pokusime néco udélat.

Oznacime si tedy Cast stopky a ve vlastnostech objektu (F9) klikneme na tlacitko Set Smooth. Ted
uz je porvch mnohem hladsi, ale presto to jesté neni ono. V zdloZzce Modifiers klikneme na Add
Modifier -> Subsurf. V kolonce Render level nastavte 4 a mérite postupné Level. Do 4 levelu bude
rozdil patrny, s vy3§im levelem uz se povrch moc neméni a proto nebudeme nastavovat level
vyssi jako 4. Rozdélovani povrchu je také narocnéjsi na hardware pocitace, takze se mlze stat ze
se vam pocitac zacne sekat. Upravte i dalSi soucasti poharu a vyrenderujte (F12). Nékteré ¢asti
jako je tfeba podstavec, budeme chtit nechat hranaté, takze ponechte nastaveni jak jsou. Na
obrdzcich mlzZete porovnat zmény.



Nemusim snad popisovat, ktery obrézek je pred Upravou a po Upravé. Rozdil je opravdu GzZasny.

Textury a material
Textury a material teprve doddvaji objektlim realisticky vzhled. Nejprve si tedy popiseme
jednotlivé vlastnosti materidlu a textur a poté si nékteré z nich vyzkousime na nasem prikladé.
Oznacte podstavec (RM), zapnéte materidlovou listu s tlacitky (F5) a pridejte objektu materidl

(Add New). Zobrazi se vam tyto tlacitka.

K ¢emu tedy jednotlivé tlacitka jsou:

Alpha definuje prihlednost materialu

Spec de facto urcuje intenzitu a velikost nejsvétlejSiho mista materidlu
Hard je mira hrubosti povrchu

Ref je reflexe, tj. v jaké mife material odrazi svétlo
Emit nastavte tehdy, chcete-li, aby material "vyzarova
ackoli nebude pfimo osvétlen

vlastni svétlo, tj. bude se jevit svétlejsi,



Nad témito parametry mizZete nastavit barvu materidlu. K dispozici je nékolik barevnych modeld
(RGB, HSV a MYK).

Traceable-pokud je vypnuto, objekt nevrha stin

Shadow - pokud je vypnuto, objekt nepftijima vrzeny stin

Shadeless-je-li tato volba zapnuta, objekt neni vystinovan, ale stin vrhat mdze

Wire-objekt je vyrenderovan v dratovém zobrazeni

VertexCol a VertexPaint si nechdme na pozdéji

Halo- vykresli kolem objektl jakousi zafi a dalSimi nastavenimi mizZete dosahnout takovych
efektl jako jsou odlesky objektivi apod. V podstaté zadné efekty jako jsou ohen, plasma apod. se
bez této volby neobejdou.

ZTransp - zapind prihlednost podle alfamapy

Zinvert-invertuje predchozi volbu

Env-uruje material pro environment maping

OnlyShadow- objekt bude pouze vrhat stin

Nyni se podivdme trochu na textury (F6). Prvni volba, ktera se vdm naskytne bude vybér mezi
texturou materialu a nebo pozadi (World). My se budeme vénovat texture materidlu. Vytvofime
tedy novou texturu Add New. V kolonce Texture Type zvolime Image.
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Nahrajeme obrazek (Load Image) v zalozce Image. K tlacitkim se uz nebudu vice vyjadfovat,
existuje spouta tutorial(l vénovana pouze tomuto tématu. Zminim jen vlastnost Repeat a
vlastnosti X a Yrepeat. Pomoci téchto tlacitek mUZeme nastavit, kolikrat se ma nas obrazek
opakovat a to v jednotlivych smérech.

Pfepneme se zpét do materidlového menu (F5), kde jiz mame také zalozku Texture. Zde mizeme
pridavat jiz nami vytvorené textury. Jeden objekt miZe mit aZ deset textur, které budou mezi
sebou prosvitat. V zaloZzce Map Input zaskrtnéte tladitko Cube. Tim docilime, Ze se bude obrazek
natahovat na objekt tvaru kvadr. Dalsi tlacitka v této skupiné jsou jiz z pfekladu patrné.

Textury tvorené obrazky nejsou naroc¢né, urcité je zvladnete samy. My si ale ukdzeme, jak
bychom mohli docilit toho, aby vypadal pohdr jako zlaty.

Zacneme tieba u kalichu, kde uvidime zmény nejlépe. Nejdfive mu pfiradime materidl (F5 -> Add
New). Nastavime Specularity na maximum (Spec 2.0), tim docilime lesklosti materidlu. ZvysSime
Hard na hodnotu 500. Pokracujeme v nastaveni barvy materialu, kterd bude, jak jinak nez Zluta.
Kovy zabarvuji i barvu odrazu a proto pfepneme na Spec a nastavime také Zlutou. Tentokrat

s vétsSim podilem cervené. Toto je ovSsem otazkou vkusu. J& jsem trochu barvoslepy, takze se
mnou moc nefidte. Nakonec nastavte jesté barvu Mir na svétle Zlutou.

Nyni ptiddme prvni Texturu. Bude ji Environment mapa, ktera bude mit vliv na barvu reflexe
(Ref), zrcadleni (Mir) a ve velmi malé, avsak stdle znatelné, mife na vlastni barvu objektu. Vliv na
vlastni barvu snizime stahnutim Col slideru na hodnotu cca 0,1, tedy kolem 10%.

Nakonec pfiddme druhou Texturu typu Clouds s nastavenim HardNoise.Sum by mél byt co
nejjeméjsi. Tato Textura poslouZi jako bump mapa. V materidlovych nastavenich tedy u této
textury zaktivujeme Nor tlacitko a vypneme Col. Slider Nor upravime podle potieby, aby byl
objekt mirné zvrdsnény.



Nyni jen staci, abychom si tento material pojmenovali a pfiradili viem ostatnim objektiim, které
maji mit stejnou barvu. Ja jsem nastavil koulim ve stopce stejny material, ale zménil jsem barvu
na bilou misto Zluté. Ve Spec jsem nechal Zlutou.
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Text
Vkladani textu v Blenderu neni nic sloZitého. Detailné ho popisuji jiné tutorialy, takZze my se
budeme vénovat pouze tomu co potiebujeme.
Radi bychom napsali néjaky text na Stitek na podstavci. Je celkem jedno co tam napisete, ale
pokud to bude cesky a s diakritikou, budete si muset pravdépodobné invertovat Font.
Zarovname tedy Cursor na stted Stitku (Shift+S -> Cursor -> Selection). VloZte text (mezernik add
-> Text) a jesSté neZ napiSeme tiZzeny text, zarovname ho na stred Stitku. Pfepnéte se do Objekt
Modu (Tab). V Edditing Menu (F9) kliknéte na Centre. Pokud bude potifeba otocte (R) a posurite
(G) text, aby byl rovnobézné se Stitkem, a aby byl cely vidét. V zdloZce Font zarovnejte text do
stfedu (Centre).
Prepnéte se do Edit Modu a napiSte néjaky text. VSimnéte si nastaveni Width, Extrude, Bevel
Depth a Bevel Resolution. Tyto vlastnosti slouzi na zvétseni tloustky a $ifky textu a na zaobleni.
Vyzkousejte si co délaji. ZvétSete Word spacing a Line Distance podle vasi potieby.



Pfepnéte na listu s Materialem (F6) a pfidejte textu material (Add New). Zménite barvu na
¢ernou, nebo jaka se vam bude libit. MUZete také textu priddvat textury.
Ja jsem vlastnosti textu upravil podle nasledujiciho obrazku, akorat jsem text zapustil vice do

Stitku, aby nebyla vidét zadni strana textu. To tvofi dojem, Ze je text do Stitku vyryty.

Na dalSich obrazcich vidite vysledek. Obrazek vlevo je vyrenderovan normalné a na obrazku
vpravo je kamera zaméfrena pouze na podstavec, abychom na text [épe vidéli.

Pozadi poharu
Tohle necham Uplné na vas. Jen upozornim Ze je nékolik moZnosti jak upravit pozadi. Jednou
z nich je nastaveni materidlu pozadi. Tuto moZnost najdete pod vlastnostmi materidlu (F6) a
volbou World Buttons (obrazek zemékoule). Mlzete ménit barvu, pfidavat textury, atd.

Déle mUzZete pohar vlozZit do jiz vymodelovaného prostredi, aby to vypadalo, Ze pohar nékdo drzi
a nebo jako v mém pripadé vlozit nékolik objektl Plane a ptiradit jim material a texturu.

Osvétleni
Osvétleni je velmi dlleZitou ¢asti Blenderu. Povidani o svétlech je ale dlouhd kapitola, kterou
popisuje jiz spousty tutorial(l, takZe ja se pouze zminim jak svétlo pfidat a par dalSich moznosti.
Mél jsem se o svétlech zminit asi jiz dfive, ale pfedpoklddam, Ze nejste naprosti zac¢atecnici, a ze
vite, Ze bez svétla, by jsme vidéli pouze cerny obrys vymodelovaného objektu.

Svétlo pridate jako kazdy jiny objekt (mezernik -> Add -> Lamp -> druh svétla). J3 jsem vloZil
nékolik svétel typu lamp a jedno svétlo typu Sun s polovi¢ni energii (F6 -> Lamp Buttons ->
Energy). Jedna s vlastnosti, ktera se vdim muze hodit je vlastnost svétla Layer. Pokud zaskrtnete



toto tlacitko, budou osvétleny timto svétlem pouze objektu umisténé ve stejné vrstvé. DllezZita
mUze byt i barva svétla (jezdce RGB). Pokud se chcete dozvédét o svétlech vice, podivejte se na
internetové stranky http://www.sweb.cz/blender/ nebo http://www.blender3d.cz/, kde najdete
také spoustu jinych uZitecnych tutoriald.

Zavér
Doufam, Ze vdm tento tutoridl pomohl orientovat se v Blenderu, a Ze jste si osvojili modelovaci
techniky v tomto textu pouzité. Také doufam, Ze se vam vysledny obrdzek libil. Jen pro Uplnost,
vysledny obrazek si mlzete uloZit v menu File -> Save Image (F3). Volbou File -> Save (Ctrl+W)
uloZite vymodelovanou scénu ve formatu .blend. RozliSeni obrazku se mliZzete nastavit ve
vlastnostech Scene (F10) pod zédlozkou Format.

Na Uplny zavér prikladdm pohar v nékolika prostiedich. Na poslednim obrazku je za pohar
vlozend fotka.










Bankérska lampicka v
BLEDNDERu

Uvod

Navod na vytvoteni 3D modelu bankérské lampicky je urcen pro open source
program Blender, ktery je ke stazeni na www.blender.org. Pro sezndmeni s pro-
gramem doporucuji video tutoridly, které jsou ke stazeni na téze strance. Nyni se
jiz pustime do samotného modelovani. Klavesové zkratky k jednotlivym néstrojum
budou v dalsim textu uvedeny v zavorkach.

Zarovka

Na zacatku je potieba si zvolit pohled, ktery budeme povazovat za vychozi. Do-
porué¢uji pohled z vrchu (NumLock 7). Nejprve vlozime v tomto pohledu kouli
(mezernik, Add, Mesh, UVSphere). 7 této koule vybereme jeden pdl a kouli
protdhneme magnetickym ndstrojem (o). Vybereme posledni ti patra protazent
pomoci néstroje hromadného vybéru (b). Poté vznikly tvar sefizneme (x, ver-
tices). Ptepneme do jiné vrstvy (napf. 2 - mimo numerickou klavesnici).

Obrazek 1: Tvorba banky zarovky

Déle vlozime do vykresu valec v pohledu kolmém na zdkladni pohled. Sit jedné



Obrazek 2: Protazeni banky

7 podstav vélce rozdélime na polovinu pomoci ndstroje Subdivide (w). Vnitin{
kruznici podstavce vybereme pomoci hromadného vybéru (b) a vytdahneme mag-
netickym ndstrojem (o). Zavit na spodku zdrovky vytvoifme pomoci ndstroje
Screw. Do scény vlozime kruznici (mezernik, Add, Mesh, Circle). Pravou
nebo levou pulku smazeme. To je dulezité, kdyby byla pulka odstranéna ze spodni
nebo z vrchni strany, provedla by se operace s ndstrojem Screw nevyziadanym
smérem. Nyni pouzijeme nastroj Screw. Nalezneme ho v edit médu, v panelech
editing (F'9). Nastavime Degr na 360°, Steps nékde kolem 20, ¢im vice, tim bude

1__Subdivide [Innervert ﬁi
_Hash Hsort | Fractsl
ooth it |Flip Nar

Obrazek 3: Spravné ofiznuti kruznice a panel ndstroje Screw

zévit dokonalejsi a Turns na 20. Turns urc¢uje délku zavitu (resp. kolikrat se
pulkruznice oto¢i). Vysledek moc zdvit nepiipomind, ale to lze snadno napravit.
Vybereme si vSechny body (a) a aktivujeme funkei Scale pro zménu velikosti (s).
Hned poté zmackneme na klavesnici pismenko x, y nebo z, tim se bude dany
objekt zmensovat jen v jednom sméru, tedy po ose x, y nebo z. Volba zavisi na
volbé zékladniho pohledu. Zavit zmensime tak, aby ndm sedél do spodku zarovky
vytvoreného predem. Déle vlozime kuzel (mezernik, Add, Mesh, Cone) jehoz
plast rozdélime ndstrojem Subdivide (w). Vybereme jeho vrchol a odstranime ho
(x, vertices). Vzniklou diru v hornf ¢asti vyplnime (Shift f). Tento sefiznuty
kuzel tvori kontakt zarovky.

Nyni vytvoiime vnitiek zarovky. Vlozime vélec a opét pouzijeme néstroj Sub-
divide (w). Vnitini kruznici podstavce vybereme pomoci hromadného vybéru



Obrazek 4: Zavit pred zménou velikosti

(b) a vytdhneme tentokrdte bez magnetického nastroje (je-li zapnut, lze ho vyp-
nout pomoci klavesy o). Vytvoreny stied sesadime se spodkem zérovky a pomoci
malého tenkého vélecku, ktery natoc¢ime (r), umistime, duplikujeme (Shift d)
a ozrcadlime, vytvorime drzaky vldkna. Tim mame hotovou celou zarovku. Nyni
napasujeme vSechny soucasti dohromady, aby sedély. K tomu je potfeba zobrazit
dohromady jak vrstvu s baikou, tak vrstvu se zbytkem zarovky. Toho dosahneme
kliknutim na obé vrstvy spolu se stisknutou kldvesou Shift (Shift 1,2). Poté
pro jednotlivé casti zarovky vytvoiime materidly, pripadné nacteme materialy
z néjaké knihovny pomoci néstroje Append (Shift F1). Vhodné materidly lze
stdhnout na adrese http://www.freewebs.com/blendermats/index.htm. Vysledek
je zobrazen na poslednim obrazku této sekce.

Obrazek 5: Vnitiek zarovky

Obrazek 6: Hotova zarovka



Vlastni lampicka

Stojan

Nejprve prepneme do nové vrstvy a vlozime valec (mezernik, Add, Mesh,
Tube), ktery roztdhneme do placky pomoci ndstroje pro zmeénu velikosti (s).
Poté vlozime kruh (mezernik, Add, Mesh, Circle), a to nejlépe v pohledu
Top (Numlock 7), ktery rozpulime a jeho konce protahneme. Vznikly tvar orotu-
jeme pomoci nastroje Spin, ktery ma stejné parametry a je ve stejném panelu jako
nastroj Screw, ktery jsme si popsali pii tvorbé zavitu. Parametry budou: Degr
- 360°, Steps nékde kolem 30, Turns - 1. Rotaci pouzijeme pii pohledu zpiedu
(Numlock 1). Déle vlozime kuzel (mezernik, Add, Mesh, Cone) a pouzijeme
na jeho plast 3-krat funkci Subdivide (w), horn{ tii patra odstranime a vrsek
zacelime pomoci vyplnéni (Shift f). Vsechny tii kusy sesadime a spojime dohro-
mady (Ctrl j). Tim mdme hotovu zdkladnu stojanu. V dalsim kroku vlozime
kruh (mezernik, Add, Mesh, Circle) a vybereme kazdou druhou dvojici bodu
(musi mit tedy pocet vrcholu délitelny ¢tyimi). Pomoci ndstroje zména velikosti
(s) vytvoifme zoubkovany tvar, ktery extrudujeme(e).

Takto vzniklou ty¢ duplikujeme (Shift d) a sesadime se zdkladnou stojanu.

Obrazek 7: Zéklad pro ty¢ stojanu

Z vrchu poté ty¢ uzavieme kouli (mezernik, Add, Mesh, UVSphere). Zdup-
likovanou ty¢ zmensime a zestihlime pomoci nédstroje zmény velikosi (s), a poté
pomoci rotace (r) oto¢ime o 90° a vsadime do koule. Z druhé srany opét uzavieme
kouli. Ty¢ opét zduplikujeme a obdobnym postupem dokoné¢ime rameno. Nakonec
pomoci kuzele vytvorime drzak stinitka. Vysledek po sesazeni je vidét na nasle-
dujicim obrazku. Poté celé rameno spojime do jednoho objektu (Ctrl j), zdup-
likujeme (Shift d) a ozrcadlime se stiedem ve velké kouli stojanu podle lokalni
osy X (Ctrl m,1). Nakonec cely stojan spojime (Ctrl j) a pritadime mu vhodny
material.



Obrézek 8: Celé rameno

Objimka
Vlozime véalec (mezernik, Add, Mesh, Tube), pouzijeme Subdivide (w) na
cely vélec a oznacime horni patro, které roztdhneme pomoci zmény velikosti (s).
Poté zdklad objimky zkopirujeme (Shift d), zmensime (s) a zasuneme zpét. Nyni
pomoci Boolovské operace Difference (v menu pod klavesu w) udélame rozdil ob-
jektu. Tim dosdhneme dutého vzhledu viditelného na obrazku. Pritadime néjaky
vhodny materidl a mame objimku hotovou.

Obréazek 9: Objimka

Nyni vytvoiime fetizek vypinace. Vlozime kouli a valec, které hodné zmensime,
sesadime a spojime, jak je vidét na obrédzku. Tim mame ptipraven clanek tetizku
ke zkopirovani.

Tuto dvojici nyni budeme ”kopirovat do tvaru” pomoci funkce DupliVerts.
Tuto funkci nalezneme v panelu Object (F7). Vlozime mesh Plane, umazeme
dva boéni vertexy a na vzniklou tdsecku naneseme dalsi vertexy funkei Subdivide
(w). Subdivide opakujeme nékolikréat, podle toho, jak dlouhy fetizek chceme.
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Obrazek 10: Clanek fetizku

Velikost tsecky upravime tak, aby délka jednoho dilku odpovidala délce jed-
noho ¢lanku fetizku. Usecku umistime vodorovné s éldnkem. Nyni vybereme
clanek zmackneme Shift a vybereme tsecku. Usecka by méla mit fialovy obrys
0 néco svétlejsi nez clanek. Stiskneme Ctrl p a potvrdime. Koule se tak stala
nadrazenou (parent) ¢lanku (child). Funkce DupliVerts vytvori za kazdy vertex
rodi¢ovského objektu jeden duplikat podiizeného objektu . Tyto kopie jsou zatim
jen virtudalni, takze pii renderu se vSechny objevi, ale nejsou samostatné, tzn. kdyz
néjak zménime puvodni objekt, zménime tak i vSechny jeho kopie. Z virtualnich
kopii vytvoiime redlny objekt pomoci funkce make duplis real (Ctrl Shift a).
Retizek zakonéime jednou vétsi kulickou (mezernik, Add, Mesh, UVSphere).
Vsechny vzniklé ¢lanky spojime funkei join (Ctrl J) a ptitadime jim vhodny ma-
terial.

Obrézek 11: Retizek a panel funkce DupliVerts

Stinitko

Vlozime kouli (mezernik, Add, Mesh, UVSphere) a vzdy tii patra od pdlu
vytdhneme pomoci magnetického néstroje (o) spolu se stisknutou klavesou Ctrl.
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Poté odstranime spodni polovinu titvaru a pomoci magnetického néstroje upravu-
jeme tvar stinitka podle své fantazie. Pritadime stinitku vhodny materidl (napf.
sklo) a sesadime vSechny ¢asti lampicky dohromady. Jesté muzeme roztdhnout
podstavec, vypada-li lampicka prilis vratce.

Obréazek 12: Hotova lampicka



3D Studio Max - Tutorial

Tento tutorial slouzi jako navod k nékterym moznostem, které nabizi 3D Studio
Max. Cilem je vytvorit tuto scénu:

Model vytvorime pomoci krivek, kterymi nakreslime obrys télesa a nasledné
prevedeme do tri rozméru diky modifikatoru "Lathe". Objektu v scéné
priradime nékolik bitmapovych a tzv. "bump" textur. Nakonec celou scénu
osvétlime bodovym a smérovym svétlem.

Modelovani

Obrys objektu:
Nejdrive nakreslime polovi¢ni obrys objektu.

1. Prepneme se na zobrazeni ze predu (front view).
2. Na panelu "create" klikneme na "shapes" a nasledné vybereme "line".
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3. Na roletce "Creation Method" zaklikneme "Initial" a "Drag Type" na
"Corner". To zpusobi, ze vSechny ¢asti ¢ary budou rovné.

|- Creation Methad |
~ Initial Type
& Comer
" Smoath
—Dirag Tupe
® Cormer
" Smaath
" Bezier

4. Vytvorime pomoci klikani pozadovany obrys objektu. V nasem pripadé
vazy. Nakonec uzavieme caru kliknutim na pocatec¢ni bod a potvrzenim
hlasky "Close spline?".



Nyni upravime obrys do pozadovaného tvaru.

1. Nyni budeme upravovat jednotlivé body. Toho docilime tak, ze na panelu

"Modify" E| v roletce "Selection" klikneme na tlac¢itko "Vertex" |7 )
2. Poku se vam nepodarilo vytvorit pozadovany tvar objektu, je mozné

kazdym bodem pohybovat pomoci tla¢itka "Select and Move" é’ .

3. Pomoci tla¢itka "Fillet", které je na roletce "Geometry" mizeme nas
objekt zpresnit. Po kliknuti na pozadovany bod a tahnutim se bod rozdéli
na dva, které se prevedou na beziérovy. Zakriveni se nastavi tak, ze vrchol
oblouky je v misté puvodniho bodu.

4. Body, mezi kterymi maji byt zaoblené Ccary, musime prevést na beziérovy.
To provedem kliknutim pravym tlacitkem na prislusny bod a vybranim
nabidky "bezier".



5. Takto upravime vSechny body objektu.



Prevedeni do 3D:
Pomoci nyni vytvoreného obrysu, vytvorime tii rozmérny objekt tak, ze tento
obrys jakoby obto¢ime kolem osy soumeérnosti. V naSem pripadé kolem osy Z.

1. Oznacime néas objekt a na panelu "Modify" rozvineme nabidku "Modifier
List". V této nabidce zvolime polozku "Lathe".
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2. Aby objekt vypadal tak jak pozadujeme, je treba na roletce "Parameters" v
sekci "Align" stisknout tla¢itko "Min".

3. V zavislosti na tom, jak moc chceme mit objekt hladky, nastavime na téze
roletce volbu "Segments". V nasem pripadé na 32.
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Tim jsme modelovani objektu dokoncili.



Textury

Prevedeni do 3D:

Nyni pokryjeme objekty texturami. Nasi scénu tvori vaza, kterou jsme
vymodelovali v predchozi ¢asti, stll a sténa. Ke spravé materialu slouzi
"Metirial Editor", ktery se otevre pri stisknuti klavesy "M".

1. Nejdrive vytvorime material pro vazu. Otevreme "Material Editor".
OznacCime jednu z praznych kouli na které si pripravime material pro

vazu.
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2. Na roletce "Blinn Basic Parameters" kliknutim na Sedivé policko u polozky

"Diffuse" otevireme nabidku pro vybér barvy. V naSem pripadé zvolime
nejaky svétly odstin hnédé.

|- Blinin Basic Parameters: |
— Self-Hlurnination

|T Ambient; _ I~ Color [0 2
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3. Aby objekt vypadal plasticky, pouzijeme tzv. "bumb-mapping". Tato volba
se nachdazi na roletce "Maps". V polozce "Bump" vybereme mapu typu
"Noise" a nastavime stupén ("Amount") na 50.
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4. Jesté nastavime parametry textury a to na roletce "Coordinates". Polozku
"Tiling" nastavime ve vSech osach na 30.
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5. Zvolenou texturu priradime oznacenému objektu pomoci tlacitka =1

6. Déle vytvorime texturu pro stul. Na roletce "Blinn Basic Parameters"
klikneme na Sedy ¢tverecek u nabidky "Diffuse". Tim otevreme nabidku
"Material/Map Browser" ve které zvolime "Bitmap". Otevieme néjakou
bitmapu vhodnou pro drevény stul.



7. Stejnym postupem budeme postupovat i u textury pro sténu.

Osvetleni

K osvétleni scény pouzijeme dvé svétla. K navozeni dojmu denniho svétla
pouzijeme bodové svétlo (Spot Light), k vlastnimu osvétleni vazy smérové svétlo
(Target Directional Light).

1. Vytvorime smérové a bodové svétlo. Obé nalezneme na panelu "Create" v
sekci "Light".
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2. Po umisténi nastavime pozadovany smér.

3. Smérovému svétlu navic povolime zobrazovani stinti. To udélame tak, ze na
roletce "General Parameters" v sekci "Shadows" zaskrtneme polozku "On".
Ddle nastavime intenzitu a barvu svétla, oboji nalezneme na roletce
"Intensity/Color/Attenuation".
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Robrazeni scény

Nyni jiz stac¢i jen scénu vyrenderovat. Tu to moznost najdeme v hlavni nabidce
pod "Rendering". Kliknutim na polozku "Render" nebo stisknutim klavesy F10
se nam otevre nabidka pro renderovani, kterd ma velmi mnoho moznosti. Nam
postaci kliknout na tlacitko "Render".
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Matusalem

Tomas Palyza

30. srpna 2007



Jako vzor pro kresleni 3D modelu poslouzila ldhev Matusalem. Lahev ma
jednoduchy tvar. Jemné zvlnéné hrdlo.
Postup kresleni:

1. Vlozime kruh - menu Add/Mesh - Circle s 32 vrcholy, prepneme se do
néhledu kamery (1), kruh zvétsime cca o 40% funkef (s).

sy [T T
Ul g e s T N ]

Obrazek 1: Kruh

2. Funkef extrude (e) (only edges) protahneme kruh nejprve smérem ke
dnu lahve podle osy z Déle oznac¢ime vrcholy, odkud jsme zacinali
protahovat od kruhu smérem dolii a dokonéime hrdlo 1dhve stejné jako
smérem ke dnu pomoci funkce extrude a zkoseni (s).

3. Dno a vrsek ldhve je nutné uzaviit. Oznaéime horni vrcholy pomoci (b),
zduplikujeme vrcholy opét funkef extrude (e) (only edges) a zmackneme
ESC. Dale funkef Mesh/Vertices - Merge uzavieme - odstrani se 31
vrcholu. To samé provedeme s dolnimi vrcholy (viz obr. 2).
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Obrazek 2: Extrude

4. Nyni separujeme hrdlo 1dhve od zbytku - ozna¢ime (b) hrdlo ldhve a

funci separate (p) oddélime hrdlo od zbytku - tvaii se jako jeden objekt.

. Nyni hrdlo i zbytek 1dhve vyhladime pomoci Mesh/Faces - Set Smooth,
objekty selektujeme v Object mode a pfepiname se zpét do Edit mode.

. Dédle hrdlo obarvime rudou barvou. Hrdlo oznacéime a
prepneme se menu Material buttons. Zde klineme na Add new a
prejdeme do Texture buttons (F6) zvolime libovolnou texturu,
prejmenujeme tuto texturu napi. na ”vrch”. Déle se pfepneme na zalozku
Colors a zobrazime si zmacknutim Colorband barevné listy. Vymazeme
v8echny prechodové pozice pomoci Del. a zvolime rudou barvu (0.46; 0;0).
Nyni se prepneme do menu Material buttons a na zédlozce Texture
zvolime tuto nové vytvoreno texturu “vrch”. Vyrenderujeme-li nyni,
vidime rudé zbarvené hrdlo (viz obr. 3).

7. Zbytek lahve bude z ¢irého skla. Nynf ozna¢ime v Object mode zbytek



N R T

Obréazek 3: Rudé hrdlo

ldhve a pfejdeme zpét do Edit mode. Prejdeme do Material buttons,
klikneme na new a piejdeme do Texture buttons. Zvolime jakoukoliv
texturu, pojmenujeme texturu napi. “spodek” a prejdeme na zdlozku
Colors. Vybereme bilou. A dédle nastavime:

(a) Menu Material Buttons, Zalozka Material - Alpha: 0.1

(b) Menu Material Buttons, Zdlozka Shaders - Reflectivity: 0.2, Spec-
ularity: 1.5, Hardness: 511, Translucency: 1, Ambient: 0.5, Emit:
0

(¢) Menu Material Buttons, Zalozka Trans - Ray Mirror: enabled, Ray
Mirror: 0.2, Ray Transparency: enabled, IOR: 1.37

(d) Menu Scene, zdlozka Render, Ray: enabled

8. Lahev je hotova a je tfeba nastavit osvétleni a kameru. Pfepneme se do
Object mode. Nasméiujeme kameru tak, abychom zabrali celou ldhev
a rozumné velké okoli. S kamerou pohybujeme bud’ pomoci sipek podle
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os nebo chytneme mysi a premistime. Smérovani kamery se nastavuje
pomoci (r) a mysi. Déle vlozime lampu - Add/Lamp - Lamp. Pohybu-
jeme stejné jako s kamerou.

9. Nyni do okoli ldhve vlozime pozadi a to prostfednictvim krychle.
Ptrepneme se do ndhledu kamery (1) a levym tla¢itkem mysi klikneme
nékam mimo ldhev. Prosfednictvim Add/Mesh - Cube vlozime krychli.
Pomoci (s) zvétsime tak, aby celd ldhev byla ukryta v krychli. Nyni
odstranime horni vrchol, ktery je nejblize ke kameie (kameru a lampy
piipadné vhodné premistime). Oznacime zbytek krychle a v menu Tex-
ture buttons ho vhodné obarvime. Vysledek vidime na obr. 4 a 5.

N O TN TN TN ]

Obrazek 4: Hotova scéna

Ut



Obrazek 5: Hotova renderovand scéna



Model ramového setu v Blendru

Pokusil sem se udélat vizualizaci svého ramu v programu Blender. Vysledek vypada takto.

V tomto tutoridlu bych chtél popsat postup, jakym jsem tento rdm a zdkladni komponenty
modeloval.

Nejdiive jsem zacal d¢lat samotny rdm, zacal jsem s hlavnimi trubkami. Abych si mohl hrat
s profilem trubek, pouZil sem metodu modelovani pomoci Bezierovych kiivek. Zacal sem
tedy spodni rdmovou trubkou, kterd ma trochu ovdlny tvar. Bezierovu kiivku vloZite
v editaénim médu stisknutim SPACE a volbou Curve—Bezier Curve. V bo¢nim pohledu
upravite kiivku na dsecku a vloZite dalsi kiivku BEZIER CIRCLE, kterd bude pfedstavovat
profil rdmové trubky z ptedniho pohledu. Profil je dobré si néjak pifejmenovat.




Jméno profilu potom vloZite do kolonky BevOB a dostanete néco takového.

No a ted’ si chvili jen hrajete s tvary trubek a sloZite hlavni rdimovy trojihelnik. J4 mam

Jediny problém byl dole s mistem pro stfedové sloZeni. Abych docilil vetsi realistiCnosti svart
pouzil sem magnetického pole. To se aktivuje kldvesou O.

Silu jakou ptisobi pole na ostatni vertexy ovlivitujete pomoci prostiedniho tlacitka na mysi a
muZete si vybrat z n€kolika méda pole. Ja nejcastéji pouzival SMOOTH FALLOFF. Po
otfezani ptebyte¢nych trubek jsem se pustil do zadni stavby.



=[R2 Madsl | [=[5cEsSrene

Zadni vidlici jsem vytvoril opét pomoci kfivek. Zde je tieba si ddvat pozor na zachovani
symetrie a na to, aby bylo dost mista na zadni kolo. Jak miiZete vidét na obrazku , nejdiive
jsem udélal jen jednu polovinu vidlice, kterou jsem poté zduplikoval SHIFT + D. Jesté ji bylo
potieba zrcadlové pievritit pomoci kldvesy M. Ted uZ stai jen spravné pfesunout na své
misto a dat si pozor, aby to bylo symetrické. Nyni mame rdm skoro hotovy.

Jeste tomu chybi patky na chyceni zadniho kola. Ty jsem také délal pomoci kiivek. Nejdiive
jsem si v bo¢nim pohledu udélal obrys patky pomoci Besierovych kfivek, které pomoci
extrude E navazujete na sebe a modelujete az dostanete obrys. J4 dostal néco takového jako je
na dals{ strdnce. Potom kiivku uzaviete a ud¢late z ni uzavienou plochu pomoci Togle Cyclic
( skratka C ).



Pomoci ALT+C konvertujete na Mesh. Piepnete se do bo¢niho pohledu a pomoci extrude E,
roztdhnete na patficnou tloustku. Pak to opét zduplikujete i pro druhou polovinu vidlice a
mate vysledek.

Nyni se pustime do ptedni odpruZené vidlice. Ta by se méla podobat Bomberu z roku 2003.
Musim pfiznat, Ze korunka vidlice se mi iplné€ nepovedla a chtéla by jesté trochu dotvarovat.
Zacal jsem uchytem k hlavovému sloZeni. To jsem ud¢lal z vilce
Add—MESH—CYLINDER a zmensil horni podstavu S. Korunku jsem také délal z vdlce,
na ktery jsem pfilepil z obou stran piilkoule Add = MESH—UVSPHERE a poté modeloval
vertexy pomoci magnetického pole a klasickym piesunem G. Postup je vidét na obrazku.



Vysledek po duplikaci a zrcadleni je na ndsledujicim obrazku.

Na to jsem udélal z valcti nohy a na né¢ opét stejnou metodou dchyty na kola, jako u zadni
stavby. Takhle vypada vidlice ve vysledku.




Nakonec ndm zbyvd pfedstavec s fiditky, sedlovka a sedlo. Jediné zajimavé z hlediska
technické stranky je sedlo. Ostatni komponenty jsem délal stejnymi technikami jako pfedtim.
Pti modelovani jsem vySel ze sféry SPACE—-MESH—UVSPHERE. V bo¢nim pohledu
jsem v zadni ¢asti koule sloucil body ke stfedu pomoci funkce MERGE, kterd se nachazi pod
klavesovou zkratkou W. Jediny bod, ktery tu zbyl jsem posunul do roviny ostatnich boda a
pomoci magnetického pole jsem protdhnul piedek sféry. Vysledek je zndzornén na

ndsledujicim obrdzku.

Zavérem jsem odstranil dolni polovinu a poupravil vrsek sedla, aby nebyl tak zaobleny. Timto
je témér tvar kola hotovy. Po pfepnuti do materidlového médu FS jsem nastavil texturu a
barvy jednotlivych komponent. VSechny kovové komponenty jsou pfiblizZné stejné s vyjimkou
sedla, u n¢jZ jsem nastavil hrubsi povrch pomoci textury NOISE. Nakonec jsem pfidal textury
na pozadi z obrdzk pomoci LOADIMG. Kone¢né vysledky miiZete vidét zde.






Model sklenice

Jan Silar

20. zaxi 2007

1 Uvod

V tomto tutoridlu se snazim popsat postup, jak jsem vytvaiel model sklenice v programech Rhinoceros a
3DMax. Prvni program je vhodny pro technické modely. Protoze sklenice vychézi z celkem jednoduchych
geometrickych tvarl, pfipada mi jeho volba vyhodné. Pro renderovani vyexportujeme model do 3DMaxu.

2 Modelovani nadoby v programu Rhino

Nyni vytvoiime model hrnku.

2.1 Pracovni plocha

|| Prikaz _Delete
Hlpikaz:

i pio tElesa

¥ e et | zaka | ) _ B
:_:'.”[ Rk ]_ frta .|. m«@;] g

Rhino - pravy pohled



2.2 Pojmenovani vrstev

AR RGO PP HasoLmSU0

iisediy [ Nonnsla FodOhlem Vertikala Cryifiody Osahiu Kolrice Tens Frodlouteni |

V okng "Vrstvy" pojmenujeme jednotlivé vtstvy (kfivky, plochy), v kterych budeme pracovat.



2.3 Vytvofreni pomocnych ¢ar

[Right]

Iﬁ‘f . e

I Gl bad fesunut

oo o

Vytvoiime pomocné ¢ary - osu a pomocny ramecek sklenice.



2.4 Vné&jsi kiivka

=

i ;-:R'Ug{m'pnk';ﬁﬁem- =] — Lt - i{-

B | — : b 1

Nakreslime do ramecku kiivku stény sklenice (body) - nabidka "Nastroje pro kiivky".



2.5 Uprava vné&jsi k¥ivky

o

| :,';R-u§1'|‘n'p fikaz Tazeni
| 1 P.l'l'kiﬂ:l

Posunovanim bodt muzeme jesté kiivku upravit.



2.6 Vnit¥ni k¥ivka sklenice

[

Funkci "Offset" vytvoiime vnitini kfivku sklenice.



2.7 Uprava vnitini k¥ivky

NEuB s am

| :,';\-’.-ybeft'e Jjbj';_kf?pr_o zahrazent FEdlt:lchhodﬂ &7 hudste ho
| Piikaz: |

Upravime jesté body vnitini k¥ivky, nékteré miizeme umazat.



2.8 Vyrovnani pfechodu vnéjsi a vnit¥ni k¥ivky

[Right]

P =
I@HdFtner
ajenim 3 kiwek venikle 7 kiivka
1kai:

Navazani vnéjsi a vnitini k¥ivky vyhladime fuknci "Plynuly pfechod mezi k¥ivkami".



2.9 Spojeni kfivek v jednu

Obje kiivky propojime v jednu a jes$té mirné upravime.



2.10 Rotace kfivky

S pulit - Bhinocer

i s
DeEftne
E ]5'-‘ Piikaz: _CHa_ng el aysr

|| Piikaz.

Tk [ o [ [ e |

Funkci "Rotovat" vytvofime nddobu a plochu sklenice pfeneseme do vrstvy plochy.
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2.11 Navrh kfivky ucha

Nakreslime a upravime fidici kifivku ucha.

2.12 Navrh profilu ucha

Pouzijeme funkci "Zaobleny obdélnik" pro vytvofeni profilové kiivky ucha.
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2.13 Vytvofeni ucha

"_'rm]:wr |3;|1.c'|i"y' .Fl:lH.Eﬁ' h‘:hﬂ Tekso Trensformars ’ﬁdrt!p Kika  Aralyes Rendor Népoveda

IEHE e c DA p00H~e - umwI00BO L HBL 0

|| RhinnScript byl nahran,

P =0 _[

[¥rstey - Vi vistve e
0|x|o|s|v]e 5 8la]z
[ s O e
krhiky ik}
“ pochy
Layer 07
Layes (13
Layer 4
Laver 05

([ Kon 7 Nei 7 Bod o Pd I S B2 Pili [ Kl 7 et @ kvo 7 el Fedmeél | zabed | _
RV weotsaams: pasi98 an liphm o [Cmk | oo | Ry
8 stant] D v (rc .| L i rogsrs . | Y muroco ancy ~(cs. | 7 soe1slepy - s ]ﬁwﬂ@amwéﬁz "_nu]i: Rhinoceron.

Funkci "Tahnout po jdené trase" - vytvofime ucho.

2.14 Umazani zbytku ucha

Pouzijeme funci "Rozdélit", pro oddéleni ¢asti ucha, které pfe¢niva do vnittku nadoby.Tu umaZeme.

2.15 Export

Exportujeme model do formatu programu 3DMax.

3 Prace v 3DMaxu

Nyni vytvofime scénu. Hrnek postavime na stil (spise kvadr). Hrnku i stolu pfifadime n&jaké materialy,
nastavime osvétleni a kameru. Nakonec scénu vyrenderujeme.

S0E MOQIMIEFS  LNAFacter _keace

Nastroje na obrazku slouzi k zadkladni manipulaci s objekty: Select Object, Select by Name, Rectangular
Selection Region, Select and Move, Select and Rotate a Select and Uniform Scale.
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Na dalsim obréazku je panel s nastroji pro zmény pohledu na scénu. Nejduilezitéjsi jsou Zoom, Pan View

o W L EN Aeid

a Arc Rotate.

3.1 Priprava modelu hrnku

{© Untitled - 3ds man 7 - Stand-alone License = EE
File Edit Tools Gn:lup Wiews Create Modifiers Character reactor Animation’ Sraph Editors REV‘IEIH(‘W\] Customize MmcStnpk Help

==

_1 0 Objects Selected

@M%%%@%@Wﬁh%@%ﬁmEW%@@&

:;% LE ! WE ] r;t 1!8 I 15 ! 2}3 I E _.i. 1!6 J {a’ L ﬁlﬁ

a E il | wl1ass a]uu s Ky [ elected i
: KeyFiters.. AB[E o B
B« et

Naimportujeme model: "File->Import" (Mozna bude potfeba sjednotit objekty hrnku v jeden. To udg-
lame: Oznagime jeden objekt. Menu "Create->Compound->Boolean", v panelu "operation" zagkrtneme
"Union", v sekci "Pick Boolean" zmackneme tlacitko "Pick opera.nd B" a klikneme na druhy objekt,
ktery chceme pfipojit.) A pak jediny objekt hrnku pFejmenujeme v poli "Name and color" na "Hrnek".
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3.2 Krabice

{® hrnek.max - 3ds max 7 - Stand-alone License =lE EF

File Edt Tools Group Yiews Creste Modfiers Character reactor Animation GraphEditors Rendering Customize MaxScript Help

CRFRERF ILRBEUANS IBE £ S ol Rl B
Lo f i Al eE T

Standard Primitives ‘I

<] 0/30 L0 _ o

ﬁ I I % | ‘s 1 ‘%:, T é’ T TL T . Ev I _y]‘{ [7. T.L' ] P % T 2%
Il BT 8 Blxfio  :ifn cefrm  f m-1n

Motart| (B9 3 8 @ D & & Dscensce -3 Maxtu.

BUCTr{C=E 8% 4P @SIOB 2T

244 Td

| SetKey|  KeyFitas.

Ighméj(.max-ﬂ'd"s.mau - 3§ hovy 1, TRT | o GIMP ]

Vytvofime krabici, na které bude hrnek stit: "Create->Standard Primitives->Box", nakreslime mysi
nejdiive zdkladnu, pak vytdhneme do vysky. Pfipadné miZeme néastrojem "Select and Uniform Scale"
upravit znovu velikost a nastrojem "Select and Move" zménit pozici
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3.3 Material hrnku

(® hrnek.max - 3ds max 7 - Stand-alone License
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Upravime material hrnku, aby vypadal nerezové: tlac¢itkem "m" vyvolame nabidku materiali. V "Shade
Basic Parameters" nastavime "Anisotropic”. V oddilu "Anisotropic Basic Parameters" nastavime barvu

"Ambient" a "Diffuse" na svétle Sedou, zaSkrtneme "Self-Illumination",

zaSkrtneme "Color",

barvu na-

stavime ¢ernou, Diffuse Level na 130, "Specular Level" na 200, "Glossines" na 25. V oddilu "Maps"
zaSkrtneme "Reflection", "Amount" nastavime na 80 a tlac¢itkem "None" vlevo zvolime "Raytrace". Na-
konec ozna¢ime pulitr a klikneme na ikonu "Assign Material to Selection".
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3.4 Textura na krabici

(® hrnek.max - 3ds max 7 - Stand-alone License
File Edt Tools Group Views Create Modfiers Character reactor Animation GraphEditors Rendering Customize MAYSCRt Help
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Nyni potdhneme krabici texturou ubrusu, kterou si pfedtim vytvofime v néjakém malovacim programu
(pouzil jsem Gimp). V "Material editor" klikneme na druhou kouli, abychom nepfisli o meterial, ktery
jsme vytvorili pfed chvili. V "Maps" zagkrtneme "Ambient color" Vybereme "Bitmap" a vybereme soubor
s texturou. Podobné aplikujeme novy material na objékt krabice. Aby se textura na krabici zobrazila, je
potfeba zapnout "Show Map in Viewport", ktera je vpravo hned pod koulema.
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{© hrnek.max - 3ds mau 7 - Stand-alone License
File Edit Tools Group Wiews Create Modifiers Character reactor Animation: GraphEditors Rendering Customize  MARScript  Help
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Dale upravime nékteré vlastnosti textury v nabidce "Modify". V nabidce "Modifier List" vybereme "UVW
Map", v "Parameters" zagkrtneme "Box" a nastavime podle potieby parametry "Length", "Width" a
"Height", aby se textura zobrazovala akorat roztazena.

3.5 Osvétleni

Ptidame osvétleni scény: "Create->Lights->Standard Lights->Omni". V "General Parameters" zagkrt-
neme u "Light Type" "On" a u "Shadows" take "On" a nastavime "Area Shadows". Nastrojem "Select
and Move" pfemistime podle potfeby zdroj svétla. A v "Intensity /Color/Attenuation" upravime pomoci
"Multiplyer" intensitu osvétleni. Protoze scéna neni umisténa v néjaké mistnosti, jejiz zdi by odréazel
svétlo, nevypada pohled s jedinym svétlem a tedy s ostrym stinem moc realisticky. Muzeme vlozit jesté
2. slabsi svétlo.

3.6 Kamera

Nyni vlozime kameru. Nastavime pohled "Perspective" tak, jak bychom chteli, aby vypadal render. Po-
moci "Views->Create Camera from View" vloZime kameru.
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3.7 Render
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V poslednim kroku vyrenderujeme scénu. Otevieme dialog pro renderovini "Rendering->Render". V
"Custom" nastavime pozadovanou velikost obrizku. Zkontrolujeme, jestli je "Viewport" nastaven na
na$i kameru. Renderovani spustime tla¢itkem "Render".
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4 Vysledné obrazky
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Tutorial pre Blender 2.41
Igor Skokan, august 2007

V tomto tutoridle vdm ukdZem ako pomocou programu Blender 2.41 urobit’ nasledujiice modely a efekty:

- model polopriehl'adnej flase Mattoni od Srimlnfmmina pomocou pouzitia obrdzku na pozadi
(background image, extrude, material)

- ako nahrat’ na fTaSu etiketu Mattoni (load texture image)

- jednoduchy model vrchndku

- vymodelovat’ priehl'adny skleneny pohdr (extrude, subsurf, material)

- animovat’ pad tekutiny (vody) do pohdra s efektom kvapky (fluid simulation)

Poznamky na avod

Ak pracujete v Blenderi na notebooku, tak ako ja, Blender vim ponika funkciu na emulovanie numerickej Casti
klavesnice tzv. NumPad, pomocou jednoduchého nastavenia v menu.

MysSou "dragé&drop" potiahnite hornu liStu pod menu smerom nadol a zakliknite v ponuke System & OpenGL a
oznacte Emulate Numpad

© Blender

[ o Lock ||| Hide dotfilerdatablock | |

Takto sa budu ¢isla na vaSom notebooku chovat’ akoby boli umiestené na NumPade a budete si moct’ pomocou
nich prepinat’ jednotlivé zobrazenia scény.

V celom tomto tutoridly budi nasledujice skratky oznacovat’
LM - Tlavé tlacitko mysi

RM - pravé tlacitko mysi

MM - prostredné tlacitko mysi

N#— NumPad #

1. Model fPase Mattoni od pininfarina

At NuriPad /) pre 3D modelovanie redlnych objektov plati obecnd zdsada, Ze je dobré mat’ po
wEORwaBERnE NumPad 31 ryke naskenované foto, alebo asponi fotorealisticky obrazok modelovaného
Bl i il objektu. V takovom pripade je potom moZné pouzit’ tito fotku ako "background
2'2?“ :EEE:: 13 image" v Blenderi a modelovat’ objekt presne podl’a obrysov na obrazku.
v Top NumPatl 7
Camera MumPad 0
et 1. Otvorte novy blenderovsky stbor (File — New, alebo CTRL X) , oznacte
_ W defaultni kocku RM a vymaZte ju DEL a ENTER.
. B PR 2. Stlacte View — Background Image, a potom kliknite na tlacitko Use
Background Image,g a Vyhl’adajteg sﬁbcf)r mattoni.jpg



W

10.

Na obrazovke sa vam zjavi vybrany obrazok, ktory budeme modelovat’.
Modelovat’ budeme pomocou jedného z najpouZivanejSich [ =]scEScens
ndstrojov v Blenderi extrude, ¢o je automatické predlZovanie I i
hran, bodov, priamok, duplikovanie profilu, a podobné
zaleZitosti.

Najprv vSak priddme prvy hlavny objekt — valec. Stlacte Add -
Mesh — Cylinder a ponechdme 32 vrcholov (Vertices: 32)
Doporucujem vam pocas modelovania sa prepntt’ do "drétového
zobrazenia objektov" (Wireframe), pretoze tak budete lepSie
vidiet’ skrz objekty a budete moct’ s nimi lepSie pracovat. Toho
dociel'te jednoducho tak, Ze vyberiete z ponuky vedl'a médu
namiesto Solid — Wireframe

Draw type:
0 Textured
& Shaded

£F Solid

= Bounding Box
A Edtvose =) [FRTE =T

Prepnite sa do pohl'adu spredu (Front View, N1), pribliZte si
pohlad skrolovanim MM a potom stlacenim klavesy G (Grab)
mySou presuite valec tak aby jeho stred bol umiestneny presne
zaroven so stredom obrdzku v pozadi.

8. Stlacte A (All) a odznacte vSetky vrcholy.
Stlacte B (Box) a oznacte vSetky vrcholy v
spodnom rade. Stlacenim S (Size) a X
(vyber osi) a pohybom mysi nastavte
spravnu velkost’ spodnej hrany flase.

9. Odznacte oznacené vrcholy kldvesom A, a
pomocou stlacenia B, oznacte horné
vrcholy. Pomocou G, Z zniZte vysku
valca, tak aby licovala s d’alSim vyraznym

bodom na fl'aske. Dalej opit’ pomocou S, X nastavte spravnu §irku.

PresvedGte sa, e mate oznaGené horné vrcholy. Ak nie, oznadte ich. Dal§im krokom je uZ pouZite samotnej
techniky extrude na automatické prediZenie tvaru smerom nahor, v smere osi z. Stladte prosim E a hned’ za
tym ENTER a potom Z (E je extrude, ENTROM vyberiete z ponuky Region a Z je pre os po ktorej chceme
objekt automaticky predlZovat’.) MySou (alebo kldvesom Sipka nahor) t'ahajte valec smerom hore k



d’alSiemu vyraznému bodu flase. Ak ste s vySkou spokojny stlacte ENTER. Pokracujte stlacenim S, X a
nastavenim spravnej Sirky valca, tak aby pekne licoval s obrazkom v pozadi.

11. Bod 10, opakujte pre vSetky vyznacné body na fl'asi, ktoré svojou polohu
prispievaju k jej tvaru. Chce to trochu cviku, ale nakoniec vysledok bude stat
zato. Takto vymodelujte aj komplikované Casti na hrdle fI'ase. Nemodelujte
zatial’ vrchndk.

12. Stlacte TAB (prepnite sa do Object mode, méd objektov) a stlacte F9 (panel
Link and Material) a dole zakliknite SetSmooth, to ndm ostré hrany z
modelovania prepocita a objekt krasne vyhladi.

13. Ked’ budete hotovy, uloZte si stibor F2 a stlacte N (Transform properties), a
pomenujte tento objekt (fI'asu) PininFarina.

14. Stlacte F12 a vyrendrujte si Co ste zatial’ vymodelovali.

15. Teraz je potreba nastavit’ spravny materidl (polopriehl'adné zelené sklo) a nahrat’ na fl'asu etiketu Mattoni.
Stlacte F5, a v ponuke Material stlacte Add New. Pomenujte ho "Mattoni zelena" a nastavte hodnoty farba
Col (Color) — R: 0.002, G: 0.341, B: 0.000 a priehl'adnost’ A (Alpha) : 0.555

i Cranps
| =] vt mattoni zelena, | x]s] F Eand
[ME:Zone [ce MR imati o

| vzol Light] ucol Paint] TenFace | shadeless |
|_Full 05| Stands Wi Zinvert |

(el T R —

Spe || 50541 -

i || B 0.000 —————

[ hsv] ovn| (2 0.555 — |




16. Prekliknite sa do podponuky Shaders a vypliite nasledujice Lambertov odraz Ref: 0.8 (reflexion), Cook
Torrov zrkadlovy odraz Spec 1.0 (specularity), vypnite poklikanim Radio (Radiosity), nastavte prenikavost’
Hard: 255 (hardness) a emisie Emit na 0.8

Shaders

Ilirvor Transp

[Lambert =] Ref 0.200 ssssssr || Hala

| CookTor 2 || Spec 1 ooomesss | TR

[Hard:z55 msssr | [Treshads
Bias

| Trnslucency 0.00 el |
| Amb 0,500 s [Emit 0500 m—

17. Vo vedlajSom panely Mirror Transp zase zakliknite ZTransp a nastavte Add na 1.000

Shaders Hlirvat Transp
Ry Hirrar
Raghfirooo |« Depthez -
Frasnel 0.00] [Fac12s
+ 2offs: 0.000- Ry Transp
IOFR 1.00 o |4 Depth:z -
Fresnel 0.00] [Fac 125

| SpecTre. 1. oms— [add 1000 s—

| onlwshadow | mowist | En |

18. Tak a eSte priddme na fl'aSu etiketu Mattoni, ktord mdme v GIF stbore mattoni-etiketa.gif. V panely
Texture Uplne vpravo vyberte napr. 5 kandl a kliknite na Add New. Textliru pomenujte "Vineta" a stlacte
F6 (Shading menu), kde zmeiite typ textiiry Texture Type — Image (obrdzok). V panely Image, nahrajte
obrazok zo stiboru pomocou Load Image. Stlacte Clip (obrdzok sa nebude opakovat’) a pretoZe GIF sibor
obsahuje transparentnu farbu pozadia, stlacte UseAlpha, ¢im aktivujete priehladny mdéd a transparentnd
farba sa nebude zjavovat’.

v o ool W image

[ElTEvinete [RIlF| IrtetPol | UseAlphs m

warld Tesshre Tupe . 1
e [image 2 [z Maannmmﬂﬁwmamﬂlilxl1
- Ll:-a.-:llma.-ge | [1%]  reload |
Extend Eﬂchncub.el Repeat | Checker
[ WinEosan [0 MaaRt000 ¢
Defalt Vars WY 0000 | Wesv 000 o

19. Stlacte opit’ FS a vratte sa do ponuky Material. Vyberte zdloZku Map Input a v nej zakliknite Flat,
nastavte posun obrazku (ofset), ofsX: 0.05, ofsY: 0.5, ofsZ: 0.00 a velkost’ obrazku ako sizeX: 1.00, sizeY:
4.00 a sizeZ: 2.40

fiap lnr‘g

[ ow | Object
[ clob stick | win | mor [ ped
Cube + ofs®ooso
Tube | sphe ¢« ofs¥o.s500 -
+ ofsZooon ¢
Y2 < sizeM 100 -
b < sizev 400 -
LA | sizeZ2 240 ¢




20. Rendrujte model F12. Mali by ste dostat’ nieco takéto:

IL. Jednoduchy vrchnak na fl’asSu

Aby bol dojem a vnem fT'ase dokonalejsi je potrebné ju uzavriet peknym vrchndkom, ktory potom nasadit’ na hrdlo
a nafarbit’ nabielo. Pri modelovani vrchndku nebudeme vychadzat’ z obrazku, ale budeme ho modelovat’ rovno
pomocou tvarov ktoré su k dispozicii v Blenderi.

Najprv sa ndm neplietla fl'asa z vrchndkom, odloZime si fl'asu do inej "dimenzie" stlacenim M (Move) a 2. Tym
sme presunuli na§ model do 2 vrstvy, kde si zatial ponechame.

1. Startovacim tvarom pre vrchnak je kruh (circle). Stladte
N7 a ubezpecte sa, Ze sa nachddzate s pohl'ade zhora (top
view). Stlacte Space — Add — Mesh - Circle a vyberte 40
vrcholov (40 vertices) a ENTER.

2. Oznacte vSetky vrcholy kruhu stlatenim A a potom
extrudujte E len vrcholy (Edges only) a ENTER. Stlacte
S a zmenSite extrudovanim - tahom mysi - dovnitra
povodnej kruZnice.

3. Prepnite sa do pohladu zboku (side view, N3) a
vymodelujte vySku vrchndku pomocou stlacenia G (grab)
a Z (os v smere ktorej potrebujeme zmenit' vysku) a
mySou vytiahnite vnutorny kruh smerom nahor.




. . . 7

4. Prepnite sa do pohl'adu zhora (top view, N7) a zakliknutim oznacte select edges (ta prostredna
palicka) a postupne vyberte pomocou SHIFT+RM kaZzdd druhd hranu ktord vedie medzi oboma
ststrednymi kruhmi. Ked’Ze sme vybrali 40 vrcholov, vyjde ndm to akurat na preskdcku, Ze oznacime 20
hran.

5. Teraz stlacte S (Size) a tahom mysi roztiahnite smerom von, a7 dostanete akusi Strbavu Struktiru. Zdklad
nového vrchndku. Teraz uZ len poloZit’ na tento zdklad vrchndku d’al$iu kruZnicu a nastavit farbu a
vlastnosti jeho materidlu.



6. Odznacte vSetky oznacené hrany A, a prepnite sa do médu oznacovania vrcholov (Vertex select).
Umiestnite svoj kurzor priamo do stredu Struktiry a stlacte Space — Add — Mesh — Cylinder, nastavte 40
vrcholov a dajte ENTER. Pomocou S (Size) zmenSite valec tak aby sa I'ahko dotykal vnitorného kruhu.




7. Prepnite sa do pohl'adu zboku (side view, N3) a posuiite cely valec klavesmi G,Z a mySou dole, tak aby
vrchnd Cast’ vrchndku a vrchnd Cast’ pripravenej Strbavej Struktiiry spolu licovali.

8. Odznacte vsetky vrcholy A, a pomocou B (Box select) oznacte spodné vrcholy valca. Stlacte X a zmazte
najprv hrany a steny (Edges&Faces) a to isté eSte raz stlacte X a vyberte vrcholy (Vertices).

9. Tvar vrchndku je hotovy, eSte nastavime farby, uloZime a pripevnime na flasu.

10. Stlacte F5 (Material) — Add New a nastavte farbu Col na
R:1.00, G:1.00, B:1.00, tym priradime vrchndku bielu
farbu.

11. Stlacte pri polozke Global druhé okienko, ¢im sa
prekliknete na druhd vrstvu, kde mame odloZenu flasu.
Oznacte fT'asu poklikanim, stlacte M a 1, ¢im zase
vratime fl'aSu do prvej vrstvy kde mame pripraveny
vrchndk. Na obrazku je dole vedl’a Global okienko
urcujice v ktorej vrstve sa aktudlne nachddzame.
Prepnite sa do prvej vrstvy, kde mame naSe oba
vymodelované objekty.

[agioba = HFHHHHHE)




12. V prvej vrstve sa teraz nachddzaji oba objekty. Oznacte si poklikanim vrchndk, stlacte kldvesu G a hybte
vrchndkom aZ kym ho nenasadite presne na vrch fl'aSe. MoZno bude nutné vrchndk zmenSit” alebo zvacsit’
¢o jednoducho dosiahnete stlacenim S a pohybom mysSou na potrebnt stranu. Prepinajte si medzi pohl'admi
zboku Side View N3, spredu Front View N1 a zhora Top View N7, aby ste vel'’kost’ a polohu vrchndku
urcili uplne presne.

13. Pomenujte vrchndk N ako "vrchnak", uloZte sibor F2 a rendrujte F12. Vysledok vyrendrovania vidite na
obrazku.

II1. Priehl’adny pohar

V tejto Casti tutoridlu sa uZ budeme pripravovat’ na poslednu Cast’, simuldciu pohybu tekutiny (vody) ako
kvapne do prazdneho pripraveného pohara.

Najskor sa prepneme do druhej vrstvy, aby sa ndm pri modelovani pohdra neplietli do cesty fl'asa s vrchndkom.
Pohiar vymodelujeme pomocou metédy extrude a subsurf z jednoduchého valca - trubiCky. Potom mu
nastavime vhodné vlastnosti, ako priehl'adnost a spravne parametre pre odraz svetla. Pohar nakoniec
naaranzujeme ku fl'asi a pustime sa do poslednej Casti.



1. Najprv priddme na modelovaciu plochu obycajny valec. Stlacte Space — Add — Mesh — Tube, 32 vrcholov

2. Podobne ako pri modelovani flaSe, najprv ztizime dno. V Edit mode odzna¢ime vSetky vrcholy tla¢idlom
A, potom pomocou B ozna¢ime spodni podstavu valca a pomocou S ziiZime na poZadovanu vel'kost' v
smere 0s X, Y. (Staci stlaCit’ S a potom t'ahat’). Aby sme vytvorili pevné dno staci ak teraz stlacime
SHIFT+F (create face alebo fill).

3. Oznacime opit pomocou B tentokrat hornii podstavu a pomocou G nastavime v smere osi Z pozadovanu
vysku. Dalej pomocou extrudovania (E, Z) "vytahujeme pohar" do vysky a vZdy patriéne upravime $irku
nadstavby pomocou tlacitka S (v smere oboch osi X a Y). Pre kontrolu doporucujem obcas pozriet’ ako
vyzerd pohdr z iného pohl'adu napr. z Top View N7 alebo z pohl'adu rendrovacej kamery NO.

4. Ak sme s tvarom pohdra spokojny, prejdeme k vytvoreniu jeho vnttornej Casti, teda tam kam budeme
nalievat’ tekutinu. V bo¢nom pohl'ade (Side View N3) oznacte vSetky vrcholy A, a extrudujme cely pohar
do vnitra pomocou Skdlovacieho nastroja S.




5. Aby bol pohir pekny zaobleny staci teraz stlacit’ F9 a kliknit’ vpravo dole v ponuke Links and Materials
na SetSmooth.

6. Priehl'adny pohdr vyrobime s pomocou nasledujicich nastaveni, stlacte F5 a chod’te do panelu Materials
kde vytvorte novy pomocou Add New. V paneli Shaders nastavte Lambert Ref na 0.8, Cook-Torrov odraz
Spec 1.329 a vysoki odolnost’ Hard na 473. V paneli Mirror Transp zase nastavte RayMir na 0.15, Fresnel
na 5, zakliknite RayTransp, nastavte hibku Depth na 7, index odrazu IOR na 1.55 a Fresnel 5. Postupujte
podla priloZenych obrdzkov.

Shaders

La.mber‘r =
lCDDkTDH Spec | F2oEEmm—mT
Hard:473 S

Translucency 0.00
AMmb 0,500 s J Emit0.000 |

7. Rendrujte F12 aby ste videli vysledok

IV. Celkovy pohl’ad na scénu alebo hra so svetlom

hirrar Transp
Rahir 0.1 5
Fresnel SIZIIZI_J Fac1.25 |

2Tr3.ns|:- Ry Trensp

T T L —

JE@

| ordwshadow | womist | Erit |

Ak dame vSetky tri doteraz vymodelované objekty na prvu vrstvu (v Object mode postupne oznacujeme
jednotlivé modely kldvesom M a stlacte 1) méZeme ich naaranZovat’ na kameru, nastavit’ svetld a vycentrovat’
pohlady.




1. Ak mdte vSetky objekty v jednej scéne, prepnite si na pohl'ad
rendrovacou kamerou N0 a skontrolujte vysledny obrdzok. Ak
bude nie¢o mimo aktudlny zaber je potreba objekt presundt’ tak
aby bol kamerou vidiet' v poZadovanej polohe. Stlacte ALT+R a
vymazte vSetky rotdcie kamery.

2. Prepnite si do pohl'adu zhora N7 a v Object méde, oznacte RM
lampu. Presuiite ju tak aby sa nachddzala priamo na kamere.
Stlacte R a rotujte paprsok tak aby sa trojica nachadzala v
priblizne centre lucu paprskov vychddzajicich z bodového
svetla. Stlacte FS a prenastavte jej typ na Spot (bodové svetlo) a
pridajte jej energiu Energy napr. na hodnoty okolo 1.7 aZ 1.8.

3. Pridajte d’alSiu lampu, stlacenim Space — Add — Lamp a umiestnite ju za scénu. Experimentujte s jej
polohou aby ste dosiahli ¢o najvernejSieho zobrazenia tieniov a objektov.

4. Rendrujte stlacenim F12. Vysledna scéna by mohla vyzerat’ napriklad takto:




V. Animacia kvapky padajucej do pohara

Toto je podl'a mojho skromného pohl'adu najzaujimavejsia Cast’ tutoridlu, ked’ do teraz pripravenej scény priddme
dynamicky pohyb kvapky vody padajicej do priehl'adného pohdra. Blender je Specidlne dobre pripraveny na takéto
poziadavky a pomoZe ndm vlastne vSetko vypocitat’ a nasimulovat’.

Pre tspes$ni animdciu kvapky vody budeme potrebovat’ 3 zdkladné veci: kvapku (vyuZijeme objekt typu
Icosphere), nddobu (vyuzijeme pripraveny pohdr) a doménu — oblast’ scény, kde sa bude dynamicky pohyb
odohravat (najjednoduchsie je vyuZit’ kocku Cube, ktorou obklopime scénu s fl'aSou, pohdrom a kvapkou)

1. Stlacte TAB a prepnite sa do Object mode. Zobrazte si scénu pomocou pohl'adu zhora Top View N7 a
umiestnite kurzor doprostred pohara. Stlacte Space — Add — Mesh — IcoSphere a ENTER. Nechajte
Subdivision defaultne na 2, toto nastavenie zmenime neskor. Prepinajte pohl'ady a naaranZujte budicu
kvapku, tak aby pri pohybe smerom nadol spadla priamo do pohara.

2. Kliknite RM na prave pridanud IcoSphere a stlacte F9. Na paneli Modifiers, stlacte Add Modifiers, vyberte
SubSurf (subsurfaces — podplochy) a kliknite. Toto nastavenie spdsobi, Ze sa povrch kvapky automaticky
rozdeli na mensSie plosky a objekt kvapka bude vyzerat’ realistickejSie. Na paneli na opacnej strane Links
and Materials, stlac¢te SetSmooth — to preto, aby bola kvapka jednoliata.

3. Majte stdle oznacent kvapku a stlacte F7 (Physics, fyzikdlne nastavenia), vyberte panel Fluid simulation,
kliknite na Enable a zakliknite Fluid. Tymto ddme Blenderu vediet’, Ze tento objekt md povazovat’ za
tekutinu. Je mozné dokonca nastavit’ pociato¢nt rychlost’ pddu v smere ktorejkol'vek osi. MoZete si

zaexperimentovat’.
Lo modifies  EEIL Fluid Simulafion
Add hodifier To: Sphere.0id Domain GO obstacle
(s JofEE O @@ % infow_| ouffiw |
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| Apply
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4 Levels: 1
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4. Aby bol efekt padania dokonany nastavime eSte pomocou F5 materidl nasej kvapky. Chceme napr. aby
vola priehl'adnd s trochou modrej farby. Nastavte farbu na modru, vynulovanim Cervenej a zelenej a v
panely MirrorTransp, nastavte Ray Mirror na 0.21, IOR na 1.55, Fresnel na 5 a druhy Fresnel na 2.85. Je to
podobné ako pri priehl'adnom pohdri. MdZete trochu experimentovat’, a napr. vyrobit’ mlieko ¢i aj pivo.
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5. Kliknite RM teraz na pohar, stlacte TAB a prepnite sa do Edit médu a stlacte CTRL+N (Recalculate
normals outside?)a ENTER. Blender prepocital kolmice na plochy na pohdri tak aby smerovali von z
pohdra, tento krok je potrebny aby Blender vedel ked’ bude simulovat’ pohyb. Teraz stlacte F7, na paneli
Fluid simulation, zakliknite Enable a vyberte
Obstacle. To znamend, Ze pri simuldcii padu tekutiny
sa bude pohar (celym svojim tvarom) chovat ako
prekdzka. Pripadne moZete nastavit’ aj flaSu ako
Obstacle, presne tym istym spdsobom, nie je to vSak
nutné.

6. Teraz musime pridat’ na scénu doménu, v ktorej sa
bude dynamicky pohyb odohrdvat’. Stlacte Space —
Add — Mesh — Cube a pridajte na scénu kocku.
Pomocou S a G, ju zvicsite a umiestnite tak aby
zahriiovala vSetko (vratane kamery a oboch lamp) ¢o je
umiestnené na scéne. Kontrolujte rdzne pohl'ady zhora,
zboku, spredu.

_=) B HE (@)

_ Fluid Simuladian
Domain Fluid
Inflow | Cwtlow

Mo additional settings as of now...

7. Kliknite F7, panel Fluid simulation a Enable a potom Domain. Zmente obe Resolution (rozliSenie i
preview aj final) na 100 a dplne dole vyberte nalistovanim do¢asny adresar kde bude Blender ukladat’



medzivypocty, medzirendre a spracovavat’ animdciu. Tak sme ziskali objekt — doménu, kde sa pohyb bude

z )
odohravat’.
l —
Diomain Fluid Obstacle AR | Same framing settings | PaL
| inflow | cutfiow ”Tf:”':;*
De
| Defalt |
| Advanceds | B4 KE | o S e
Req. B&KE Memory 200.95 ME Render Daaman e

FAL 1649

Disp. -Qual.: | Preview = | Final = .F"”'L
o e [smi [edso ] [Cow FRCTN eosa ] [united rnd

8. Stlacte F10 (Animation) a na paneli Anim zmeiite koncovy frame (End) na 50, na paneli Format vyberte z
ponuky formatov Avi Jpeg. Pozrite sa na obrdzok vlavo hore.

Domain Fluid | Obstecle
cutlow

[ Advamceds] | BAKE |

Fed. BAKE Memor 200,95 WE

[ Resolufion: 100+ | Preview~Res. 100 |

[ strtfmeooo [ Endfime0so |

Disp. —Gual.: | Prevjew = Final d

9. Stlacte F7 a stlacte Bake. Blender za¢ne animovat’ pad kvapky do pohdra na 50 frameoch. Bude to chvilku
trvat’ a o priebehu vds bude informovat’ v status okne hore na obrazovke v
P | 5 baking fluids 26 /43 |

policku "baking fluids".
-

10. Po skonceni "pecenia tekutin", stlacte ALT+A a sledujte priebeh padu kvapky na scéne. Ak budete chciet
prerusit’ ndhl'ad animécie a pokracovat’ v prici stlacte ESC. Ak chcete moZete nalistovat’ ktorykol'vek
frame pomocou §ipok «—, — a stlac¢it F12 a vyrendrovat’ aktudlnu scénu. Vidime, Ze okrem padajice;j
kvapky je vidite'nd aj podvodna IcoSphere (Co nechceme)



11. PretoZe padajtici objekt je uZ teraz nezdvisly na pdvodnom objekte kvapky, oznacte RM pdvodnii
IcoSphere a presuiite ju na druht vrstvu stlacenim M 2.

12. Skontrolujte medzivysledok napr. frame 20 rendrovanim F12. Ak ste spokojny méZeme prejst’ ku
findlnemu generovaniu vyslednej animécie.

13. Stlacte F10 a prenastavte koniec sekvencie End na 100. Stlacte v menu ponuku Render — Render
Animation a chod’te sa tak na hodinku prejst. Blender bude zatial’ generovat’ findlnu verziu scény a
animdcie.

ST Help | = |scR:2-Model | %]

Render Current Frame F1g

¥ Anim

¥ Render

REMDER o .
LA Render Animation
Elendear Intetnal =
Dojceauence Show Fender Buffer Fi1
Render Dipeman i i
Flay Back Rendered Animation

PLAY

P emmil eIz =1 sorder | Ganma [ st [ endtoo ]

Render Settings F10

14. Ak budete chciet’ kontrolovat’ priebeh rendrovania a pridavania snimkov do avi, prekliknite sa na
"kontrolnt obrazovku s Python". Na nej uvidite ¢asovi ndro¢nost’ pridania jednotlivych frameov.



A0 Blender k

Uzing Puython version 2_4

Yimport site’ failed; wuse —v for traceback

bad call to addguewe: 8 {137, @)

had call to addguewe: B (137, 12>

bad call to addguewe: @ {1392, @)

Created avi:z stmp~HA01_A100.avi

added frame 1 {frame B in avi»>: Time: BB:33.36
added frame 2 C(frame in avi»: Time: B@:31_87

i
added frame 3 (frame 2 in avid: Time: BA:=31.92
3 in avi»: Time: AA:=32 .87

added frame 4 (frame

15. Vysledok je uloZeny v adresdri c:\tmp\ a je vo formate avi. M6Zeme ho napriklad nahrat’ na YouTube
http://www.youtube.com/watch?v=-cUalEnZZck
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Zatisie pri sviecke
Daniel Smolarik

Uvod

V tomto tutoridle si ukdzeme ako pomocou 3D grafického editoru Autodesk 3D Max Studio
namodelovat’ jednoduchu scénu (obr. 1), ktort som nazval ,, Zdatisie pri sviecke*. Scéna pozostava
z niekol’kych jednoduchych komponent: miestnost’, stolik, svietnik, horiaca svieca a kniha. Cielom
tutoridlu je ndzorna ukazka modelovania jednotlivych komponent scény a aplikacie niektorych
modifikatorov, zaklady prace s osvetlenim, textirami, tvorba materidlov ale predovsetkym
osvojenie si prace s tymto editorom. Tutorial neobsahuje vyCerpavajuci popis grafického prostredia
editoru, ale jednotivé kroky budi dostatocne ndzorne popisané. Prostredie editoru je pre zakladnti
tvorbu dostato¢ne intuitivne ale pre pohodInu pracu s editorom tplne postacuje zakladna literatura k
softwareu alebo preStudovanie si niekolkych tutoridlov. Konecnd scéna je vysledkom mojich
zakladnych znalosti a sklisenosti s pracou uvedenym grafickym editorom.

V kazdej kapitole si ukdzeme tvorbu danej komponenty samostatne (samostatny subor) a na konci
vSetky komponenty scény importujeme do jedného siiboru a vhodne ich rozmiestnime tak, aby
vytvorili pozadovani konecnu scénu. Pri tvorbe jednotlivych komponent scény nebudeme brat’
ohlad na vzijomné rozmery komponent, pretoze v koneCnej scéne jednotlivé komponenty
uniformne preskalujeme tak, aby si velkostne navzdjom odpovedali.

Obrazok 1: Konecna podoba scény "Zatisie pri sviecke"



Miestnost’

Ako prvu si vytvorime miestnost, v ktorej sa budi nachadzat’ vsetky ostatné komponenty. Vo
viewporte (tj. pohlad na scénu; Standardné viewporty st Top, Front, Left a Prespective)
Perspective si pomocou nastroja Box (panel Commad Panel (Standardne vpravo) — karta Create
— druh Geometry — kategoria Standard Primitives — objekt Box) vytvorime kvader. Kazdy
objekt vytvarame bud’ tahanim mysi v jednotlivych smeroch (rozmeroch) alebo zadanim hodnot
jednotlivych parametrov objektu. Kazdy vytvoreny objekt mézeme 'ubovol'ne pomenovat’ (kolonka
Name and Color), v tomto pripade kvader pomenujeme napriklad ,,miestnost. Kvéader
zkonvertujeme do Editable Poly (pravym tlac¢itkom na kvader — Convert To — Editable Poly).
To nam umozni editovanie objektu na niz8§ej urovni (Vertex, Edge, Border, Polygon, Element).
V sekeii modifikacie (Command Panel — karta Modify) vyberieme v kategérii Selection troven
Element, kliknutim ozna¢ime vo viewporte na$ kvader (Element, ma iba 1) a v kategorii editacie
objektu Edit Elements klikneme na vol'bu Flip, ktora sposobi, Ze naSa miestnost’ bude ,,otvorenad®.
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Na dokoncenie miestnosti eSte potrebujeme jednotlivé steny otextarovat. Tvorba textir a
materidlov a ich pridel'ovanie objektom resp. Castiam objektov sa vykondva pomocou Material
Editoru (klavesova skratka M). Otvorime si Material Editor a vytvorime si dve textary: jedna pre
boc¢né steny a druhd pre podlahu. Textiry a materidly vytvdrame editovanim parametrov
,»prazdnych* materialov (Sedé gule v Material Editore). V tomto pripade vytvorime iba jednoduché



materialy (textiry) pomocou bitmdp. Klikneme na 'ubovolny prazdny material a v kategorii Maps
daného materialu priddme do kolonky Diffuse Color pozadovanu bitmapu a to pretiahnutim danej
bitmapy z l'ubovolného suborového manazéra na tlacitko None. V podadresari maps\ editoru
Autodesk 3D Max Studio sa nachadza archiv bitmdp textur r6znych materidlov. Pre bo¢né steny
pouzijeme bitmapu maps\ArchMat\Concrete.Cast-In-Place.Ribbed.Vertical.2.jpg (vertikdlna
tapeta) a pre podlahu pouzijeme bitmapu maps\ArchMat\Finishes.Flooring.Carpet.Loop.1.jpg
(koberec) a materidly pomenujeme napriklad ,,tapeta resp. ,.koberec”. Material sa objektom (ich
Castiam) prirad’uje pretiahnutim daného materidlu na objekt alebo vyznacenim objektu (Casti
objektu) a kliknutim na tlacitko Assign Matertial To Selection. Aby sme mohli priradovat
material len niektorym polygoénom, v sekcii modifikacie nasho kvadra vyberieme v kategorii
Selection urovenl Polygon. Najskor odstranime dve bo¢né steny a vrchnu stenu (vyznacenim +
kladvesa Delete) a potom vyznaCime zvy$né boc¢né steny (z vnutra) kvadru a priradime im material
»tapeta® a podlahe material ,,koberec”.
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Do miestnosti eSte pridame osvetlenie (panel Commad Panel — karta Create — druh Lights —
kategoria Standard — objekt Omni — jednoklik do miestnosti) a parametre nastavime podla
obrazka (parameter Multiplier urCuje intenzitu svetla, zaskrtneme volbu Shadows: On aby nam
predmety osvetlené svetlom vrhali tien). Len pri svetle samotnej svieCky by sme niektoré objekty
vobec nevideli, vratane samotného svietniku a sviecky. Svetlo OmniLight mézeme pomocou
nastroja Select and Move 'ubovolne premiestiiovat’ po miestnosti.
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Light Typg——

I~ Targeted

Shadows————
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‘ I Shadow Map -
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Stolik

Pozn.: Postupy analogické tym z predchadzajucej kapitoly uz nebudem podrobne popisovat a
rovnako tak aj v dalsich kapitolach. Nové prvky pri tvorbe budu popisané.

Najjednoduchsou castou scény je stolik. V Perspective viewporte vytvorime pomocou nastroja
Box dosku stola a pomenujeme ju ,,doska“. Nohu stola vytvorime rovnako pomocou néstroja Box
(,,noha*). Dal§iu nohu stola dostaneme klonovanim vytvorenej nohy (pravym tlaéitkom na kvader
,noha*“ — Clone). Kliknutim na nastroj Select and Move v Main Toolbar presunieme klon na
pozadovanu poziciu pomocou viewportov. Rovnako tak aj pre ostatné nohy stola. Nohy umiestnime
tak aby mali od krajov dosky stola rovnakt vzdialenost’ (v Top viewporte napriklad pomocou
mriezky na pozadi).
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V Material Editore vytvorime dva jednoduché materialy: pre dosku stola (tlacitko Get Material
— v okne Material/Map Browser — Browse From: Mtl Library — dvojklik na material
Wood_Bubing) material ,,doska” a pre nohy stola (tla¢itko Get Material — v okne Material/Map
Browser — Browse From: Mtl Library — dvojklik na material Wood Cedfence) material
,,noha®. Vytvorené materialy priradime odpovedajucim ¢astiam vymodelovaného stola.
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Svietnik

Pomocou nastroja Line (panel Command Panel — karta Create — druh Shapes — kategoria
Splines — nastroj Line) nakreslime vo Front viewporte krivku priblizne podobnt tej na obrazku.
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Samotny svietnik vytvorime rotdciou naSej krivky okolo osy (Standardne prechadzajucej
pociatoénym bodom krivky). Rotaciu vykoname aplikdciou modifikdtoru Lathe na naSu krivku
(panel Command Panel — karta Modify — ponuka Modifier List — modifikator Lathe). V
kategoérii Parameters modifikdtoru Lathe nastavime parameter Degrees na hodnotu 360
(predvolena hodnota). Rozbalenim modifikatoru Lathe (kliknutim na znak ,,+*) a vyberom osy
rotacie v kombin4cii s nastrojom Select and Move mozeme posuvat’ osu rotacie.
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Ako materidl na svietnik pouzijeme Standardny materidl Metal Dark Gold a aby nebol povrch
svietnika hladky zavedieme do materidlu pre svietnik Sum (Noise) (Material Editor — tlacitko Get
Material — v okne Material/Map Browser (Browse From: Mtl Library) — dvojklik na material
Metal_Dark_Gold — v kategorii Maps klik na tlac¢itko None pri parametri Bump — vyber Noise
— OK — hodnotu Bump nastavit’ na 50). Vytvoreny material pridelime svietniku.
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Sviecka

Pomocou nastroja Cylinder (panel Commad Panel — karta Create — druh Geometry —
kategoria Standard Primitives — objekt Cylinder) vytvorime vo viewpoerte Perspective valec
(priblizne o parametroch: Radius = 70, Height = 270 ) a pomenujeme ho napriklad ,,sviecka®. V
karte modifikatoru (panel Command Panel — karta Modify) upravime v kategorii Parameters
predvolené hodnoty zakladnych parametrov (Heigh Segments, Cap Segments, Sides, tj. pocty
stien) nasho valca ,,sviecka® tak ako st uvedené na obrazku.
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Aby svieCka nadobudla realistickejSicho dojmu, tj. sviecka uz bola niekolkokrat zapalena a je
dielom rucnej prace, trochu zdeformujeme jej povrch, a to zavedenim Sumu na objekt. K tomu
aplikujeme na na$ valec modifikdtor Noise (panel Command Panel — karta Modify — ponuka
Modifier List — modifikator Noise) a upravime parametre modifikatoru v kategdrii Parameters
priblizne tak ako st uvedené na obrazku (je na kazdom akt sviecku si vyrobi). Vyznam
jednotlivych parametrov je intuitivny. Takto vytvorena svieCka je ale dost’ hranatd, ¢oZz ubera na
realistickosti. Preto na sviecku este aplikujeme modifikdtor MeshSmooth (panel Command Panel
— karta Modify — ponuka Modifier List — modifikator MeshSmooth) a v kategorii parametrov
Subdivision Amount tohto modifikatoru zvySime hodnotu parametru Iterations aspoil na 2 pre
jemne;jsie vyhladenie povrchu sviecky.
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Pre svieCku vytvorime iba jednoduchy materidl (textiru) ktorého povrchu pridelime iba farbu z
palety tj urCenie rozsahu odtietiov danej farby, v nasom pripade zelenej, priblizne ako je na obrazku
(Material Editor — vyber ,prazdneho materidlu“ — kategoéria parametrov Shader Basic
Parameters — vyber Blinn — kategdria parametrov Blinn Basic Parameters — pomocou palety
vybrat’ farby Ambient a Diffuse). Nakoniec material pridelime sviecke.
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Knot sviecky vytvorime znova pomocou nastroja Cylinder priblizne o parametroch ako na obrazku.
Front %‘?|d&|f@|@| T‘

Iknat r

| Modifier Lis |

[ e |3

|- Parameters |

Fadius: IEEI— J

Height: IW J

Height Segments: IE—J
Cap Segments: |1— J
Sides: I‘l— J

A4F |4k 4F (4}

4k




Knot vSak len malokedy stoji rovno a tak ho mierne ohneme, ¢o dosiahneme aplikovanim
modifikdtoru Bend (panel Command Panel — karta Modify — ponuka Modifier List —
modifikator Benb) na knot. Zdkladny parameter Angle (uhol ohybu) modifikatoru nastavime na
hodnotu 20. Pre knot vytvorime rovnako ako v predchddzajicom pripade iba jednopduchu
jednofarebnu texturu, v tomto pripade Ciernu. Knot nakoniec vhodne umiestnime do svieCky
(pomocou nastroja Select and Move v Main Toolbar).

1 0 T T 0 ~:3|*ﬂ|,§&]1‘@l@|1~ |
R iR @
B

| Madifier List

ylinder

I~ Limit Effect
o 2

Nakoniec nam zostava vytvorit’ plamen svieCky. K tomu pouZijeme nastroj SpeheGizmo (panel
Commad Panel — karta Create — druh Helpers — kategdéria Atmospheric Apparatus — objekt



SphereGizmo). Objekt vytvorime l'ubovolne mimo svieCku. V karte Modify, v parametroch
Sphere Gizmo Parameters zaskrtneme vol'bu Hemisphere a upravime hodnotu parametru Radius
na 140. Pomocou nastroja Uniform/Non-Uniform Scale (Main Toolbar — Select and
Uniform/Non-Uniform Scale — v Left resp. Front viewporte tahdme objekt SphereGizmo v
smere osy Z) vytvorime pretiahnuty tvar hemisferického objektu SpereGizmo tak aby mal
priblizny tvar plamena sviecky. Tento ,,plamei* premiestnime (nastroj Select and Move v Main
Toolbare) pomocou Top, Left a Front viewportu vhodne nad sviecku, tak ako je uvedené na
obrazku.
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Pre tplnost’ horiacej sviecky musime este objektu ,,plamen* typu SphereGizmo pridat’ efekt ohna,
tj. aby nam sviecka v scéne ,skutoCne” horela a tym osvetlovala okolité objekty (kategoria



parametrov Atmospheric & Effects objektu ,,plamen* — Add — Add Atmosphere [Fire Effect]
— OK — vyznacit’ pridany efekt v zoname — Setup — upravit’ parametre pridaného efektu Fire
Effect podl'a obrazku).
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Kniha

Najskor si pomocou nastroja Box v Perspective viewporte vytvorime kvader, ktory pomenujeme
»kniha“, a v karte Modify Command Panelu upravime jeho parametre podl'a obrazka.

Frowt .%3|E|I{E}'|{®||T|
| kniha .
| Modtier Lis |
CoBe

B [0 [ e | =

[ Parameters ]
Length[T500 2|
Perspective Wit [700,0 =
Height[Z50 2

Length Segs:|1 J

Wwidth Segs:[5 2

Height Segs:[50 2
|_7 Generate Mapping Coords.
[~ Realworld Map Size

AF |4k AF [4F [4F

1k

Ked’ je kniha otvorena su jej okraje pod vplyvom vazby §ikmo skosené. Pre zoSikmenie l'avej steny
kvadru ,.kniha“ aplikujeme na na§ kvader modifikator volnej deformacie FDD 2x2x2. Na trovni
sub-objectu Control Points modifikatoru FDD si vo Front viewporte vyzna¢ime l'avy spodny bod,
tj. celkovo vyznacime 2 body na kvadri, a pomocou nastroja Select and Move ich posunieme v
zéapornom smere osy X. Rozny ohyb stranok spdsobi, ze naviSeny papier vytvori na vonkajsej stene
drobné vrasky. Toho docielime aplikovanim modifikatoru Neise (iba v smeroch X a Y), ktorého
parametri upravime podl'a obrazku.
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Vnutornd stena knihy (tj. stena vézby) je vplyvom Sumu tiez hranatd, ¢oZ je pre nds neziaduce.
Najskor vSak spojime cely stoh modifikatorov aplikovanych na kvader ,.kniha“ (karta Modify —
vyznalit’ vSetky modifikatory (FDD + Noise) + objekt Box — pravé tlacitko — Collapse All).
Modifikovany kvéder ,.kniha“ ndm prejde na objekt typu Editable Mesh.
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Na urovni sub-objectu Vertex objektu ,.kniha* (Editable Mesh) si vo Front viewporte vyznac¢ime



vSetky vrcholy vnutornej steny a pomocou nastroja Uniform/Non-Uniform Scale postivanim v
zapornom smere osy X zarovname vnutornu stenu kvadra , kniha®.
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Pruznost’ masivu ohnutych stranok spdsobi na knihe ohyb. Tento ohyb masivu listov dosiahneme
aplikovani modifikatoru vol'nej deformacie FDD 4x4x4 a vyberieme urovenl sub-objectu Control
Points.
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Na tejto trovni si vo Front viewporte vyznaéime treti stipec bodov (Control Poits), tj. celkovo
vyzna¢ime 16 bodov, a pomocou nastroja Select and Move ich posunieme mierne v smere osy Z.
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Podobne vyznaéime vo Front viewport §tvrty stipec bodov ale tie mierne zrotujeme v smere
hodinovych ruciciek.
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Druht polovicu knihy dostaneme klonovanim vytvorene;j a jej rotaciou o 180 stupiiov v rovine X,Y
a jej vhodnym prilozenim k prvej polovici.
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Dosky knihy vyrobime pomocou nastroja Box, tak aby odpovedali, popripade mierne presahovali,
rozmery jedného stohu stranok knihy. Tento objekt typu Box potom naklonujeme aby sme ziskali
druht dosku knihy. Dalej budeme potrebovat aby boli dosky knihy v oblasti viizby spojené. K tomu
si vo Front viewporte pomocou nastroja Line nakreslime krivku priblizne ako na obrazku.
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Na taktto krivku aplikujeme modifikator Extrude, ktory nam krivku ,,vytiahne® do treticho
rozmeru, a miera toho je dand hodnotou parametru Amount tohoto modifikatoru. Hodnotu
parametru Amount ur¢ime tak, aby dlzka spojovacicho prvku viazby bola zhodna s dizkou dosiek.
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Vyslednu podobu knihy dostaneme vhodnym usporiadanim jednotlivych prvkov (stohy listov,
dosky, spojovaci prvok obalu knihy) knihy tak aby vytvorili podobizen redlnej otvorenej knihy, tj.
priblizne tak ako je to vyobrazené na obrazku.




Zostava nam uz len otextirovat’ knihu. V Material Editore vytvorime pre cely obal knihy (dosky +
spojovaci prvok dosiek) jednoduchy material v podobe jednofarebnej textury, ktora bude hneda. A
kedze dosky star§ich knih st zabalené eSte v platne, priddme textlre pre cely obal knihy aj Sum aby
bol povrch dosiek drsny. Pre stohy papiera knihy vytvorime tiez jednofarebny material, kde farba
bude mat’ nadych ,,starého* papiera.
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Kazdy z tychto materidlov (textur) priradime prislusnej ¢asti knihy. Zostdva ndm eSte otexturovat’
viditeI'né strdnky knihy, ktord je otvorend. V Material Editore si vytvorime dva jednoduché
materialy (pre lavi a prava viditel'nu stranku knihy), ktoré budu kazdy tvoreny iba bitmapou, ktoré



su obrazkami stranok z knihy (obrazky boli stiahnuté z internetu).
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Aby sme mohli pridelit’ vytvorené materidly pre viditelné stranky knihy prislusnym strankam,
musime v karte Modify u kvadra ,,kniha* (avy alebo pravy stoh listov) vybrat’ Groven sub-objectu
Poly, vyznalit' vSetky polygony, ktoré tvoria viditeInt stranku knihy, a v Material Editore
kliknutim na Assign Material to Slection priradime material vrchnej stene kvadru ,kniha®.
Rovnako tak postupujeme aj pre druhy stoh listov.
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Finalizacia scény

Postupne sme si vymodelovali a otexturovali vSetky prvky scény. Vysledkom je niekol’ko stiborov s
koncovkou max, ktoré teraz vSetky postupne vyexportujeme (ponuka File — Export) do suborov s
koncovkou 3ds. Tieto subory vsetky importujeme (ponuka File — Import) do jedného prazdneho
pracovného suboru, ¢im sme ziskali vSetky modely v jednej scéne. Ako som na zaciatku uviedol, pri
tvorbe jednotlivych komponent scény sme nebrali ohl'ad na vzajomné rozmery komponent, pretoze
v konec¢nej scéne jednotlivé komponenty uniformne preskdlujeme (nastroj Unoform/Non-Uniform
Scale) tak, aby si velkostne navzajom zodpovedali. Zostava uz len modely vhodne usporiadat
(nastroje Select and Move a Select and Rotate) tak aby sme dostali poZzadovanu scénu. Ked uz
mame scénu usporiadani tak si vo viewporte Perspective pomocou nastrojov pre pracu s



viewportami umiestnenych v pravom dolnom rohu GUI editora (vid’. obrdzok) nastavime pohl'ad na
scénu priblizne tak ako je na obrazku.
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Uplne poslednou vecou je vykreslenie nastavenej scény (Rendering — Render... — nastavit
parametre Width a Height — Render).
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Karambol v Blenderu
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Uvod

V tomto tutoridlu si ukaZzeme zakladni techniky modelovani v Blenderu. Na ptikladu modelovani
taga, kouli a stolu na karambol (kule¢nikova hra, které se hraje na kule¢nikovém stole bez dér) se
seznamime s pracovnim prostiedi Blenderu a zdkladnimi metodami modelovani.



Pracovni prostredi

Ovladani

Nejprve se sezndmime se zakladnim ovlddanim Blenderu. Ze za¢atku se vam mize zdat pon¢kud
neintuitivni, ale po chvilce zjistite Ze je dost efektivni. Pfi praci jednou rukou ovladate mys a
druhou ruku mate na klavesnici pripravenou k mackani klavesovych zkratek.

Pohyb

Pro ptiblizeni a oddéleni slouzi kole¢ko na mysi (KM)
Pokud se chceme pohybovat doleva ¢i doprava, pfidrzime Ctrl+KM
Pro pohyb nahoru a dolu pridrzime Shift+KM

Pohled

Pro riizné pohledy na modelovany objekt slouzi numerické klavesnice:

Num 1 — pohled zepiedu

Num 3 — pohled z boku

Num 7 — pohled ze shora

Num 0 — pohled kamery, ¢ili pohled na vysledny model

Klavesy Num 2, 4, 6 a 8 slouzi pro otaCeni pohledu ve sméru horizontdlnim i vertikalnim.
Alt+LM — nataCeni pohledu uzivatelem

Klévesy + a - slouZzi k pfibliZzeni a oddéleni objektu, klavesa Enter na numerické kldvesnici
ptiblizeni normalizuje.

Prace s objekty

Vybér objektii a naslednd prace s nimi se v Blenderu provadi pravym tlac¢itkem mySi (PM), coz je
ze zaCatku trochu matouci. Levé tlacitko mysi (LM) slouzi k potvrzovani ukoll a posouvani
objektl. Kontextova nabidka se vyvolava mezernikem.

Mody

Pti modelovani budeme pracovat ve dvou modech.
Edit mode slouzi k uprav¢ vlastniho objektu, mtzete
v ném pracovat s jednotlivymi vrcholy, hranami a T .
sténamli). Object IJnode slm};ﬁ ke globz}i’lnim operacim ney sor onew [oreer 9 @ KA
jako jsou naptiklad pfesouvani objektu, rotace objektu
a zména velikosti. Mezi jednotlivymi mody se piepina
klavesou Tab nebo pomoci nabidky ve spodni Casti v

okna viz obrazek €. 1. 2 Weight Paint
% Texture Paint
M \ertex Paint
& U Face Select
&° Sculpt Mode

i ]
I bley Dielete
e | Genter Cursor_ |

Azslan

Ilustrace 1: Prepindani modu



Grafické rozhrani

Zakladni

Po spusténi Blenderu uvidite nésledujici okno. V horni €4sti je info-panel, kde mizete ptepinat mezi
jednotlivymi scénami a nachézi se tady standardni nabidka jako ve Windows (UloZeni souboru,
nacteni souboru, vlozeni pfedmétu...). Uprostied se nachazi 3D okno, nejdilezitéjsi ¢ast Blenderu.
Zde vidite veskeré objekty, které se nachazeji na scéné, mizete je upravovat, tvorit, zvétSovat. Dole
muzete vidét Tlacitkové okno. Tady najdete asi nejvice funkci. V horni ¢asti vpravo za oznacenim
,Panels' se pfepind mezi jednotlivymi podskupinami tlacitek, které se vztahuji k urcité ¢innosti.
Prepinat mezi nimi mtzete bud’ klasicky mysi nebo klavesovymi zkratkami.
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Ilustrace 2: Okno Blenderu po spusténi



PrizpUsobené

Neékdy se hodi vidét objekt z vice thll, okno Blenderu muizete rozdélit na
vice ¢asti pokud najedete kurzorem mysi na okraj okna. Objevi se
dvousmérna Sipka a pokud zmacknete prostedni tlacitko mysi objevi se Split Area
nabidka jako na obrazku €. 3. Vyberte volbu Split Area a zvolte si jak chcete
okno rozd¢lit. Pokud mate dostatecné velky monitor, doporucuji okno
rozdélit na 4 ¢asti a v kazdé ¢asti mit jeden pohled jako na obrazku cislo 4.

Iustrace 3:
Rozdélovani okna na
vice pohledit

25 Blender

i 12 Object Mode

.!!.@ @ |Global

] [pddwedie | tocube

llustrace 4: Okno rozdélené na ctyri casti - vlevo jsou pohledy zepredu a z boku a vpravo z vrchu a
pohled kamery




Modelovani

Stul

Prvnim objektem ktery budeme modelovat je stl. Spust’te Blender a piepnéte se do edit mode
(Tab). Klavesou A oznacite nebo naopak odznacite vsechny body. Zruste vSechna oznaceni a
vyberte pouze vrchni sténu krychle. Bud'to ptidrzte Shift a pravym tlacitkem mysi vyberte 4 vrchni
vrcholy. Nebo stisknéte Ctrl+Tab a vyberte ,,face select mode*, potom pravym tlacitkem mysi
oznacujete celé plochy (faces). Krychli se spravné oznacenou horni sténou vidite na obrazku 5.

llustrace 5: Krychle s oznacenou horni sténou

V hornim pohledu stisknéte klavesu S a horni sténu trochu zvétsete.
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Horni sténu nechte oznacCenou a extrudujte ,,na misté* tak, ze zmacknete klavesu E a akci ihned
potvrd’te. Zmensete nove vzniklou plochu klavesou S.
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llustrace 7: Zmensend nové vznikla plocha

Vysledek vidite na obrazku vyse. Ted’ miizeme plosku ,,zatlacit™ dovniti krychle a trochu rozsifit,
tim nam vzniknou zeSikmené mantinely kuleCniku. Zatlac¢eni provedeme pomoci metody extrude
(E) a rozsiteni pomoci Scale (S). Na obrazku vidite jak by to mélo pfiblizn¢ vypadat.
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Nyni mame ptipraveny takovy zaklad kule¢nikového stolu. Pomoci funkce Scale (S) ho upravime
tak aby se podobal opravdovému stolu. Pokud chcete zvétSovat pouze podle nékteré z os, stisknéte
béhem zvétSovani kldvesu s pismenem dané osy (X, Y, Z). Ja jsem stiil prodlouzil, trochu snizil a
upravil sklon bo¢nich stén. Vysledek mého snazeni je na obrazku 8.

n [ sedtvode <) @ (@ s OO (= k4 = view select Mesh [seatvose = |@ (@ |
El flml [ 1 ]

(3 l ki1 i
Tlustrace 8: Still po nékolika upravach pomoci funkce Scale.

V dal$im kroku ptidame ke kule¢niku nohy. Nohu vytvofime metodou kombinaci extrudovani a
scalovani. Zacneme tim, ze ptidame circle. V pohledu z vrchu stisknéte mezernim a z nabidky
vyberte Add > Circle. circle nasledné extrudujte smérem nahoru a riizné zvétSujte a zmensSujte podle
vasi fantazie. Mnou vytvoienou nohu muzete vidét a obrazku 9.

Tlustrace 9: Noha stolu



Nohu pak ttikrat zduplikujeme (Shift + D) a umistime na spravné misto.
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Poslednim krokem ktery musime udélat, aby byl stiill kompletni je texturovani a obarveni. Pro
jednoduchost pouZzijeme pouze zelenou barvu na platno a dievénou texturu na télo stolu. Vyberte
nejprve vrchni stény téla stolu.
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Déle tyto plochy rozdélime na ptilky. Jedna polovina
bude patfit k platnu a druha bude télo stolu. Rozd¢leni
provedeme pomoci tlacitka subdivide v dolnim panelu.
Ujistéte se, ze mate zmacknuta tlacitka Beauty a Short,
jinak se plochy rozd¢€li na 4 dily misto na dva. Poté, co
uspés$né rozpulite horni stény stolu, vybereme vSechny
plochy, které budou soucasti platna. Prepnéte se do
vybérového rezimu ploch pomoci Ctrl + Tab 3.
Pridrzte klavesu Shift a pravym tlacitkem vyberte
vSechny plochy.

[o[a [onea =] @4 [2) (| [Bla) A\ = view seeet e [Sconvoo: <) @3 (@ =) FB0]n (om0 (@ 3 [2) [

Jakmile budete mit vSechny plochy vybrané nastavte jim spravnou barvu. Vlevo dole v panelu links
and Materials stisknéte tlacitko New a potom Asign. Spravnou barvu pak mizete vybrat kliknutim
na ¢tverecek vlevo od volby ,,2 Mat 2¢




Podobnym zpiisobem ptiddme zbytku stolu texturu dieva.

Koule

Modelovani kouli je jednoducha zalezitost. Pfepneme se do object mode (Tab) a pfes menu
(Mezernik) piidame jednu kouli postupem Add > Icosphere. Koule obarvime stejnym postupem
jako sttl. V karambolu jsou dvé koule bilé a jedna Cervena.

Tago
Téago je opét jednoduché. Pomoci Add > Mesh > Cylinder pfidame valec a metodou scale z n¢j
udélame tago, které nasledné obarvime stejnym postupem jako sttil.

Osvétleni

Poslednim krokem je pfidat spravné osvétleni. Nad kule€nikem obvykle visi dvé lampy, proto i my
pridame dv¢ lampy pies menu.



Vysledek

Vysledny obrazek pak miize vypadat néjak takto:
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Obrézek 1: Hlavni okno programu

Lampicka v Blenderu

Jako zdpoctovy ukol na predmét pocéitacovd grafika 2 jsem si vybral modelovani v programu Blender
a to konkrétné model lampicky. Jako pfedlohu jsem pouzil ndkres lampicky, kterou md studio Pixar jako

P

svoje logo. V tomto tutoridlu se nepfedpoklddd zddnd pfedchozi znalost Blenderu ani jiného modelovaciho
programu.

Hlavni okno programu a zakladni ovladani

Po spusténi programu se objevi vychozi okno programu 1.

Hlavni menu

Upln& nahofe je hlavni menu programu. Zde nds bude zajimat polozka File, v niZ se nachdzi klasické
New, Open, Save a Save as. Bystry ¢tendr si jisté jiz vS§imnul, Ze se zde nenachdzi nic co by se alesponl
vzdélené podobalo pfistupu do nastaveni. Nastaveni je v Blenderu feSeno pomérné netypicky a to tak, Ze
se horni menu roztdhne smérem dolii. Na roztaZené ploSe se poté objevi zdkladni nastaveni jako napfiklad
automatické ukldddni modelu a podobné. Dalsi véc co nds bude v hornim menu zajimat je polozka Render
a v ni Render Curent Frame. Touto polozkou vyrenderujete aktudln{ scénu.

Pracovni plocha

Pod hlavnim menu se nachdzi vlastni pracovni plocha. Po otevieni nové scény je na stfed standartné
umisténa krychle a kolem nf je umisténa kamera a svétlo. Pracovni plocha md vic rezimi price s objekty.
Ni4s budou v tomto tutoridlu zajimat pouze 2. Prvni je Object mode a druhy je Edit mode. V rezimu Object
mode je mozné pohybovat s objekty jako celky. To znamend, Ze pokud budeme chtit objekt napiiklad
premistit, otocit nebo zménit jeho velikost, musime byt v rezimu Object mode. Naproti tomu v reZimu



Edit mode miiZzeme ménit jednotlivé body nebo skupiny bodd, ze kterych se skldd4 objekt. To znamen4, Ze
pokud budeme chtit naptiklad posunout jeden roh krychle, musime byt pfepnuti do Edit mode. Kldvesova
zkratka pro pfepindni mezi reZimy je tabuldtor.

Objekt nebo bod vybereme stisknutim pravého tlacitka mysi. Pokud chceme vybrat vic objekti najed-
nou, drzime pii vybéru kldvesu Shift. KdyZ uzZ mame objekt vybrany miiZeme s nim riizné¢ manipulovat.
Levym tlac¢itkem mys$i klikneme na Sipku, kterd se u objektu objevila a tazenim objekt pfesuneme na poZa-
dované misto. Stejnou akci je mozné spustit stisknutim kldvesy G, presunutim mysi na misto a stisknutim
Enter pro potvrzeni. Rotace se spousti kldvesou R a velikost se mén{ stisknutim kldvesy S.

Pokud chceme vytvofit néjaky novy objekt, stiskneme mezernik a objevi se vyskakovaci menu kde
klikneme na Add a vybereme si poZadovany objekt. Pokud jsme pfepnuti do editaéniho médu, budou se
objekty pfiddvat do editovaného objektu. Naproti tomu pokud jsme v Object mode, bude ptidany objekt
vloZen samostatné.

KdyZ chceme néco ze scény vymazat, oznac¢ime si pravym tlacitkem mySi poZadovany objekt nebo
pozadované body a stiskneme kldvesu Delete.

Pro spravné umist'ovani objektu na misto je potifeba vidét scénu z rtiznych pohledi. Piepindni mezi
pohledy je standartn€ nastaveno na tlacitka 1, 3 a 7 na numerické kldvesnici. Pomocf tlacitek 4 a 6 miZzeme
scénu naticet doprava a doleva a stisknutim O se zobrazeni prfepne do pohledu kamery. Pomoci kolecka
mysi miZeme scénu pribliZit nebo oddalit. Pro pohyb po scéné stiskneme kldvesu Shift respektive Ctrl a
scrollujeme kolecekem.

Spodni panely

~ws

Pod pracovni plochou se nachdzeji nejriznéjsi panely, kde se nastevuji rizné parametry objektt. Po-
drobnéji se k nim dostaneme v pribéhu modelovani.

Stinidlo

Prvni véc, kterou musime vytvofit je stinidlo. Stiskneme 1 a pfepneme se do pohledu zepiedu. Pre-
pneme se do objektového reZimu, stiskneme Mezernik a v menu vybereme Add, Curve a Bezier curve. Po
pridani se Blender automaticky pfepne do editacniho reZimu. Vybereme tedy posledni bod, stiskneme Shift
a klikneme pobliZ ktivky. Tim se pfidaji dal$i body. Naskldddme body tak aby vytvofily tvar, ktery vypada
jako stinidlo lampicky. Po umisténi bodt by to mélo vypadat podobné jako na obraku 2.

Prepneme se do objektového mddu, vybereme kfivku a stiskneme Alt+C. Vysko¢i menu, kde vybereme
Mash. Tim se ptivodné bezierova kfivka konvertovala na obycejnou skupinu bodii. Nyni nyn{ se pfepneme
klavesou 7 do pohledu shora. Ve spodnim panelu najdeme okno Mesh tools a nastavime ho podle obrdzku
3 a stiskneme Spin. Pokud vS§e probého spravné, mélo by stinidlo vypadat jako na obrazku 4.

Zarovka

N4

Po tspésném vytvoreni stinidla miZeme pfistoupit k tvorbé Zarovky.

V menu pod pracovni plochou klikneme na polozku View a Background image. V zobrazeném okné
klikneme na Use background image a poté na Load. Vybereme si n€jaky vhodny obrdzek zZirovky. Tento
obrazek se poté umisti na pozadi pracovni plochy a umoZni ndm snadnéji vytvofit spravny tvar Zarovky.
Prepneme se do pohledu zepiedu a vlozime NURBS Curve. Stejny zptisobem jako u stinidla si priddme
nékolik bodl a kiivku upravime tak aby ohranicovala horni okraj Zarovky na obrdzku. Poté se pfepneme
do objektového modelu a pomoci Alt+C opét konvertujeme NURBS kiivku na obycejnou. Vysledek by
mél vypadat zhruba jako na obrazku 6. Poté se piepneme dopohledu zepiedu a stejnym zpisobem jako u
stinidla krivku orotujeme a vytvofime prostorovy model Z4rovky.

Nyni musime jeSt€ nastavit materidl, ze kterého je Zarovka vytvofena. Ve spodnim panelu stiskneme
tlacitko s kulickou a klikneme na tlac¢itko Add new. Tim jsme pfidali vybranému objektu novy materidl.
Vlastnosti materidlu nastavime podle obrazka 7 a 8. Tim mame Zarovku hotovou. Nyn{ ji miZzeme umistit
do stinidla kam patfi. Stiskneme G a premistime Zdrovku do stinidla. Zkontrolujeme si pozici ve vSech
pohledech.



Obrézek 2: Kfivka pro stinidlo

Obrazek 3: Nastaveni rotace



Obrazek 4: Hotové stinidlo



Add Mullres

Obrazek 5: Hotové stinidlo - jiny pohled




Obrézek 6: Kiivka Zarovky
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Obréazek 7: Nastaveni materidlu Zarovky
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Obrézek 8: Nastaveni materidlu Zarovky

Drzak lampicky

Nyni si vymodelujeme nosnou konstrukci lampicky. ZaCneme tchytem stinidla na vlastni konstrukci.
VloZzime do scény plochu a upravime ji do tvaru obdélniku jako na obrazku 9. Pfepneme se do pohledu
zhora a edita¢niho reZzimu a stiskneme E. Ve vyskakovacim menu vybereme poloZku region a vytdhneme
plochu do poZadovaného tvaru.

Tycky tvofici konstrukci vytvoiime stejnym zpisobem akordt Ze nebudeme vytahovat do boku, ale
nakreslime si podstavu a tu potom vytdhneme jako je ukdzdno na obrdzku 10. Stisknutim Shift+D si ty¢ku
¢tytikrat zduplikujeme a duplikované tycky umistime jako na obrdzku 11.

Do drzdku nyni umistime malé valecky pro uchyceni pruZin. Vlozime novy vilec s primérem 1 a
vyskou 6. Vélec zmensime tak aby primér byl stejny jako je §itka tycek drzaku. Zduplikujeme a umistime
na misto.

Posledni véci na drzdku jsou plechy, které drzi pohromad¢ tyCky. Vlozime si NURBS kiivku a vymode-
lIujeme ji do tvaru plechu. Potom stiskneme C. Tim se kfivka uzavfela a vytvofila 2D plochu. Nynf kiivku
malinko vytdhneme aby to byl 3D objekt a ne jenom 2D placka, zduplikujeme a umistime na misto.

Podstavec

Dalsim krokem je modelovéni podstavce. Pfiddme si NURBS kiivku a vytvarujeme ji jako je na obrazku
12. Pfevedeme objekt na obycejnou kiivku a pfepneme se do editaéniho reZimu. Pro snadnéj$i vymodelo-
véani podstavce je lep$i umazat polovinu bodd a rotovat jen polovimu bodu ale o 360 stupiiti nez mit cely
tvar a rotovat jen o 180 stupni. Zduplikujeme tchyt stinidla na drzédk a umistime ho doprostied podstavce

jako na obrdzku 13

Rozsviceni zarovky

Nyni vloZime do scény svétlo typu Lamp a nastavime podle parametrd na obrdzku 14. Pro lepsi osvét-
lIeni umistime jeste jedno svétlo nékam za lampicku. Bude tak 1épe vidét cely model.

Pruziny

Nyni pfichdzi na fadu modelovani pruZin. Nebudeme zde modelovat animaci skédkajici lampicky jako
ma4 firma Pixar, takZe ndm staci pouZit jednodussi postup.

VloZime do scény kruh, pfepneme se do editaéniho reZimu a vloZime je$té svislou ¢4ru jako na obrazku
15. V panelu Mesh tools nastavime parametry rotace podle obrdzku 16 a stiskneme Spin. Nyni se ndm
vygenerovala krdsnd pruZina, kterou zmens§ime zduplikujeme a umistime na misto.



Obrazek 9: Uchyt stinidla



Obréazek 10: Prvnf tycka drzdku lampicky



Obréazek 11: Drzik lampicky
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Obrazek 12: Kfivka podstavce
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Obrazek 13: Cely podstavec

Megafive
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Obrazek 14: Nastaveni svétla
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Obrézek 15: Pfiprava na pruZinu

Obréazek 16: Parametry pruZiny

13



Obrazek 17: Findlni obrazek

Stul

Aby 1épe vynikly stiny, je lepsi lampicku umistit na sttl. VloZime si do scény plochu zvétsime ji a
vytdhneme smérem dolu.

Vypinac

Jako posledni véc ndm zbyva vymodelovat vypinac. Pomoci NURBS kfivky si vytvofime zdkladnf tvar,
ktery vytdhneme do boku. Poté napiseme Cislice O a 1 opét je vytdhneme a umistime do vypinace tak aby
to vypadalo jako, Ze jsou vyryté do vypinace. Cisla si nabarvime na bilo, vypina¢ na &erno a umistime ho
do podstavce.

Finalni obrazek

Timto mdme model hotov a miZeme ho vyrenderovat. Pokud nebude vidét spravné, pohneme s kame-
rou tak aby byl zabrén cely.
Vysledny obrdazek mize vypadat napiiklad jako na obrazku 17.
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Hraci kostky v POV-Ray

Cilem tohoto tutorialu je provést postupem pii modelovani hracich kostek s pouzitim nastroje
POV-Ray (Persistence of Vision Raytracer). Program POV-Ray je volné §ifitelny nastroj pro
vytvafeni tfi dimenzionalni grafiky. Veskeré informace, vCetné linku na stazeni aplikace a
dokumentace, lze nalézt na domovské strance projektu http://www.povray.org/. Samotna
instalace produktu nds ni¢im neptekvapi a probiha s vyuzitim standardniho pravodce
instalaci.

Po spusténi aplikace vidime standardni rozhrani nastroje, které ndm nabizi né€kolik zakladnich
funkci reprezentované tlacitky v horni listé¢. My pouzijeme jen dvé zakladni a to ,,New* pro
zalozeni nového projektu a pak v prubéhu samotného modelovéani pro zobrazeni vysledkt
tlacitko ,,Run® pro spusténi rendrovéani obrazkl. K samotnému modelovéni slouzi spodni ¢ast
aplikace do které zapisujeme piikazy pomoci specialniho jazyka. Vice o tomto jazyku najdete
v nékterém z tutorialti na vySe uvedenych www strankach.
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Obrazek 1: Aplikace POV-Ray



V tuto chvili méme jiz aplikaci pfipravenu k samotnému modelovani objektti. Jako prvni krok
ke kterému musime pfistoupit je nastaveni pozadi, umisténi kamery ze které budeme objekty
pozorovat a osvétleni scény. K tomuto slouzi nasledujici jednoduché ptikazy.

#include "colors.inc"
background { color rgb <1, 1, 1>}

camera {
location <7, 5.5, 4>
look at <-0.5,-1,-2>
H

light source {
<10, 5, 5>
color White
}

light source {
<0, 5, 5>
color White

}

K nastaveni barvy pozadi jsme vyuzili ptikaz backround {}, ktery krom jiného umoziuje
nastavit pozadi zadanim barvy v RGB. Pfed pouzitim barev vSak nesmime zapomenout tyto
barvy zpfistupnit pro nas projekt pouzitim piikazu #include a pfislisné knihovny v tomto
ptipad¢ colors.inc.

Dalsim krokem je nastaveni kamery pro sledovéni scény. To provedeme pouzitim piikazu
camera {}, ktery ocCekava dva parametry: Prvni location, ktery urCuje umisténi samotné
kamery a druhy look at, ktery uruje smér pohledu této kamery.

Jako posledni ¢ast v tomto okamziku umistime osvétleni scény. V naSem ptipade jsme pouzili
dvou bodovych zdrojii svétla. Bodovy zdroj svétla vlozime do scény ptikazem light source {}
se soufadnicemi pro umisténi zdroje a parametrem color pro uréeni barvy svétla.

Po vyrendrovani scény dostaneme nasvicenou bilou plochu s umisténym nahledem na scénu
viz. nasledujici obrazek.
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Obrizek 2: Svétlo, kamera, pozadi

Pro lepsi predstavu o umisténi souradné soustavy si jako mezikrok pred dalsim modelovanim
zobrazime v poc¢atku soufadné soustavy jednotlivé osy a umisténi tohoto pocatku. To lze
provést nasledujici sekvenci piikazu.

// osa x
cylinder {
<0.0, 0.0, 0.0>, <3.0, 0.0, 0.0>, 0.03
texture {
pigment { color rgb <1, 0, 0> }
}
}

cone {
<3.0, 0.0, 0.0>, 0.06, <3.5, 0.0, 0.0>, 0.0
texture {
pigment { color rgb <1, 0, 0> }
}
}

/l osay



cylinder {
<0.0, 0.0, 0.0>, <0.0, 3.0, 0.0>, 0.03

texture {
pigment { color rgb <0, 1, 0>}
}
H
cone {
<0.0, 3.0, 0.0>, 0.06, <0.0, 3.5, 0.0>, 0.0
texture {
pigment { color rgb <0, 1, 0> }
}
}
// osaz
cylinder {
<0.0, 0.0, 0.0>, <0.0, 0.0, 3.0>, 0.03
texture {
pigment { color rgb <0, 0, 1> }
}
H
cone {
<0.0, 0.0, 3.0>, 0.06, <0.0, 0.0, 3.5>, 0.0
texture {
pigment { color rgb <0, 0, 1>}
}
}

Pomoci piikazu cylinder{} umistime do pocatku soufadné soustavy valec jehoz konec
opatiime ptikazem cone {} kuzelem. Na oba objekty pouzijeme texturu pro jejich obarveni.
Pro pouziti textur musime textury inicializovat ptikazem #include “textures.inc”. Vysledek
muzete vidét v nasledujicim obrazku.
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cylinder {
vl,  Oad, D.035. ¢R.0, 30,
texture {1
pigment { color rgh <0,
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cone {
¢0.0, 3.0, 0.05, 0.08, 0.0
Texdture 4
pigment { color ragb <0,

t

S/ psa =z
cylinder {
vl, 00, .03, ¢3.0, Do,
texture 1
pigment { celer rgb =0,
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cone {
¢0.03 0.0, 3.05, 0.08, <0.0
texture 4
pigment { color ragb <0,
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Cutput - = 'Cpoyd dice.bmp!
Obrazek 3: Osy

Nyni se pustime jiz do samotného modelovani hraci kostky. Hraci kostka je ve své podstaté
velmi jednoduchy objekt jedna se krychli ofezanou kouli v jejichz sténéch jsou pouzity dalsi
mensi koule pro vymodelovani jednotlivych puntikl zndzoriujici ptisluSné ¢islo. Jako prvni
krok vytvotime samotnou kostku s hladkymi sténami. Pro vytvoreni tohoto objektu pouzijeme
pranik krychle a koule. Reprezentace v POV-Ray je nasledujici sekvence prikazi.

intersection {
box {
<0,0,0>, <2,2,2>
texture {
pigment {
color rgbt<1,0.2,0.2,0.3>
}
}

}
sphere {
<1,1,1>, 1.4
texture {
pigment {
color rgbt<1,0.2,0.2,0.3>



}
b
b
}

Piikaz intersection {} vytvoii prunik vlozenych objektli, v nasem piipad¢ krychle a koule.
Krychli vytvorime pomoci piikazu box {}, ktery ocekava jako parametr levy dolni a pravy
horni roh a v takto ur¢eném prostoru vytvoii krychli. Ptikaz sphere{} oproti tomu ocekava
jako parametry bod urcujici stfed koule a jeji primér. Vzijemnym prinikem téchto dvou
objektti vznikne pozadovany tvar kostky. Pro zviditelnéni vytvoieného objektu je nutné pouzit
texturu k obarveni jeho stén.

Pro dokonceni kostky je nutné pfidat na kazdou ze stén prohlubné znazoriujici ¢islo. Pro
ptislusnou stranu kostky to provedeme tak, ze vytvorime rozdil mezi jiz vytvoienou kostkou a
kouli umisténou na patficné soufadnice. To provedeme piikazem diference {}, ktery ocekava
dva a vice objekti jejichz rozdil ma vytvorit. Pouziti 1ze demonstrovat na nasledujici ukazce
kodu.

difference {
intersection {
box {
<0,0,0>, <2,2,2>
texture {
//T_Glass4
pigment {
color rgbt<1,0.2,0.2,0.3>
}
}

h
sphere {

<1,1,1>, 1.4

texture {
//T_Glass4
pigment {

color rgbt<1,0.2,0.2,0.3>

}

H

}
}

/1

sphere {
<2,1,1>,0.15
pigment {

color rgb<0,0,0>

j

}

H

Umisténim vSech ¢isel na viditelné stény kostky dostaneme findlni model kostky viz.
nasledujici obrazek.
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T
Tight_source {
a0, &; G

color white |

difference {
intersection {
box {
e, 0,05, 22, 2,2
texture {
AAT_alass4
pigment 4
color rgbt<l,0.

s

¥
sphere {
1A ey L4
texture {
AAT_al ass4
pigment 4
color rgbtl,0.

¥
¥
T

prat
sphere 4
e, T aw,. 0,15
piament {
celor rgbed,0,0:

FFA

Qukput - = "Cpovidice. brp!
Obriazek 4: Kostka

Pro dokon¢eni nami pozadované scény musime vytvorit jesté jednu kostku. Tu vSak
vytvofime velmi snadno a to tak Ze pouzijeme stejny postup jako u predchozi vcetné
shodnych parametrti jen pfiddme dva nové piikazy pro posunuti (translate {}) a otoceni
(rotate {}). Timto vytvofime snadno a rychle novou kostku na pozadovanych soufadnicich.
Jako posledni krok pro dokonceni scény pfidame podlozku na které kostky budou lezet.
V nasem ptipad¢ jsme zvolily jednoduchou plochu s motivem Sachovnice. Tuto plochu
vytvoiime nasledujicim piikazem.

plane {
<0,1,0>,0
texture {
pigment {
checker color rgh<0.6, 0.6, 0.6>, color rgh<0.1, 0.1, 0.1>
}
}
H



Piikaz plane{} urcuje ze se jedna o hladkou plochu. Jako texturu této plochy pouzijeme
ptikaz checker, ktery ndm vytvoii pozadovanou Sachovnici ze zadanych barev. Nyni mizeme
spustit posledni rendrovani scény a ziskame nami pozadovany finalni vysledek.

Obrazek 5: Finalni scéna
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Zatisi

Toto je tutorial k nasledujici scéné :

Tento tutorial byl vytvofen 27.5.2007 pomoci 3D Studia MAX a V-Ray 1.5

RC3. Autorem je Ondfej Svejkovsky. Tutorial je rozdélen do tfi ¢asti :
1.Dzban a sklenicky

2.Skfinka

3.Zbytek scény

Zde je mozné stahnout originalni soubor scény zatisi.max a textury které
jsou potfeba. Po otevieni souboru .max bude nutné zménit v jednotlivych

materialech cesty k texturam.

lof1l 11/20/2008 05:15 PM
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1.DZban a sklenicky

%‘I%‘ﬁ%lwlmlr‘[ Nejdfiv pomoci nastroje Line (Pravy toolbar (dale jen

]._Linaﬂ'l . PT)-Create-Shapes-Line) nakreslime obrys dzbanu. Je

_|M"odifier Lisk L‘ dulezité kfivku uzavfit, tj. nakreslit ¢aru najednou a na konci

B NURES Surface uzavieni kfivky potvrdit v dialogu. Pak pfevedeme tento

Lurve OV poly gon na NURBS kfivku (Prava my§-Convert To-NURBS).
Curve

Nyni pomoci fidicich bodu upravime kfivku tak aby méla

obrys dzbanu.

Finalni podoba obrysu by méla vypadat asi néjak takto.
Nicméné to neni Zadnou podminkou. Tvar mlze byt

samoziejmé i jiny.

1of6 11/20/2008 05:14 PM
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[Line0t

IModi'fier List

=

| NURBS Surface |

w il s

(e

Jakmile médme obrys dzbanu nakresleny, vybereme hotovou
kfivku a aplikujeme na ni modifikator Lathe (PT-Modify -
Lathe). Pocdet stupiit bude 360, pocet segmentu je vhodné

zvolit alespon 32, aby byl dzban dostate¢né hladky .

||l elE

[Tret

| Modifier List
B Editable Poly

Kdy Z je dzban hotovy, musime jeS§té upravit jeho hrdlo, aby
bylo vhodné pro nalévani. Pfevedeme tedy dzban na
Editable Poly (Prava mys$-Convert To-Editable Poly). Nyni v
praveém toolbaru zvolime vertex, abychom mohli vybirat
jednotlivé vrcholy sité a nize pak rozbalime poloZzku Soft
Selection a zatrhneme volbu Use Soft Selection - viz
obrazek. Soft Selection nam umoziiuje velmi plynule

tv arovat celou sit. Vybereme pfiblizné 4 vrcholy na hrdle
dZzbanu a posuneme je troSku smérem od osy. Vysledek by
meél byt podobny tomu na obrazku. Pokud nefunguje v$e jak

ma, je mozna tfeba upravit polozku Falloff v Soft Selection.

20f 6
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Nyni nalejeme do dZbanu néjakou tekutinu. Nakreslime
zhruba jeji obrys opé&t pomoci nastoroje Line. Dame si
zalezet, aby vnéj$i obrys byl pfimo v téle dzbanu a ne v
duté vnitini ¢asti. Ny ni opét nakrelsenou kfivku orotujeme
pomoci modifikatoru Lathe jako v pfipadé dzbanu. Nasledné

pfevedeme vznikly utvar opét na Editable Poly.

i | Nyni vybereme objekt, ktery bude pfedstavovat tekutinu ve
| P £ @@ T ynivy ) J bude p
- dZbanu a ofezeme ji pfesné do tvaru dzbanu. Zvolime néstroj
+ ] ﬁ % ‘3‘ (S ‘1‘ Boolean v Compounds Objects (PT-Create-Geometry-
ICorrrpound Objects ;! Compound Objects-Boolean). V Pick Boolean zvolime

polozku Copy a v Operation dame Substraction. Vratime se

zpét do Pick Boolean a klikneme na tla¢itko Pick Operand B
a vybereme dzban. Tekutina se ofeze, ale ziejmé bude tfeba

nékteré prebyvajici vrcholy sité vymazat. Pfevedeme

vy sledny objekt na Editable Poly a smazZzeme vS8echny

pfeby v ajici hrany a vrcholy.

[Evindeil1 [ |

'

3o0f6 11/20/2008 05:14 PM
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W e @]E‘T Nasledné vy modelujeme drzadlo dzbanu. Nakreslime

>

Fome T nejdfive obyc&ejny valec (PT-Create-Geometry-Standard
[Cvinderm | | .

Primitives-Cylinder) a ten poté hned pfevedeme na NURBS
| Modiier List I3 objekt. Pomoci fidicich bodu upravujeme drzadlo tak dlouho
| B WURBS Surface az se nam libi. TéméF uréité bude tfeba pfidat vice Fidicich

---'.éSz:\:zE:iGU bodu pomoci Refine nebo Insert na pravém toolbaru. Je
tfeba davat pozor, aby se nevytvofily néjaké nezadouci
zlomy .
w/H 8| B
:".l : — — :
ow | | Cali | | Bath |
%]‘Eh% @ij? Hotov é drzadlo jeSté v pfipadé potfeby pfevedeme na
]CudaDT : | . Editable Poly a doupravime pomoci Soft Selection tak aby
— [ttotion]. jeho konce plynule navazovaly na dzban.
todifier List -
B Editable Poly

€| H[IYE |

I By BT 2|

PRI T TR T L

40f6 11/20/2008 05:14 PM
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Skleni¢ku udélame zcela stejnym zplusobem jako dzban.
Nakreslime si nejdfive jeji obrys pomoci nastroje Line a poté
opét orotujeme s vyuzitim modifikatoru Lathe. Muzeme, ale

nemusime pfi tom vyuzit NURBS kfivky.

% ISho _‘__J VRapMH Jakmile mame skleni¢ku a dzban hotov é, pfifadime jim
~Diffuse material. V material editoru (M) vybereme jeden slot a v
- _D"[f'rme:lJ ném pfipravime material. Jako typ materiadlu zvolime
— VRay Mtl (tla¢itko vpravo od nazvu materiadlu). Difuzni barva
r Reflection
@ barva odrazu budou ¢isté bila. Paramtery upravime dle

Reflect J
Hilighrgl_ns_sine_é;D,T ﬂJ[ F[eénﬂié_f_ladiwj&_]?ﬁ obrazku. VSe ostatni nechame na puvodnich hodnotach.

Refl gossiness[095 2| | FesnellOR[TE 1 2] |

Upozorfiuji, Zze pro VRay Mtl je tfeba mit nainstalovany V-Ray

Su_bi:livs.IED j Mai:t!eptH‘_l? ﬂ ) renderer, ktery neni soucasti 3D studia. PFi rendrovani se
Uss interpalation 1 Ekit'c;alm- musi vybrat tento renderer v menu Rendering-render.
r Refraction

Refiact ] | ORTTE 2|
-ﬁ_lb_si_é!r.]:_s_s.]T = _I Maxdepth[5— ﬂ

Subdivs [50_ 2{ Exit calar - B
Use interpelation T Fogeolar[ ]
Affect shadows [~ Fog multiplier [F.025 3|
Affect alpha T Fa_g__piasm,u_ =)

- Translucency

Type lﬁ Scatier cuefle_D_ ﬂ
‘Back-side cDJD[']:I | etk casfffT0 ﬂ
Thic:kneafs'lmﬂq,tl ﬂ Light multiplierl‘l_ﬂ ﬂ

Zde je pak material tekutiny ve dzbanu. Opét je to typ

% |8 X @6 % e R |Tas kutiny ve dzbanu. OF _ )
o - _J e - VRay Mtl. Barva tekutiny mize byt jakakoliv, zde je tmavé
K'I s = _—I_ag Cervena.

Diftuse || | |
- Reflection
Reflect |

Hilight dlossiness [T0 | 4] | [[T Freselreflections I~ [T

F|ef| glossiness |1_ﬁ_ 2{ J Fresnel I0F ﬁs_ ﬂ _J
Subdivs[50 %] Mardepth [T %]
Use interpolation [ Emt'\::olor_

— Refraction

Rehact ] | oB[T:m 2|
Glossiness IT _:J J Mardepth[5— 2|

S_Lgbdivfsir ﬂ Exit colar - I
Use interpolation [~ Foo color [N
Affect shadows [ Fog multiplier [0,07T5 |
Affect alpha I~ Foghias[30 2

r~ Translucency
Type lh Scatter c:oeﬂ'lD,D_ ﬂ
Back:side c_albrl:[ J et cneffl‘lﬂ_ ﬂ

Thicknsss IW ﬂ Liatt rrusdtiptien W ﬂ

—Diffuse

50f6 11/20/2008 05:14 PM
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Pokracovani...

60f6 11/20/2008 05:14 PM
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Skfiiftka bude obla, proto ji zahajime
vytvofenim zaobleného kvadru (PT-Create-

Geometry-Extended Primitives-ChamferBox).
Pfedni a zadni ¢ast zaobleni se ale musime
zbavit a proto je ofezeme pomoci dvou
normalnich kvadra (PT-Create-Geometry -
Standard Primitives-Box). Nastavime je tak,
aby pokryvaly celou oblast zaobleni. Pak uz
jen pouzijeme dvakrat nastroj Boolean v

Compounds Objects

Zepfedu jiz mame skfifnku hotovou. Nyni je
tfeba vyfezat vnitini prostor. To opét udélame
pomoci nastroje Boolean v Compounds
Objects. Jako ofezavaci téleso pouzijeme
zaoblany kvadr, jehoz rozméry nastavime
pfiblizné podle obrazku vlevo. Samozifejmé
musi byt hlubSi nez nas polotovar. Nélteré

Vv nitfni poly gony budou mozna chybét, ale pfi

rendrovani to nebude v adit.

| Modifier List

Editable Poly
Werken
Edge

‘Border

‘Palygon

-+ Element

Chamfer Edges

Poté udélame policky. Jsou vytvofeny z jednoduchych kvadru. Aby vypadaly o néco realisti¢téji, jsou troSku zkosené. To lze
prov ést tak, Zze kvadr pfevedeme na Editable Poly, vybereme v§echny hrany objektu (Edges) a v roletce Edit Edges zvolime

Chamfer. Otevie se okno jako na obrazku ve kterém muazeme upravit parametry zkoseni.

1of6 11/20/2008 05:14 PM



2. Skrinka
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Pokragujeme dal ¢elem $uplika. Celo vytvofime pomoci
zaobleného kvadru, ktery ze vSech stran ofizneme. Lze ho ale
také vytvofi editovanim normalniho jednoduchého kvadru. Po
ofezani pfevedeme objekt na Editable Poly a zkosime pfedni
hrany. Velikost ¢ela volime tak, aby mezi télem a polickami

by ly znatelné mezery.

Celo druhého Supliku, které je identické, ale zrcadlové
obracené vytvofime nejdfive zkopirovanim originalniho ¢ela
(Ctrl+V) a poté dvojnasobnym pouzitim nastroje Mirror (Horni
toolbar) kde nejdfive zrcadlime podle osy X a pak Y nebo
naopak. V oddilech skfifiky kde nejsou Supliky musi mit
skfinka zada. Ty udélame opét z jiz hotovych ¢el. Pouze nyni
je po kopirovani a zrcadleni jesSté zvétSime (Horni toolbar-

Scale), aby zakryvaly cely zadni otvor.

Drzadlo Suplikt vytvofime z kvadru, ktery nasledé zkosime
(Edit Poly-Chamfer). Nakreslime pak na libovolné misto
kruznici pomoci nastroje Circle (PT-Create-Shapes-Circle),
kterd bude mit polomér podobny zaobleni drzadla (viz
obrazek). Vratime se k drzadlu, vy bereme jeden z ¢elnich
polygonl a v pravém toolbaru najdeme v Edit Poly gons
poloZzku Extrude Along Spline. V dialogu po stisknuti Pick
Spline vybereme kruznici a upravime parametry, aby
vysledek vypadal jako na obrazku. Pfebyte¢né vrcholy a
hrany vymazeme. Konec pak dodélame jesté jednim

extrudovanim. Vybereme ¢elni polygon a pouzijeme Extrude.

Celé drzadlo by mélo vypadat asi takto. Pokud vytvofime

pravou ¢ast, levou muzeme jednodu$e dodélat zrcadlenim.

Cely Suplik je na obrazku vievo. Télo Supliku tvofi kvadry,
které byly zkoseny ztejnym zplUsobem jako v pfedeslych
pfipadech. Kolejnice Supliku jsou tvofeny zaoblenym

kvadrem po stranach.

11/20/2008 05:14 PM
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Kole¢ko skiitky zahdajime tvorbou jeho blatniku. Nakreslime
si uzavfenou kfivku pomoci Line. Ve stejném menu

pouzijeme i nastroj Circle k nakresleni kruznice, podél které
budeme kfivku blatniku extrudovat. Kfivku pak pfevedeme

na Editable Poly.

Po Extrude Along Spline vymazeme pfebytecnou geometrii a
konce blatniku upravime podle obrazku. VyuzZijeme pfitom

Soft Selection.

Kole¢ko, nebo jen jednu jeho ¢ast udéame opét stejnym
zpusobem. Tj. kfivka, pak nastroj Lathe. Je ov§em také

mozné vyjit z valce a ten postupné upravovat.

Druhou stranu kole¢ka po orotovani vytvofime pomoci
nastroje Mirror. Dal$i detaily kolec¢ka jsou tvofeny
zaobleny mi valci (PT-Create-Geometry-Extended Primitices-
ChamferCyl). Samoziejmé fantazii se meze nekladou, kazdy

|
'||i 1 i kolecku muzZe dodélat jak chce.

| Mi

3o0f6 11/20/2008 05:14 PM
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%J EJ‘\&‘]@‘EJT[ Uchyt koledka je tvofen zaoblenym valcem, ktery zasahuje

"|_Cylinder10 . do blatniku z boku. Na ném je pfimo uchytka. Ta je
r - vy modelovana Upravou zaobleného valce. Ten je preveden
| Modifier List LI . ) ) )

na NURBS plochu a editovan pomoci Soft Selection do

tvaru, ktery je vidét na obrazku.

Celé kole¢ko pak vypada priblizné takto.

Toto je vzhled celé skfifiky. KoleCka jsou pochopitelné &ty fi
a jeden ze Supliku je pro pestrost povytazen. Chybéjici

poly gony vnitiniho plasté skrfinky pfi renderovani nechybi.

40f6 11/20/2008 05:14 PM



2. Skrinka

50f 6

file:///fhome/chalupecky/Documents/pogr-tutorials/sv...

P % |8 | X | @ |4 % o [@ [ & &

[- Shader Basic Parameters

[ wie I~ 2Sided
I Face Map ™ Faceted

Blinn hd

[- Blinn Basic Parameters ]
= SelfHlumination

g Ambient:'- s v Colar - J

ﬁ Driffuse: - m
—-Specular:l:l il Dpacity: [T00 2| J

— Specular Highlight
Specular Level [35° 2| |
Glossiness: IT}J J

Softer: W _:J

%, |Skiinka0l ~|  Standard
|

[+ Entended Paramsters Ji
i SupeiSampling i
[E Maps |

Amount Map
I™ Ambient Color...[T00 2| [Hone |
I¥ Diffuse Color... JT00° 2| Skiinka fWalnut3 taa) |Iﬁ
| e R S e | K= |

Material sk¥ifiky je tvofen pouze texturou ofechov ého dfeva.
To znamena, Ze vedle polozky Difuse stiskneme tlacitko,
dame Bitmap a vybereme mapu ze souboru. Dole v roletce
maps je pak ta stejna textura pouzita jako bump mapa
(Amount 40%). Specular a Glossiness byly upraveny, aby
se dfevo vice lesklo - viz obrazek. Policky maji ten samy
material, ale je tfeba upravit Tilling textury, protoze jsou

mensi.

% G X @15 P29 RIS 5

%, IUmeIa hirnota

ﬂ R

i Diffuse

Difuse] ||
3 Ha[leclion
Reflect - M
Hilight glassiness [T Q J |T Fresnel reflections [ |T
Refl glossiness[T0. 2| | FesnsllDA[TE 2| |
Subdivs[20 2] Maxdepth[5 %)
Use interpolation [ Exit-color [N

r Refraction
Hefract_ | ORITE 2 |

Glossiness |1_D_ ﬂ J I ax depth |5_ ﬂ
Subdivs ISD_ ﬂ Exit colar - I

lse interpalation T Fog :CD|D[I:|
Affect shadows - [ Feg multiph’erl‘lﬂ ﬂ

Affect alpha [ Foobiss[O0 2|
— Translucency

Type I tona x| Soattercoelf | (1] ij
Back-side colar I:l J Funddbck coer[lU_E ﬂ
Thicknes&l ] ﬂ Light muttiplier. | 10 ﬂ

Tento material je pouzit na ¢ela Supliku. Je hodné leskly.
Bila brava je uréena polozkou Diffuse. Ostatni parametry

isou nastaveny tak jak je uvedeno na obrazku.

11/20/2008 05:14 PM
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3 N 2 Tento material ¢erné barvy je pouzit na kolejnice Supliku.
% IKoIeie _T_J MR aphdt Mé&| by byt podobny nalakovanému plechu. Jeho vyznam v
- Biffuse této scéné je ov8em minimalni, je mozné pouzit klidné
Diffuse [N |

standardni 3DS max material misto VRay Mtl a vysledek

— Reflection

Reflact - _|

Hilight olossiness IT ﬂ J |T Frezsnel reflections I |T
Refl. glozsiness IW ﬂ | FresnellOR [T | ﬂ J
Subdivs IED_ ﬂ I ax depth I?_ ﬂ

s interpolation [ E it color -

bude v podstaté stejny. Télo Supliku je tvofeno texturou
svétlého dieva. Stejné jako u kolejnic plati, Zze neni nijak

tfeba se timto materidlem zabyvat - je ho vidét jen velmi
maly kousek.

~ Refraction

 Retsct DN | oRfE 2| |
Glossiness[T0 2| |  Masdepth[7 3|

Subdivs ISD_ ﬂ Edit calary - r
s interpalation [~ Foug colar |:|
Affect shadaws [ Fog mult.iplial‘l,ﬂ_ 2]
Affect alpha T Fog biale,D_ ﬂ

— Tranzlucency

Type I Fiora | Gostercoefi[00 | 2]

Backsidecolor[ | | Fwddhokooosli[DE 2]
Thickness[20 |2 Lahbmultipler]T.0 1 5]

A = 1 Fa P I'_ T .
|7 28 5 A @A | T | Bl ||||| B Kole¢ka a drzadla Suplikd jsou chromové. Tento VRay Mtl
%, IEhrom _‘,’_J Whaphtl chromu celkem pé&kné& odpovida. DuleZité jsou pfedev$im
e
. odrazy (Fresnel reflections) s indexem lomu 16.
pifsc IR | a ’

— Retlection

Reflect I:l _|

Hilight olossiness IT ﬂ J|T Freznel reflections v H

Refl glossiness [TO 2| | FresnelIOR[TED 2| |

Subdivs IB_ j I ax depth IT ﬂ

|se interpolation [ E it colar -

— Refraction

 Retoct DN | oR[E 2| |
Glossiness IT ﬂ J I & depth IT =

Subdivs IB_ ﬂ Edit calary - r
|lge interpalation [~ Fogeolo[ |
Affect shadaws [ Fog mult.ipliah,u_ EJ
Affect alpha Foobiss {00 2|

— Tranzlucency

Type I Mone + | Soattercoet [00 i|

Backssidecolor] || Fwddhokeeoslf[T0 2]
Thickress[T0000. 2| Light mulliplier[T0 1 3]

Pokracovani...
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3. Zbytek scény

Misa je vytvofena z kvadru, ktera ma sit 10x10.

|[Kvadr pak pfevedeme na Editable Poly a vybereme
nejdfive vrcholy v jeho rozich pomoci Soft
Selection. Upravime hodnotu Pinch v Soft
Selection, aby deformace probihala poZadovanych

zpusobem ve tvaru kruznice. Pak rohy zvedneme.

Potom vybereme vrcholy v8ech hran a hrany
zvedneme. Dle potfeby je mozné nyni upravit

parametr v Soft Selection Falloff.

Opét vybereme pouze vrcholy v§ech &ty rohu,

upravime Soft Selection parameter Pinch zpatky na

nulu a Falloff radikalné zmenSime. Rohy troSku

snizime. Nyni vybereme polygony v§ech bocnich

hran a pfidélime jim Smoothing Group 32. Tento

parametr je sou¢asti menu Editable Poly v pravém
toolbaru. VSechny ostatni polygony musi dostat

Group 1. Toto zajisti, Ze pfi nasledujicim vyhlazeni

zUstanou hrany ostré.

Pro vyhlazeni pfidame modifikator Mesh Smooth
(PT-Modify -MeshSmooth). Subdivision Method byla

zvolena Classic a Iterations byly nastaveny na 2.

Jako posledni model na fadé je decka na skfirnce.
Je to prosty kvadr, dost tenky, ktery je poté
pfeveden na Editable Poly a upraven. Je tfeba
pouzit Soft Selection a vytvofit rizné hrbolky a
ohyby. Samoziejmé zmény by mély pusobit

alespon tro§ku nahodné.

1of3 11/20/2008 05:15 PM
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Cela scéna pak vypada néjak takto. Byly pfidany - jako pozadi - dievéna podlaha a zed. Scéna je nasvétlena dvéma svétly. Jedno
je ty pu Omni (Create-Lights-Standard-Omni). Jsou u ného aktivovany stiny - typ VRayShadow. V roletce Intesity/Color/Attenuation
je zatrhnut Decay s hodnotou Inverse a 620. Je pouzita Near Attenuation s hodnotami 0 a 40 a také Far Attenuation s hodnotami 400
a 800. Ve VRay Shadow Params jsou zaskrtnuty polozky Transparent Shadows a Smooth Surface Shadows. Druhé svétlo je typu Free
Spot a je namifeno pfimo na skfifiku. Tvofi kuzel vyrazného sv étla, které na zatis$i dopada. Parametry jsou upIné stejné az na Far

Attenuation kde jsou tentokrat hodnoty 600 a 1000. Samoziejmé parametry svétel také dost zavisi na tom jak jsou daleko od scény.

Material misy je vyrazné zbarvené sklo. Misa je ¢ervena. V

pfipadé zmény barvy je potfeba modifikovat nejen Diffuse

barvu, ale i barvu refrakce.

il " }im-mamﬂ']'r:' gJJ
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@22 |85 | X | @ | £ |gﬁ | L) | ) ||W3'Q 5 Material decky je VRayMtl material s texturou. Jako bump
%, IHard _'J VR apt mapa je pouZita stejnd textura s Amount parametrem 30.

V§echny ostatni polozky jsou standardnii. Zcela stejné je

I'.|_+ metﬁg |] vyfeSen i materidl podlahy. Opét textura + ta sama mapa
L= e - ] | jako bump mapa.
Diffuse  [T000 3|¥ Map #11 [tzblacloth jpd) |

Reflact 1000 =/ None |

HGIossinessW ﬂ v MNane |

RGlossiness[T000 5| Nane |

Freznel [OR |1_DD-D_ HF Maohe |

Fefract  [T000 3| Nane |

Glossiness IW ﬂ v Mane |

|OR [To00 QI? Nane |

Tianslucent [TO00 21 None |

Bump 300 g v Map #13 [tablecloth:jpg) |

Dizplace 1000 5"7 Naone |

Opaciy  [T000 3@ Maone |

E nviranmeant v Mans |
[+ Reflect nterpolation li
I+ Refract interpolation Ji

[- Directs Mariager |

[~ D% Display of Standard b ateral Save s B File

L —r 7

Material zdi je dost komplikovany. V tomto pfipadé byl

Sl IW HIV Colar [VRzCalor ) | pfevzat z webu www.vray -materials.de. Nejdulezitéjsi ¢ast
Reflect  [JO00 3| Mone | o . s esix
HGIos_sines_slﬁD‘,D_ﬂF e | materialu je bump mapa, ktera je pomérné slozité
RGlossiness[T00.0 ﬂp Niora | generovana v material editoru. Do 3D studia Ize pfidavat
Fiesrie lDH'IW ﬂp figva | kompletni materialy v souborech s koncovkou .mat. Pak
Refract  [T000° 2[i¥ Nore | sta¢i kliknout na tlaéitko vedle nazvu materialu v nasledném
Glossiness [T000 2™ Mone | dialogu zvolit Mtl Library a dat Open a vybrat externi

10R 000 5| Nane | material.

Translucent [T00.0 5"7 Narie |

Bump  [300  :|¥ Conewall Bump [Mik)] |

Displace  [T0000° EJP Mare |

‘Opacity IW ﬂl? Nohe |

Enviranment v Hone |
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Modelovani antického chramu

Ondfej Tichy
25. ¢ervna 2008

Nasim tkolem bude vytvofit v Blenderu model antického chrdmu. Nebudu
zde vysvétlovat jeho zdkladni ovladéni, na internetu lze najit mnoho riznych
tutoridla, které ¢tenédre provedou zdkladnimi vlastnostmi. To ale neni nezbytné
nutné, pokusime se zde vysvétlit postup po detailnich krocich.

Nejprve se pustime do vytvofeni antického sloupu. Vytvorime valec, ktery
bude mit na obvodu podstavy 48 bodi. P¥epneme pohled na horni ("7" na nu-
merické klavesnici). Stiskneme mezernik a vybereme z nabidky ADD — MESH
— CYLINDER. Poéet VERTICES nastavime na 48, jeho dalsi rozméry nés za-
tim nemusi zajimat, ty upravime pozdéji dle potieb a estetického citéni. Nyni
se pomoci TAB pfepneme do edita¢niho moédu a pomoci klavesy B budeme po-
stupné oznafovat body po dvou a vytvaret drazky na sloupu (klavesa G), jak je
ukizéno na obr. 1.

I T

Obréazek 1:

Velikost sloupu pak mtZeme upravovat bud funkei SCALE (klavesa S) nebo
tim, 7e oznalime vSechny body podstavy sloupu s pouZijeme klavesu G. Tu
doladime dle podstavce sloupu, ktery vytvorime nyni.

Vybereme z nabidky ADD — MESH — CUBE. Kostku zplostime a pouZi-
jeme funkci EXTRUDE (klavesa E). Tim v ramci jednoho objektu zkopirujeme



oznacené Casti a miZeme je napiiklad posunem dale modelovat. Timto zptso-
bem vytvoiime podstavec dle obr. 2.

Obrazek 2:

Horni ozdobu sloupu vytvorime slou¢enim dvou valci a kvadru (CTRL +
J). Ve upravime do odpovidajicich rozméra, pFidame jesté zplostéslé koule jako
ozdoby pod horni ozdobu a nad podstavec a v8e opét slouc¢ime. Ziskdme tak
hotovy sloup, viz obr. 3.

Obrazek 3:

Texturu pro cely sloup vytvorime v nabidce F6. Lze také stahnout jiz hotovy
soubor s texturou, pomoci SHIFT + F1 ho naéist a v nabidce F6 uZ jen texturu
prifadit k oznafenému objektu.

Nyni je na Fadé podstavec celého chramu, ktery vytvofime opé&t pomoci



funkce EXTRUDE. Vytvofime hodné zplosténou desku odpovidajicich rozméri,
pfepneme se do edita¢niho rezimu (TAB) a ozna¢ime horni body. Postupnym
extrudovanim vytvofime podstavec tvar dle obr. 4.

Obrazek 4:

Opét mu pfifadime texturu mramoru a za¢neme vytvaret zakladni strukturu
chramu, totiZz sloupotadi. Sloupy kopirujeme pomoci SHIFT + D a pfesouvame
na jejich mista, az dostaneme scénu obdobnou jako na obr. 5.

5 oven [@ouevwe ][0 9(0 ]

Obrazek 5:

Chramovou lod vytvofime jednoduse pomoci kvadru upraveného do sprav-
nych rozmérd. Do jeho pFedni ¢asti udélame extrudovanim otvor na dvefe.

Dalsi ¢asti bude vytvoreni stfechy chramu. To udéldme opét modelovanam
pomoci EXTRUDE a horni body zaSpi¢atime, aby davaly tvar stifechy, dle
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Obrazek 6:

Chybi nam jesté dodélat dvete, které bude reprezentovat deska s propadlym
prostfednim dilem a pfifazenou texturou dieva (obr. 7). Nem4 cenu na nich
délat n&jaké velké detaily, budou stejné z velké ¢asti schované za slouporadim.

Na pruceli chramu dame népis, ja jsem vybral " MAGRIPPA.L.F.COS.TERTIUM.FACIT",
ktery je umistén na Pantheonu v Rimé a znamend priblizng: "Nechal vybudo-
vat Marcus Agrippa, syn Lucitiv, za svého tietiho konzuldtu". Text modelujeme
pomoci piikazu ADD — TEXT. V edita¢nim médu miZeme ménit obsah textu
a ve standartnim médu pak jeho vlastnosti, napiiklad pravé hloubku. Vznikne
nadm tak objekt tvaru daného textu, kterému pfifadime texturu ¢erného mra-
moru (viz obr. 8).

Text umistime na p¥islugné misto na priceli. Scéné pak mizeme jesté vytvo-
¥it podklad, naptiklad pfidanim desky (ADD — MESH — PLANE) a pfifadit
ji texturu sklanatého podkladu. Pomoci ADD — LAMP muzeme také scénu dle
libosti nasvitit.

Klavesou F12 pak v8e vyrendrujeme, cely vytvor si maZeme prohlédnout na
obr. 9 a 10.



Obrazek 7:
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Obrézek 8:
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Sachy v Blenderu

Sachovnice
Prvni co si ukdZeme u tvorby Sachi je Sachovnice. Nejprve upravime prostredi blenderu, abychom
vidéli objekt z nékolika pohledi najednou tim, Ze rozdélime plochu na ¢tyfti ¢asti.

Klikneme pravym tlacitkem mysi na ¢aru oddélujici spodni panel nastrojd a pracovni plochu. Ze

zobrazené nabidky zvolime split, mysi najedeme doprostied pracovni plochy a levym tladitkem mysi

potvrdime rozdéleni. Stejné to udélame jesté dvakrat na ¢are, kterd nyni rozdéluje pracovni plochu,
az dosdhneme stavu na nasledujicim obréazku.
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Prvni ¢asti Sachovnice bude jedno policko. Polic¢
menu a z néj vybereme Add a pak Plane.

| —
ko budeme vytvaret z roviny. Mezernikem vyvoldme




Plochu mame oznacenou a ted vyvolame kldvesou E menu extrude, ze kterého zvolime region,
kterym z plochy udéldme kvadr.

Po zméacknuti kldvesy Z se bude plocha rozsifovat pouze jednim smérem a ¢isly na numerické
kldvesnici miZzeme urcit o kolik presné. Nastavime tedy 0,5 a potvrdime enterem (Pokud se plocha
rozsifuje opacnym smérem tak po zadani hodnoty stisknéte klavesu -).
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Pro docileni 3d efektu jednotlivych policek budeme cely postup opakovat jesté jednou, tentokrat
viak plochu zvét§ime v ose Z pouze 0 0,1.

hodnotu o néco mensi nez jedna. Zménu velikosti opét potvrdime enterem.
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Ted nezbyva neZ policka rozmnozit policko 64x, aby vznikla celd Sachovnice. Kldvesou Shift+D
vytvorime duplikat objektu, pak zaddme pismeno osy, ve kterd chceme objekt posunout a nakonec
¢islo o kolik.
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o
Takto vytvorime osm policek, které pak mizeme vsechny oznacit Shift+Pravé tlacitko a znova
duplikovat aZ vznikne celd Sachovnice.

[igoioan o] (9 3 (@ 1] 5D [= [oovsn o]

Pro snadné&;jsi manipulaci mGZeme vSechna ¢ernd poli¢ka spojit v jeden objekt. Oznadime je
Shift+Pravé tlacitko a Ctrl+] je sjednotime. To samé miZeme provést s bilymi policky.
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Pravym tladitkem oznacdime Cernd polic¢ka a klavesou F5 vyvoldme nastaveni materialu pro objekt.

Vytvofime novy material a pojmenujeme jej napriklad ¢erna policka. MliZeme nastavit i barvu, tu ale
pak stejné prekryjeme texturou.

[onictiacan o] (9 3@ o] EFINS [= [cionr_o

I CFEETS o - v
-

. ==
Zmackneme klavesu F6 pro nastaveni textury objektu. Tlacitkem Add New vytvorime novou texturu a

vhodné ji pojmenujeme. Vybereme typ clouds a zalozku texture pfepneme na colors.
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Tady klikneme na colorband a vybereme vhodné barvy pro poli¢ko. Cely postup opakujeme i pro bild
poli¢ka. Vysledek by mohl vypadat podobné jako na nasledujicim obrazku.
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Obal na Sachovnici
Policka uz mdme, ale Sachovnice porad vypada jako by se méla rozpadnout, proto pro ni vytvorime
drevény obal.

Oznacime ¢ernd policka a z menu pres mezernik zadame Transform->Center New a poté Transform-
>Snap->Cursor — Selection. Tim nastavime kurzor na stfed Sachovnice. Poté vloZzime plochu a
posuneme ji ve sméru osy Z pod Sachovnici.

Klavesou S vyvolame zménu velikosti plochy a zvétsime ji 9x, aby mela na kazdé strané pal pole navic.
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fifadime texturu. Pro vyvolani efektu dieva mizZeme pouzit obrazek se strukturou dreva.

K obalu p
Jako typ struktury vybereme Image a nacteme obrazek, ktery se pak pouZije jako textura.



Nyni vytvorime Cisla a pismena pro popis sloupct Sachovnice. Pfes mezernik vyvoldme menu a
zvolime Add->Text. Text smaZzeme a hapiSeme pismena od A do H.

Vycentrujeme pismeno A a poté v menu editing (F9) ménime mezery mezi pismeny, az bude pismeno
H na spravném misté. Pro plasti¢nost pismen mlzeme zvétsit hodnotu Bevel Depth textu podle
libosti. Pismena zkopirujeme i na horni ¢ast $achovnice. Cisla vklddame po jednom. Jako prvni
vloZzime jednicku a pak text vidy zkopirujeme, posuneme vys a zménime hodnotu o jednicku. Sloupec
Cisel pak zkopirujeme i na druhou stranu Sachovnice. Vysledek pak mizZe vypadat, jako na

nasledujicim obrazku.
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Sachové figurky
Pro tvorbu figurek jsem pouzil metodu, na kterou jsem narazil v minulych projektech predmétu
Pocitacova grafika, konkrétné to byl tutoridl od Vladimira Jarého z roku 2006. Metoda spocivd v tom,
Ze si na pozadi blenderu vloZime obrazek a pak polovinu obrazku popiseme kfivkou, kterou potom
oto¢ime kolem své osy a tak vznikne figurka.

sz [x][c[scEseme [x e

lacaumce <} (@ im [ | GG [cioes

Zacéneme tim, Ze vloZime obrdzek na pozadi. To udélame pres nabidku view a Background image.
Potom vloZzime plochu, ze které odstranime tfi vrcholy, takze ndm zbude pouze jeden bod.

[sizwomm _ [x][S[sChtcans | [lnbien .

Bod presuneme do zakladny figurky a pres funkci extrude budeme priddvat dalsi body a tim opisovat
kfivku figurky. Na konec budeme mit oznaceny vrchni bod, na ktery vycentrujeme kurzor pfes menu
Transform->Center New a poté Transform->Snap->Cursor — Selection.



Nyni si pres kldvesu B ozna¢ime vSechny body kfivky a v editacnim menu (F9) nastavime u Degr.

hodnotu 360°, aby se kfivka otocila kolem celé osy a u polozky Steps pocet krokl ve kterych se bude
kiivka otacet, napf. 18. Potom klikneme na tlacitko spin a pak na plochu, na které méame pohled
zhora.

Mame figurku hotovou a ted' ji uz jen nastavime vyhlazeni tladitkem Set Smooth. Vysledek vidite na

dalSich obrazcich.
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Umisténi figurek na sachovnici

Cpen Aecent
Fcae Last Sassion
Sapm

v s

Compras Fiin

ava ndge..

Dusp Suanaon

Dimp Screan

Savs Rontine.

Sawe Oynamic Runtime...

Save efaun Semngs
Laad Factory Setings

Vzhledem k tomu, Ze figurky jsou umistény v jiném souboru, musime je k Sachovnici pfidat. To se déla
pres polozku hlavniho menu File->Append or Link, kde vybereme soubor s figurkami a pak jednotlivy
objekt. Jako prvni mizZeme vlozit figurku pésce. Jednoduchym posunem a kopirovanim ji rozmnozime
po Sachovnici. Stejnym zplsobem pridame i ostatni figurky. Pro kazdou barvu vytvofime materiél a
pak jej pfifadime figurkam, ke kterym patfi.



Dalsi obrazky
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Vyrenderovany obrdzek Sachovnice
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3D modelovani v Blenderu

Na zacatku jsem si rozdélila pracovni plochu Blenderu pomoci stfedniho tlac¢itka a
vybrani polozky Split Area ze zobrazeného menu.
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Do jednotlivych oken jsem nastavila ruzné pohledy. http://www.grafika.cz/art/3d
[clanek1329651850.html

Obrazek jako predloha

Na pozadi jsem vlozila obrazek - znak nasi fakulty.
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Krivky

Kdyz uz mam predlohu nachystanou, je potreba obtdhnout vesSkery text a vilnovku. Po
stisknuti mezerniku se objevilo menu, z néjz jsem vybrala Add - Curve - Bezier Curve.
Néasledné se nastavi v Curve Tools - Convert moznost Poly. Timto ziskdm krivku

s neékolika vertexy a témi obkresluju text FJFI. Dany vertex vyberu pomoci pravého
tlacitka mysi (ddle PM). Potom je potreba pretdhnout pres krivku kurzor soucasné
se stisknutym levym tlacitkem mysi (ddle LM). Dalsi vertex priddm pomoci
Ctrl+LM. Na konci kfivku spojim vybrdnim dvou vertexu a stisknutim klavesy C. Vice
o modelovdni pomoci krivek: http://www.grafika.cz/art/3d/clanek1232498738.html
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Vlnovku si vymodeluju stejné jako text pomoci Poly, s tim, ze na konci se prepnu do
Bezier (Curve Tools - Convert - Bezier) a vyhladim okraje. Pozn: prepindni mezi
Objektovym a Editacnim médem se provadi pomoci Tabuldtoru.

Z 2D delame 3D

A ted z 2D objekt musim vyrobit 3D objekty pomoci extrudovani krivek.

Ménim hodnoty parametra Width, Extrude, Bevel Depth a Bev Resol. Vysledny tvar je

stale programem chdpdn jako krivka a proto je potreba prekonvertovat pomoci Alt+C
z Curve do Mesh. Timto se vytvori sit vertext (Obr. 6).
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Dalsi zajimavé moznosti Blenderu jsou hezky sepsany v tutoridlu:
http://www.grafika.cz/art/3d/clanek1232498738.html
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Dalsi krok je vytvoreni modelu atomu. To provedu tak, Ze nejdrive vlozim kruznici
(Add - Mesh - Circle), které potom pridélim pozadovany prurez. Prarez vyrobim jako
dalsi kruznici a tento profil pojmenuju. Timto mizu s pojmenovanym objektem dale
pracovat a pridélit jej jako prurez pomoci BevOb (Bevel Object) kruznici, kterd bude
tvorit model atomu. Vybranim objektu obruce a kldvesovou zkratkou Shift+D vytvorim
dalsi dvé duplicity.

Nyni pomoci Add - Mesh - UVSphere vytvorim tecky nad ,J“ a ,I“ a stred atomu.

V tuto chvili mdm vytvorené vSsechny objekty potrebné k vytvoreni loga. Nejtézsi ¢asti
je zformovani modelu atomu v 3D prostoru. Zde pouzivdm tri razné pohledy ve trech
oknech a pomoci posouvani objektu a rotace vyformuju model atomu.



. e e e e M M M e M M M M M M M M M M M M M M M M M M M N M M M M M M M M M M N N M M M M M N M M M M M N N N M M M N M N M M M M M N M N M M M M-
LA Whender [ AP e blerder 44 windon o, Benderkgo I bieed) ek

it

Pridavani materialu a textury
Priddni materidlu: Shading - Material Buttons - Add New
Pridani textury: Shading - Texture Buttons - Add New (Texture Type)

A na z4avér je potreba vyrobit scénu, tzn. nasviceni, nastaveni kamery a vytvoreni
podkladu. Ja jsem pro nasviceni pouzila objektii Lamp typu Sun a Area (Add - Lamp).



e e e o R R R e e e e e e e e e e e e e el el el e e D e e e e e I I e e e e D e e e e e D D D D T I M R R M e e e e M e M M M M M M M M M M M M M R R M M M M N
A bbensderbospo 1 St bl
Blirdar ¥ [

Aieruder- 244

Ulozeni obrédzku se provede pomoci menu Render - Render Current Frame (F12) - F11
- F3.
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Vysledné 3D logo






Modelovani usporné zarovky

Uvod

K vymodelovani usporné zarovky v programu Blender je nejprve tieba instala¢ni soubor ze
stranek http://blender3d.org Ja jsem pouzil verzi 2.43 pro Windows. Dale byla zapotiebi
konkrétni predloha tisporné zarovky. Vzbral jsem si zarovku, kerou jsem naSel na strankéach
wikipedie: http://en.wikipedia.org/wiki/Compact_fluorescent lamp pod pojmem “Biax or
Linear CFL”, protoze mi pfi$la nejzajimavéjsi z vystavenych typa.

Obrazek 1: Pfedloha

Po nainstalovani programu jsem si prohlédl video tutorialy a naucil se tak zakladni manipulaci
s prostiedim, vytvafeni objektd, praci s materialem, texturami a dal§imi uZitenymi technikami.
Samotné modelovani zarovky probihalo vétSinou od oka podle obrazku. Vysledné rozméry a
pomeéry jednotlivych ¢asti nejsou tedy uplné totozné se skutecnosti. Strukturu baterie jsem
rozdélil na tii Casti: trubice, stfed a Sroubovy zaklad.



Model

Trubice
Chceme vytvoftit prozatim jednu dutou trubici kruhového prifezu daného tvaru ohnuti.
Potiebujeme tedy napted vzmodelovat kiivku,kterou poté zménime na trubici.

V hornim pohledu (Num?7) si vlozime Beziérovou kiivku (mezernik — Add — Curve - Bezier
Curve).

Pro vytvoteni profilu budeme pottebovat vice koncovych vertexi. Takze, na kfivce ozna¢im
levy konec a pomoci Ctrl a levého kliknuti pfidam dalsi bod. Kiivka se tim prodlouzi o jeden
bod. My budem potiebovat celkem 7 bodi, kudy prochézi kiivka. Proto postupné ptidam jeste
dalsi body i na pravou stranu kiivky. Poté vytvaruju kiivku do takového tvaru, jaky potiebuji.

Profil uz bychom méli, jenze je to jen profil, ted’ je potreba ho vzplnit kruznicemi. Sko¢im do
objektového menu (Object menu) ptes Tab a nékde kousek od luku vloZzim Bezier Circle. Uz
tedy mam vlozenou Bezier circle, kterou trochu zmensim pomoci S - zména velikosti a
prostiedni tlacitko mys$i a tazeni nahoru.



Piepnu se do Editing (F9) a tplné vlevo v kolonce OB piejmenujte objekt. Zvolim si néco
jednoduchého typu “kolecko”. Sko¢im zpét do Objekt menu a ozna¢im si profil trubice. Dole
je kolonka BevOB, kam napis$u jméno kolecka... “kolecko” a potvrdim.

Co se vlastné stalo? Pfikazem BevOB jsem programu fekl, aby tento objekt "splynul" s
objektem kolecko... a vytvofil tak trojrozmérny obraz. Vyhodou této techniky je, ze jednoduse
muzu upravovat tvar objektu, protoze tvar luku a tvar kolecka ztistava potad na scéné.

Pokud byste tieba z koleCka udélali ¢tverec, luk by pak mél hranaty profil...

Upravte tedy poméry velikosti obou objektt tak, aby trubice vypadala opticky dobie.

Jenze ted’ nemizeme luk modelovat pomoci vertexu, jelikoz je porad jesté kiivkou. To
napravime konverzi do meshe klavesovou zkratkou Alt + C.

Na spodku kazd¢ trubice je mal4 vzvySenina, tu vyrobime tak, Ze ozna¢ime vSechny vertexy
ve dvou poslednich fadcich trubice,

pfepneme se do predniho pohledu a umitnime selection bod doprostied kola(zakladny trubice)
a pouzijeme funkci Extrude ( E). Pomoci S a mysi roztahneme tuto ¢ast do velikosti kterou
potiebujeme. To samé pro druhy konec trubice.

Nyni potiebujeme tfi kopie této trubice. Mohli bysme ji prosté tfikrat zkopirovat a pootacet.
Lepsi zpusob je pouziti funkce Spin Dupplicate. V nastaveni nastavime polozku Degr tedy
rotaci na 360°, a polozku Steps na 3, nastaveni Steps nyni udava kolik paprskt kolo bude mit,
z horniho pohledu umistime selek¢ni bod kousek od nasi trubice, udélame to tak, ze 3D kursor
nastavime tam, kde chceme mit selek¢ni bod. Poté vypneme editacni mod ( Tab ) a klikneme
v EditButtons na tlacitko Centre Cursor. Selek¢ni bod je konecné tam, kde ma byt, zapneme
edit méd, vyskeletujeme vSechny body trubice (A ) a klikneme na tlacitko Spin Dup,
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které se nachazi vpravo vedle tlacitka Spin.

Stred
Nejjednodussi ¢ast modelu. Do projektu vlozime valec ( mezernik — Add — Mesh - Cylinder ).
Pomoci G — poloha, S — velikost nastavime valec pod trubice a zmensime. Oznac¢ime vSechnz
body spodni strany valce a pomoci Extrude ( E ) a S a G namodelujeme valec do tvaru kterz

potrebujeme.

Sroub

Do scény vlozime kruznici (Add — Mesh - Circle), Pravou nebo levou ptilku smazeme. Je
dualezité, ze které strany bude ptilka smazéana, kdyby byla ptlka odstranéna ze spodni nebo
vrchni strany tak by se operace s nastrojem Screw provadéla nevyzadanym smérem.



Zase nastavim parametry Degr na 360, Steps tentokrat bude stacit na 16, ale kdo chce mit
zé&vit dokonalejsi, mize zadat vyssi hodnotu(32), Turns nastavime tieba na 20 (Turns nyni
tika, jak bude zavit dlouhy, respektive kolik otacek ptlkruh udéla kolem selekéniho bodu).
Pozd¢&ji smazeme a upravime az bude Sroub hotov. Selekéni bod by mél byt pti vlozeni ve
stiedu kruznice, takze s nim nemusime provadét dalsi upravy. Zmacknéte tlacitko Screw,
které se nachazi vlevo od tlacitka Spin. Na nésledujicim obrazku to zavit jesté¢ moc
nepiipomina.

To jednoduSe napravime. Vyselektuju si vSechny body ( A) a aktivuju funkci Scale pro zménu
velikosti ( §) a hned na to zméacknu na klavesnici pismenko Z, tim se bude dany objekt
zmenSovat jen v jednom sméru tedy po ose Z. Stejn¢ tak kdyby jsme chtéli objekt zvétSovat



nebo zmensovat po ose X nebo Y, tak jednoduse aktivujeme Scale a poté stiskneme X nebo
Y.

Sroub ofiznu, selektuju spodni body a smazu, totéZ nahote. Chci jen asi pét zaviti.

Doprostied Sroubu vlozim valec, jiz zminénym zpisobem. Upravim velikost na trochu uzsi
nez je polomér Sroubu. Oznacim spodni zakladnu vélce a protdhnu funkci Extrude a
vymodeluju do tvaru tupého jehlanu. Poté ozna¢im cely Sroub a posunu do pozice pod
sttedem Zarovky pomoci G.



Material a barvy

Prvni véc Kterou musim udélat, je rozdélenimodelu na ¢asti podle materidlu. Ozna¢im vzdz
¢ast, na kterou chci aplikovat nejaky material a separuji ji od zbytku modelu klavesou P-
selected. Zvolena ¢ast se zméni v objekt, ktery jiz nemtizu tvarovat. Pokud chci aby byl objekt
hladky, pouziju funkci Set Smooth. Pokud bych chtél ud¢lat jesté n€jake zmény tvaru musim
objekt znovu zménit na mesh pomoci alt+C.

Material aplikuju tak, ze oznacim objekt a v panelech ozna¢im tla¢itko koule (Shading-F5).

Dale potiebuju ptidat Link k objektu (zmacknu Add new). Vpravo v Links and Pipeline
zmenim jméno linku (v ,,MA:“) na néco rozumného, napt. ,,sklo”. Upravim vlastnosti

- materialu.
—

Tt Trdisg

Dale selektuju dalsi ¢ast zménim na objekt a tak dale.
Pti zméné materialu trubic mam dal$i moznost. Pokud chci, aby trubice svitili, pouziju na né
funkci HALO v zélozce Render pipeline.
Dale uz jen Renderuju a ulozim vysledek.



Funkce HALO prilis presviti scénu, pouzil jsem tedy na trubice pouze Cisté bilou barvu, na
objimku mirn¢ Sedivou a matnou, a na Sroub material chrom, stazeny ze stranek Blender

knihovnz materiald. Gumovy krouzek uplné na spodu Sroubu je ¢erny a matny a kontakt opét
chromovy.




